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Copyright
 MAGIX is a registered trademark of MAGIX AG. 
Other named product names may be registered trademarks of their respective owners. 
This product uses MAGIX patent pending technology. 
Copyright
 © MAGIX AG, 2002-2009. All rights reserved. 
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Preface
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe will help you teach your photos to walk – or
even better, how to dance. With this software, your photos will become the star of an impressive
multimedia show, and you're the director! 
Enjoy your photos together with your family and friends on TV or on your PC. Play your pictures just
like a feature film with great fades and effects as well as narration and subtitles. Add intros and outros, or
invent your own closing credits. In other words, turn your living room into a cinema! 
Create attractive DVD menus that match the format of your slideshow: 4:3 or 16:9 for wide-screen TVs
& monitors. Burn your slideshow together with a high-quality menu onto a playable DVD, CD-ROM,
Video CD, Super Video CD, miniDVD, JPEG disc, TV Showtime DVD, multi-disc, or Blu-ray Disc. 
The printed manual is only a brief introduction to the software. You can find detailed documentation as a
PDF in the start menu of your MAGIX product. The electronic manual can be opened using the "F1" key
to provide a more detailed explanation of the options, dialog boxes, menus, and program interface.
Program help and the PDF manual will even guide you through the jungle of the process of formatting
blank discs, DVDs, Video CDs, High Definition slideshows, etc. 
Have fun with MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe! 
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Support
 If you experience any problems with your software, please contact our support team: 
Support website: http://support.magix.net 
This website takes you to the MAGIX user service page; the following free offers are also featured
there: 

 FAQs (frequently asked questions) and general tricks and tips. In most cases, you'll find the
solution to your problem here. If not, use the email support form.

 Email support form: Use the special form to inform our support staff about your system. This
information is used to solve your problems quickly and competently. Simply fill it out and send it
with a mouse click!

 Support forum: You are not alone... Perhaps other users had a similar problem and can help
you solve yours. Our support staff are also regular contributors.

 Download section: Updates, improvements, and patches are likewise offered free of charge via
download. Many problems you may experience are already familiar to us, and they can often be
solved by downloading the latest patch. Besides patches, there are also wizards for checking and
optimizing your system.

 Links: The links list contains the contact addresses for all of the most important hardware
manufacturers. 

You can also reach our support team by telephone:
 UK: 0905 118 0888 (25p/min)
Monday to Friday 9:00 - 16:00 (GMT) 
US: Phone: 1-305-722-5821 
Monday to Friday 9am – 5pm (EST) 
Please have the following information at hand:

  Program version
 Configuration details (operating system, processor, memory, hard drive, etc.), sound card

configuration (type, driver)
 Information regarding other audio software installed
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Package contents
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Package contents
 Program CD / DVD
 The MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe installation manager is included on this CD. 
Manual
 It is always useful to read the introductory chapters of this manual. Hint: The complete documentation is
included in the MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe directory as a PDF file. To read it
you will need the "Adobe Acrobat Reader" application which you can download for free from
www.adobe.com. 
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System requirements
  For Microsoft® Windows® XP I Vista™

Minimum configuration:
  PC with Intel® Pentium® or AMD® Athlon® 1 GHz and higher
 Min. 512 MB RAM
 500 MB free hard disk space for program files, min. 1 GB free for video files (5 GB

recommended).
 16-bit sound card, CD drive, Microsoft® compatible mouse.
 SVGA graphics card with min. 32 MB RAM, MAGIX Xtreme PhotoStory on CD & DVD 8

deluxe: min. resolution 1024 x 600. Additional programs included in delivery: min. resolution
1024 x 768 at 16-bit high-color

 3D power effects with OpenGL/DirectX 9 support and Microsoft® Windows Media PlayerTM

version 7.0 or higher

Minimum requirements for hardware-accelerated preview:
  DirectX 9.0c compatible graphics card, mind. 128 MB graphics card memory (256 MB+

recommended), and Pixelshader 2.0, ATI X300 and better, NVIDIA GeForce 6600 and better
 Creates CDs with SCSI or IDE CD-R(W) burners, DVDs with DVD+/-R(W) burners
 MAGIX Online Services and integrated browser require an Internet connection, Microsoft®

Internet ExplorerTM version 6.0 and higher recommended.
 Min. 56k modem for transferring screen contents via the Internet. ISDN or higher Internet

connection recommended.
MP3 export requires Windows Media PlayerTM

 installation version 10 or higher 

Page 7



Serial number
 A serial number is included with each product, and although it is not required for the installation of the
software, it does enable access to additional bonus services. Please store this number in a safe place. 
What can a serial number do?
 A serial number ensures that your copy of MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe is
clearly assigned to you and only you, and it makes improved and more targeted customer service
possible. Abuse of the software can be prevented with a serial number, since it ensures that the optimum
price/performance ratio continues to be offered by MAGIX. 
Where can the serial number be found?
 The serial number can be found on the reverse side of your CD/DVD case. If your product, for
example, is packed in a DVD box, then you'll find the serial number on the inside. 
For the versions that have been especially optimized for the Internet (download versions), you'll receive
your serial number for activating the software directly after purchasing the product via email. 
When will you need the serial number?
 The serial number is required when you start or register MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe for the first time. 
Note: We explicitly recommend registering your product, since only then are you entitled to get program
updates and contact MAGIX Support
. Entering the serial number is also required for activating codecs. 
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More about MAGIX
In this chapter
MAGIX Online World
magix.info
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MAGIX Online World
 Well-connected: Products and services online from MAGIX
 Discover the possibilities offered by the MAGIX Online World. Every MAGIX product offers a direct
and easy-to-use gateway to the world of online multimedia: 

 Present your photos, videos, and music
directly in your Online Album or in
worldwide Internet communities.

 Find professional templates & content for
enhancing your personal projects.

 Design your own personalized website using professional Flash® design with photos, videos,
music & impressive animations. 

 Order brilliant photo prints to be sent directly to your doorstep. It's quick, easy, and well-priced.
Experience these and many more online services on http://www.magix-online.com
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magix.info
 Help and get help
 - Directly from within the program, you'll be able to access magix.info, the new MAGIX Knowledge
Base. In the Knowledge Base, you'll find answers to all of the most frequently asked questions about
MAGIX products and multimedia in general. Couldn't find an answer to your particular question? No
problem, just ask the question yourself. 

You can go to magix.info
 in the "Online" menu, or via this button. 
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Introduction
In this chapter
What is MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe?
What’s new in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe?
Additional new features of the deluxe version
Properties
Overview of the program interface
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What is MAGIX Xtreme PhotoStory on CD &
DVD 8 deluxe?
 The name says it all:
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe puts your photos and movies onto a CD or DVD
as a slideshow for viewing on your PC screen or TV like a movie. 
The typical scenario: 
Holiday, family, or birthday pictures are scattered all over the place in envelopes, photo albums, and
scrap books. The hard disk is overflowing with photos from your digital camera and camera phone, and
a burner is available, as is a scanner. MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe will tidy
everything up, compile your photos, enhance them, and then burn them all onto CD or DVD. 
What's so special, you ask?
 The CD or DVD can then be played on a DVD player and viewed on a TV. A personal slideshow is
created and perfectly arranged just like a feature film. Of course, you can archive your entire project data
onto your slideshow DVD as well. Additionally, there are options that let you open each photo
individually and interactively like a photo album (as a TV Showtime DVD or JPEG disc, for example). If
you have the appropriate end devices, then you can experience everything in high definition as a WMV
HD on your PC screen or as a HD DVD on a wide-screen TV. 
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What’s new in MAGIX Xtreme PhotoStory
on CD & DVD 8 deluxe?
 50 adjustable 1-click templates for 3D title and text
animations
 Add exciting 3D titles to your images. MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides
50 presets for you to customize. If you want a static or animated text, to use individual titles, or if you
want to add a transparent background to your images, the sky's the limit – thanks to the outstanding
technology featured in MAGIX 3D maker. You'll find the templates in the Media Pool under the tab "
Titles
". 

Slideshow wizard
 Create professional slideshows with ease using the Slideshow assistant. In just five steps, the wizard will
show you what you need to do. Select the format, photos, videos, effects, and background music, and
MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe will create the slideshow automatically. Once it's
created, you can burn your slideshow directly onto CD or DVD or edit it manually. The slideshow
wizard is available at program start and can be accessed later via "File -> Wizards -> Slideshow
 wizard". 

Improved image quality
 Panorama photomontages and slideshows that you upload to your personal MAGIX Online Album now
have improved image quality. 

Improved removal of audio distortions
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe can now remove unwanted audio distortions
from your video recordings even better than before. Camera sounds and other noise are now a thing of
the past. These improved options can be found under "Effects -> Optimize sound
" once you have an object selected. 

Synchronize sound and picture perfectly
 Now you can align music, sounds, and speech with photos and events in videos in perfect synchronicity.
A sample-exact timeline and corresponding zoom level
 helps with the alignment. This is especially practical for creating music videos, since picture and sound
require a 100% match. 

Convenient JKL navigation
 Navigate through your project via so-called "JKL" navigation. The J, K, and L keys on your computer
can be used to rewind ("J"), stop ("K"), and fast forward ("L"). The speed can be increased for these
functions by pressing J or L again. Up to 128x speed is possible. Holding down "Shift" slows down
playback. 

Over 20 detail improvements
  Improved creation of slideshows for 16:9 format monitors.
 Improved panorama montage automation
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 Effects settings can be conveniently copied to other photos, videos, and music.
 Gap-searching function warns you automatically before burning if there are gaps in the project.
 Slideshows can be attached to one another.
 and much more

 MAGIX Photo Manager
 MAGIX Photo Manager is the perfect companion for managing your photos. Create digital photo
albums and add new images with ease. MAGIX Photo Manager can be found under "File ->
Supplementary programs". 
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Additional new features of the deluxe version
 HD ready
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe deluxe can now burn high-resolution Blu-ray
DiscsTM with animated menus. There are plenty of high-quality templates for menus that are especially
suited to the options offered by Blu-ray Discs TM

. 

YouTube upload
 You can upload your slideshow directly to YouTube from MAGIX Xtreme PhotoStory on CD & DVD
8 deluxe for everyone in the world to see. 

Individually dynamic
 Thanks to animations with waypoints (keyframes), you can control the timing of effects. Besides
individual zooms and camera pans, you can also apply color ranges so that they appear and disappear in
your images. Settings options can be found in the Media Pool under "Effects". Read more about this in
the chapter "Animating objects" in the help file. 

Artistic and deforming filters
 There is no limit to your creativity thanks to the new artistic and deforming filters. These are also
available under the "Effects
" tab in the Media Pool. 

Other new features in the PLUS version
  Temporal zoom & fast forward: Accelerate longer video sequences or slow down fast

movement.
 Rhythmic image changes: Have the images change in time with the background music

automatically.
 Video stabilization: Rescue your wobbly recordings.
 HD slideshow player: Play high-resolution slideshows without having to export them

beforehand. Just switch the video monitor to fullscreen mode to do so. This function requires
activation of the "hardware acceleration (Direct3D)" video mode.

 Exchange mode for media in slideshows: Swap media from your project with a click.
 50 more 1-click templates for individual 3D titles & text animations
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Properties
 Import 

 Photo: Windows bitmaps (BMP), JPEG, GIF, ZSoft Paintbrush (PCX), PNG, Portable Pixmap
(PPM), Portable Greymap (PGM), Adobe Photoshop (PSD), Sun Rasterfile, Targa (TGA),
Tagged Image File Format (TIFF), Photo CD (PCD). 

 Video: AVI, DV-AVI (Types 1 and 2), Windows Media 9, MPEG-1, MPEG-2, QuickTime
movie, MAGIX Video (MXV).

 Text: You can easily enter longer texts such as credits with any text processing program and
then save them in the universal RTF text format. Loading this kind of text into MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe creates a text object.

 Audio: Wave, MP3, OGG VORBIS, WMA, Audio CD track from non copy-protected CDs.

 Export
 Slideshows can be exported in the following formats as video files: MXV (MAGIX Video), AVI,
MPEG-1/-2, Windows Media 9, QuickTime (*.MOV), RealMedia, and FlashTM (FlashTM only via
MAGIX Online Album
). 
Please note:
 The MPEG-2 encoder required for the MPEG-2 export has not yet been activated. To unlock it for
free, please have your serial number ready (found in the CD case of your installation CD or on the inside
of your DVD box). 

Three views
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides three specialized views for especially
easy editing: 

 Storyboard mode lists several photos in sequence. Every photo is displayed with a preview
picture in the storyboard. Choose how you want to fade between photos from many different
transition options.

 Timeline mode chronologically displays your photos with text and sound elements over four
tracks. The longer the representative object remains in the track, the longer the corresponding
photo will be displayed during playback. In total, you have four tracks to arrange your photos
with titles, movie sequences, and music.

 Overview mode displays all photos in multiple rows. The zoom function makes sure that the
number of photos you want to view can be viewed at the same time. Photos or photo groups can
be deleted, or their order in the list can be changed.

 Concentrated multimedia power
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides a large number of multimedia functions
that help you really get the best out of your photos and make fascinating slideshows from good photos.
For example: 

 Image optimization: Typical errors (exposure, color, redeye, etc.) can be easily fixed using the
"1 click" effect. Picture size and position can be corrected, for example, by increasing the size, by
rotating, clipping, levelling the horizon, etc. Each editing step is non-destructive, i.e. the original
photos remain the same.

 Transitions: Besides the many variations for "simple transitions" (e.g. soft fades, black fades,
page turn, wave, etc.), there are also complex transitions like picture-in-picture fades or thematic
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3D fade series (gallery, photo table, notice board, etc.).
 3D effect templates to reshape subjects and have them fly through the picture.
 1-click animations for transforming photos into videos (jumping, mosaic, kaleidescope, etc.).
 Titles & texts: You can enter text in various fonts and colors and position them wherever you

want in the picture. Dynamic movement of the titles and texts are also possible (for opening and
closing credits, for example).

 Zooms & camera movements: Zoom into picture sections, pan across the picture!
 Decorative elements and superimposed videos with cartoons, speech bubbles, costume

accessories, frames, etc.
 Multimedia opening and closing credits with video templates including sound, personal texts,

and motifs.
 Dubbing: Theme-related background music for every occasion is included. You can import your

own CDs and MP3s directly. The integrated MAGIX Soundtrack Maker is used for quickly
composing your own background music from musical templates. The recording functions enable
individual spoken commentary via microphone. Multiple options for sound optimization enhance
and unify all sound elements in one coherent audio track.

 Present & share
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides very flexible options for presenting and
sharing your slideshows. For example: 

 Burn a disc: All standard disc types for playback on DVD players and PCs can be created:
Video DVD, (S)VCD, miniDVD, TV-JPEG disc.

 DVD menus: Interactive DVD menus are created automatically. Uniquely customizable
templates with intros, animated buttons, 3D titles, and music are included. When designing the
menu you can directly access the motifs of your slideshow.

 TV formats: All TV formats are supported: standard (4:3), widescreen (16:9), PAL, NTSC.
 Data archiving: Original photos and project backups can be archived to CD or DVD, including

playback software which can play the data archive immediately on any PC.
 Presentation on a free website: MAGIX Online Album and MAGIX Community provide

comprehensive options for presenting your works to the public online or just to your friends. And
all of it comes for free on your own website which can be created and designed with just a few
clicks.

 Integration into your own website: If you already have a website, then you can also integrate
your slideshow into it. To do so, there are a number of video formats available (e.g. WMV or
FlashTM).

 Also in the PLUS version
  More elements and templates: Transition variations, 3D fade series, 3D effects, 1-click

animations, decorative elements, opening and closing credits, movieshow themes.
 3D design & 3D animation: Freely reshape or rotate photos in front of various backgrounds,

have pictures spin through space or distort them.
 Single frame capture for video camcorders and webcams (e.g. for cartoons).
 MAGIX Music Editor for detailed sound editing.
 MAGIX Print Studio for CD/DVD cases, labels, photo calendars, and much more.
 MAGIX Xtreme Photo Designer 6 for detailed image editing.
 Thematic background music and dubbing sounds.
 Picture-in-picture animations: Create breathtaking collages.
 Interactive, high-resolution PC slideshows: Present your slideshows with menus directly on

your PC.
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 Automatic volume reduction during voice-overs and speech.
 Blu-ray Disc support.
 and much more

 Overview of the program interface
 After starting MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, you'll see the following setup: 

1 Menu bar
2 "Slideshow" screen

 for creating and editing your slideshows. 
3 "Burn" screen

 for burning slideshows to disc. 
4 Media Pool

 for navigating through the folders of your computer. 
5 Video monitor

 with universal preview function so that you always see what
the effects and settings do. 

6 Navigation buttons/Transport console
 of the video monitor. 

7 Toolbar
 which supplies different tools depending on the editing mode
activated. 

8 Buttons for quickly toggling between the three views:
Overview mode, Timeline mode, and Storyboard mode
. 

9 Arranger:
 All the pictures of your slideshow are shown here. 
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Import 
 Photo: Windows bitmaps (BMP), JPEG, GIF, ZSoft Paintbrush (PCX), PNG, Portable Pixmap

(PPM), Portable Greymap (PGM), Adobe Photoshop (PSD), Sun Rasterfile, Targa (TGA),
Tagged Image File Format (TIFF), Photo CD (PCD). 

 Video: AVI, DV-AVI (Types 1 and 2), Windows Media 9, MPEG-1, MPEG-2, QuickTime
movie, MAGIX Video (MXV).

 Text: You can easily enter longer texts such as credits with any text processing program and
then save them in the universal RTF text format. Loading this kind of text into MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe creates a text object.

 Audio: Wave, MP3, OGG VORBIS, WMA, Audio CD track from non copy-protected CDs.

 Export
 Slideshows can be exported in the following formats as video files: MXV (MAGIX Video), AVI,
MPEG-1/-2, Windows Media 9, QuickTime (*.MOV), RealMedia, and FlashTM (FlashTM only via
MAGIX Online Album
). 
Please note:
 The MPEG-2 encoder required for the MPEG-2 export has not yet been activated. To unlock it for
free, please have your serial number ready (found in the CD case of your installation CD or on the inside
of your DVD box). 

Three views
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides three specialized views for especially
easy editing: 

 Storyboard mode lists several photos in sequence. Every photo is displayed with a preview
picture in the storyboard. Choose how you want to fade between photos from many different
transition options.

 Timeline mode chronologically displays your photos with text and sound elements over four
tracks. The longer the representative object remains in the track, the longer the corresponding
photo will be displayed during playback. In total, you have four tracks to arrange your photos
with titles, movie sequences, and music.

 Overview mode displays all photos in multiple rows. The zoom function makes sure that the
number of photos you want to view can be viewed at the same time. Photos or photo groups can
be deleted, or their order in the list can be changed.

 Concentrated multimedia power
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides a large number of multimedia functions
that help you really get the best out of your photos and make fascinating slideshows from good photos.
For example: 

 Image optimization: Typical errors (exposure, color, redeye, etc.) can be easily fixed using the
"1 click" effect. Picture size and position can be corrected, for example, by increasing the size, by
rotating, clipping, levelling the horizon, etc. Each editing step is non-destructive, i.e. the original
photos remain the same.

 Transitions: Besides the many variations for "simple transitions" (e.g. soft fades, black fades,
page turn, wave, etc.), there are also complex transitions like picture-in-picture fades or thematic
3D fade series (gallery, photo table, notice board, etc.).

 3D effect templates to reshape subjects and have them fly through the picture.
 1-click animations for transforming photos into videos (jumping, mosaic, kaleidescope, etc.).
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 Titles & texts: You can enter text in various fonts and colors and position them wherever you
want in the picture. Dynamic movement of the titles and texts are also possible (for opening and
closing credits, for example).

 Zooms & camera movements: Zoom into picture sections, pan across the picture!
 Decorative elements and superimposed videos with cartoons, speech bubbles, costume

accessories, frames, etc.
 Multimedia opening and closing credits with video templates including sound, personal texts,

and motifs.
 Dubbing: Theme-related background music for every occasion is included. You can import your

own CDs and MP3s directly. The integrated MAGIX Soundtrack Maker is used for quickly
composing your own background music from musical templates. The recording functions enable
individual spoken commentary via microphone. Multiple options for sound optimization enhance
and unify all sound elements in one coherent audio track.

 Present & share
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides very flexible options for presenting and
sharing your slideshows. For example: 

 Burn a disc: All standard disc types for playback on DVD players and PCs can be created:
Video DVD, (S)VCD, miniDVD, TV-JPEG disc.

 DVD menus: Interactive DVD menus are created automatically. Uniquely customizable
templates with intros, animated buttons, 3D titles, and music are included. When designing the
menu you can directly access the motifs of your slideshow.

 TV formats: All TV formats are supported: standard (4:3), widescreen (16:9), PAL, NTSC.
 Data archiving: Original photos and project backups can be archived to CD or DVD, including

playback software which can play the data archive immediately on any PC.
 Presentation on a free website: MAGIX Online Album and MAGIX Community provide

comprehensive options for presenting your works to the public online or just to your friends. And
all of it comes for free on your own website which can be created and designed with just a few
clicks.

 Integration into your own website: If you already have a website, then you can also integrate
your slideshow into it. To do so, there are a number of video formats available (e.g. WMV or
FlashTM).

 Also in the PLUS version
  More elements and templates: Transition variations, 3D fade series, 3D effects, 1-click

animations, decorative elements, opening and closing credits, movieshow themes.
 3D design & 3D animation: Freely reshape or rotate photos in front of various backgrounds,

have pictures spin through space or distort them.
 Single frame capture for video camcorders and webcams (e.g. for cartoons).
 MAGIX Music Editor for detailed sound editing.
 MAGIX Print Studio for CD/DVD cases, labels, photo calendars, and much more.
 MAGIX Xtreme Photo Designer 6 for detailed image editing.
 Thematic background music and dubbing sounds.
 Picture-in-picture animations: Create breathtaking collages.
 Interactive, high-resolution PC slideshows: Present your slideshows with menus directly on

your PC.
 Automatic volume reduction during voice-overs and speech.
 Blu-ray Disc support.
 and much more
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 Overview of the program interface
 After starting MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, you'll see the following setup: 

1 Menu bar
2 "Slideshow" screen

 for creating and editing your slideshows. 
3 "Burn" screen

 for burning slideshows to disc. 
4 Media Pool

 for navigating through the folders of your computer. 
5 Video monitor

 with universal preview function so that you always see what
the effects and settings do. 

6 Navigation buttons/Transport console
 of the video monitor. 

7 Toolbar
 which supplies different tools depending on the editing mode
activated. 

8 Buttons for quickly toggling between the three views:
Overview mode, Timeline mode, and Storyboard mode
. 

9 Arranger:
 All the pictures of your slideshow are shown here. 
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Export
 Slideshows can be exported in the following formats as video files: MXV (MAGIX Video), AVI,
MPEG-1/-2, Windows Media 9, QuickTime (*.MOV), RealMedia, and FlashTM (FlashTM only via
MAGIX Online Album
). 
Please note:
 The MPEG-2 encoder required for the MPEG-2 export has not yet been activated. To unlock it for
free, please have your serial number ready (found in the CD case of your installation CD or on the inside
of your DVD box). 

Three views
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides three specialized views for especially
easy editing: 

 Storyboard mode lists several photos in sequence. Every photo is displayed with a preview
picture in the storyboard. Choose how you want to fade between photos from many different
transition options.

 Timeline mode chronologically displays your photos with text and sound elements over four
tracks. The longer the representative object remains in the track, the longer the corresponding
photo will be displayed during playback. In total, you have four tracks to arrange your photos
with titles, movie sequences, and music.

 Overview mode displays all photos in multiple rows. The zoom function makes sure that the
number of photos you want to view can be viewed at the same time. Photos or photo groups can
be deleted, or their order in the list can be changed.

 Concentrated multimedia power
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides a large number of multimedia functions
that help you really get the best out of your photos and make fascinating slideshows from good photos.
For example: 

 Image optimization: Typical errors (exposure, color, redeye, etc.) can be easily fixed using the
"1 click" effect. Picture size and position can be corrected, for example, by increasing the size, by
rotating, clipping, levelling the horizon, etc. Each editing step is non-destructive, i.e. the original
photos remain the same.

 Transitions: Besides the many variations for "simple transitions" (e.g. soft fades, black fades,
page turn, wave, etc.), there are also complex transitions like picture-in-picture fades or thematic
3D fade series (gallery, photo table, notice board, etc.).

 3D effect templates to reshape subjects and have them fly through the picture.
 1-click animations for transforming photos into videos (jumping, mosaic, kaleidescope, etc.).
 Titles & texts: You can enter text in various fonts and colors and position them wherever you

want in the picture. Dynamic movement of the titles and texts are also possible (for opening and
closing credits, for example).

 Zooms & camera movements: Zoom into picture sections, pan across the picture!
 Decorative elements and superimposed videos with cartoons, speech bubbles, costume

accessories, frames, etc.
 Multimedia opening and closing credits with video templates including sound, personal texts,

and motifs.
 Dubbing: Theme-related background music for every occasion is included. You can import your

own CDs and MP3s directly. The integrated MAGIX Soundtrack Maker is used for quickly
composing your own background music from musical templates. The recording functions enable
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individual spoken commentary via microphone. Multiple options for sound optimization enhance
and unify all sound elements in one coherent audio track.

 Present & share
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides very flexible options for presenting and
sharing your slideshows. For example: 

 Burn a disc: All standard disc types for playback on DVD players and PCs can be created:
Video DVD, (S)VCD, miniDVD, TV-JPEG disc.

 DVD menus: Interactive DVD menus are created automatically. Uniquely customizable
templates with intros, animated buttons, 3D titles, and music are included. When designing the
menu you can directly access the motifs of your slideshow.

 TV formats: All TV formats are supported: standard (4:3), widescreen (16:9), PAL, NTSC.
 Data archiving: Original photos and project backups can be archived to CD or DVD, including

playback software which can play the data archive immediately on any PC.
 Presentation on a free website: MAGIX Online Album and MAGIX Community provide

comprehensive options for presenting your works to the public online or just to your friends. And
all of it comes for free on your own website which can be created and designed with just a few
clicks.

 Integration into your own website: If you already have a website, then you can also integrate
your slideshow into it. To do so, there are a number of video formats available (e.g. WMV or
FlashTM).

 Also in the PLUS version
  More elements and templates: Transition variations, 3D fade series, 3D effects, 1-click

animations, decorative elements, opening and closing credits, movieshow themes.
 3D design & 3D animation: Freely reshape or rotate photos in front of various backgrounds,

have pictures spin through space or distort them.
 Single frame capture for video camcorders and webcams (e.g. for cartoons).
 MAGIX Music Editor for detailed sound editing.
 MAGIX Print Studio for CD/DVD cases, labels, photo calendars, and much more.
 MAGIX Xtreme Photo Designer 6 for detailed image editing.
 Thematic background music and dubbing sounds.
 Picture-in-picture animations: Create breathtaking collages.
 Interactive, high-resolution PC slideshows: Present your slideshows with menus directly on

your PC.
 Automatic volume reduction during voice-overs and speech.
 Blu-ray Disc support.
 and much more

 Overview of the program interface
 After starting MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, you'll see the following setup: 
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1 Menu bar
2 "Slideshow" screen

 for creating and editing your slideshows. 
3 "Burn" screen

 for burning slideshows to disc. 
4 Media Pool

 for navigating through the folders of your computer. 
5 Video monitor

 with universal preview function so that you always see what
the effects and settings do. 

6 Navigation buttons/Transport console
 of the video monitor. 

7 Toolbar
 which supplies different tools depending on the editing mode
activated. 

8 Buttons for quickly toggling between the three views:
Overview mode, Timeline mode, and Storyboard mode
. 

9 Arranger:
 All the pictures of your slideshow are shown here. 
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Three views
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides three specialized views for especially
easy editing: 

 Storyboard mode lists several photos in sequence. Every photo is displayed with a preview
picture in the storyboard. Choose how you want to fade between photos from many different
transition options.

 Timeline mode chronologically displays your photos with text and sound elements over four
tracks. The longer the representative object remains in the track, the longer the corresponding
photo will be displayed during playback. In total, you have four tracks to arrange your photos
with titles, movie sequences, and music.

 Overview mode displays all photos in multiple rows. The zoom function makes sure that the
number of photos you want to view can be viewed at the same time. Photos or photo groups can
be deleted, or their order in the list can be changed.

 Concentrated multimedia power
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides a large number of multimedia functions
that help you really get the best out of your photos and make fascinating slideshows from good photos.
For example: 

 Image optimization: Typical errors (exposure, color, redeye, etc.) can be easily fixed using the
"1 click" effect. Picture size and position can be corrected, for example, by increasing the size, by
rotating, clipping, levelling the horizon, etc. Each editing step is non-destructive, i.e. the original
photos remain the same.

 Transitions: Besides the many variations for "simple transitions" (e.g. soft fades, black fades,
page turn, wave, etc.), there are also complex transitions like picture-in-picture fades or thematic
3D fade series (gallery, photo table, notice board, etc.).

 3D effect templates to reshape subjects and have them fly through the picture.
 1-click animations for transforming photos into videos (jumping, mosaic, kaleidescope, etc.).
 Titles & texts: You can enter text in various fonts and colors and position them wherever you

want in the picture. Dynamic movement of the titles and texts are also possible (for opening and
closing credits, for example).

 Zooms & camera movements: Zoom into picture sections, pan across the picture!
 Decorative elements and superimposed videos with cartoons, speech bubbles, costume

accessories, frames, etc.
 Multimedia opening and closing credits with video templates including sound, personal texts,

and motifs.
 Dubbing: Theme-related background music for every occasion is included. You can import your

own CDs and MP3s directly. The integrated MAGIX Soundtrack Maker is used for quickly
composing your own background music from musical templates. The recording functions enable
individual spoken commentary via microphone. Multiple options for sound optimization enhance
and unify all sound elements in one coherent audio track.

 Present & share
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides very flexible options for presenting and
sharing your slideshows. For example: 

 Burn a disc: All standard disc types for playback on DVD players and PCs can be created:
Video DVD, (S)VCD, miniDVD, TV-JPEG disc.

 DVD menus: Interactive DVD menus are created automatically. Uniquely customizable
templates with intros, animated buttons, 3D titles, and music are included. When designing the
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menu you can directly access the motifs of your slideshow.
 TV formats: All TV formats are supported: standard (4:3), widescreen (16:9), PAL, NTSC.
 Data archiving: Original photos and project backups can be archived to CD or DVD, including

playback software which can play the data archive immediately on any PC.
 Presentation on a free website: MAGIX Online Album and MAGIX Community provide

comprehensive options for presenting your works to the public online or just to your friends. And
all of it comes for free on your own website which can be created and designed with just a few
clicks.

 Integration into your own website: If you already have a website, then you can also integrate
your slideshow into it. To do so, there are a number of video formats available (e.g. WMV or
FlashTM).

 Also in the PLUS version
  More elements and templates: Transition variations, 3D fade series, 3D effects, 1-click

animations, decorative elements, opening and closing credits, movieshow themes.
 3D design & 3D animation: Freely reshape or rotate photos in front of various backgrounds,

have pictures spin through space or distort them.
 Single frame capture for video camcorders and webcams (e.g. for cartoons).
 MAGIX Music Editor for detailed sound editing.
 MAGIX Print Studio for CD/DVD cases, labels, photo calendars, and much more.
 MAGIX Xtreme Photo Designer 6 for detailed image editing.
 Thematic background music and dubbing sounds.
 Picture-in-picture animations: Create breathtaking collages.
 Interactive, high-resolution PC slideshows: Present your slideshows with menus directly on

your PC.
 Automatic volume reduction during voice-overs and speech.
 Blu-ray Disc support.
 and much more

 Overview of the program interface
 After starting MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, you'll see the following setup: 
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1 Menu bar
2 "Slideshow" screen

 for creating and editing your slideshows. 
3 "Burn" screen

 for burning slideshows to disc. 
4 Media Pool

 for navigating through the folders of your computer. 
5 Video monitor

 with universal preview function so that you always see what
the effects and settings do. 

6 Navigation buttons/Transport console
 of the video monitor. 

7 Toolbar
 which supplies different tools depending on the editing mode
activated. 

8 Buttons for quickly toggling between the three views:
Overview mode, Timeline mode, and Storyboard mode
. 

9 Arranger:
 All the pictures of your slideshow are shown here. 
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Concentrated multimedia power
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides a large number of multimedia functions
that help you really get the best out of your photos and make fascinating slideshows from good photos.
For example: 

 Image optimization: Typical errors (exposure, color, redeye, etc.) can be easily fixed using the
"1 click" effect. Picture size and position can be corrected, for example, by increasing the size, by
rotating, clipping, levelling the horizon, etc. Each editing step is non-destructive, i.e. the original
photos remain the same.

 Transitions: Besides the many variations for "simple transitions" (e.g. soft fades, black fades,
page turn, wave, etc.), there are also complex transitions like picture-in-picture fades or thematic
3D fade series (gallery, photo table, notice board, etc.).

 3D effect templates to reshape subjects and have them fly through the picture.
 1-click animations for transforming photos into videos (jumping, mosaic, kaleidescope, etc.).
 Titles & texts: You can enter text in various fonts and colors and position them wherever you

want in the picture. Dynamic movement of the titles and texts are also possible (for opening and
closing credits, for example).

 Zooms & camera movements: Zoom into picture sections, pan across the picture!
 Decorative elements and superimposed videos with cartoons, speech bubbles, costume

accessories, frames, etc.
 Multimedia opening and closing credits with video templates including sound, personal texts,

and motifs.
 Dubbing: Theme-related background music for every occasion is included. You can import your

own CDs and MP3s directly. The integrated MAGIX Soundtrack Maker is used for quickly
composing your own background music from musical templates. The recording functions enable
individual spoken commentary via microphone. Multiple options for sound optimization enhance
and unify all sound elements in one coherent audio track.

 Present & share
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides very flexible options for presenting and
sharing your slideshows. For example: 

 Burn a disc: All standard disc types for playback on DVD players and PCs can be created:
Video DVD, (S)VCD, miniDVD, TV-JPEG disc.

 DVD menus: Interactive DVD menus are created automatically. Uniquely customizable
templates with intros, animated buttons, 3D titles, and music are included. When designing the
menu you can directly access the motifs of your slideshow.

 TV formats: All TV formats are supported: standard (4:3), widescreen (16:9), PAL, NTSC.
 Data archiving: Original photos and project backups can be archived to CD or DVD, including

playback software which can play the data archive immediately on any PC.
 Presentation on a free website: MAGIX Online Album and MAGIX Community provide

comprehensive options for presenting your works to the public online or just to your friends. And
all of it comes for free on your own website which can be created and designed with just a few
clicks.

 Integration into your own website: If you already have a website, then you can also integrate
your slideshow into it. To do so, there are a number of video formats available (e.g. WMV or
FlashTM).

 Also in the PLUS version
  More elements and templates: Transition variations, 3D fade series, 3D effects, 1-click
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animations, decorative elements, opening and closing credits, movieshow themes.
 3D design & 3D animation: Freely reshape or rotate photos in front of various backgrounds,

have pictures spin through space or distort them.
 Single frame capture for video camcorders and webcams (e.g. for cartoons).
 MAGIX Music Editor for detailed sound editing.
 MAGIX Print Studio for CD/DVD cases, labels, photo calendars, and much more.
 MAGIX Xtreme Photo Designer 6 for detailed image editing.
 Thematic background music and dubbing sounds.
 Picture-in-picture animations: Create breathtaking collages.
 Interactive, high-resolution PC slideshows: Present your slideshows with menus directly on

your PC.
 Automatic volume reduction during voice-overs and speech.
 Blu-ray Disc support.
 and much more

 Overview of the program interface
 After starting MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, you'll see the following setup: 

1 Menu bar
2 "Slideshow" screen

 for creating and editing your slideshows. 
3 "Burn" screen

 for burning slideshows to disc. 
4 Media Pool

 for navigating through the folders of your computer. 
5 Video monitor

 with universal preview function so that you always see what
the effects and settings do. 

6 Navigation buttons/Transport console
 of the video monitor. 

7 Toolbar
 which supplies different tools depending on the editing mode
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activated. 
8 Buttons for quickly toggling between the three views:

Overview mode, Timeline mode, and Storyboard mode
. 

9 Arranger:
 All the pictures of your slideshow are shown here. 
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Present & share
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides very flexible options for presenting and
sharing your slideshows. For example: 

 Burn a disc: All standard disc types for playback on DVD players and PCs can be created:
Video DVD, (S)VCD, miniDVD, TV-JPEG disc.

 DVD menus: Interactive DVD menus are created automatically. Uniquely customizable
templates with intros, animated buttons, 3D titles, and music are included. When designing the
menu you can directly access the motifs of your slideshow.

 TV formats: All TV formats are supported: standard (4:3), widescreen (16:9), PAL, NTSC.
 Data archiving: Original photos and project backups can be archived to CD or DVD, including

playback software which can play the data archive immediately on any PC.
 Presentation on a free website: MAGIX Online Album and MAGIX Community provide

comprehensive options for presenting your works to the public online or just to your friends. And
all of it comes for free on your own website which can be created and designed with just a few
clicks.

 Integration into your own website: If you already have a website, then you can also integrate
your slideshow into it. To do so, there are a number of video formats available (e.g. WMV or
FlashTM).

 Also in the PLUS version
  More elements and templates: Transition variations, 3D fade series, 3D effects, 1-click

animations, decorative elements, opening and closing credits, movieshow themes.
 3D design & 3D animation: Freely reshape or rotate photos in front of various backgrounds,

have pictures spin through space or distort them.
 Single frame capture for video camcorders and webcams (e.g. for cartoons).
 MAGIX Music Editor for detailed sound editing.
 MAGIX Print Studio for CD/DVD cases, labels, photo calendars, and much more.
 MAGIX Xtreme Photo Designer 6 for detailed image editing.
 Thematic background music and dubbing sounds.
 Picture-in-picture animations: Create breathtaking collages.
 Interactive, high-resolution PC slideshows: Present your slideshows with menus directly on

your PC.
 Automatic volume reduction during voice-overs and speech.
 Blu-ray Disc support.
 and much more

 Overview of the program interface
 After starting MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, you'll see the following setup: 
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1 Menu bar
2 "Slideshow" screen

 for creating and editing your slideshows. 
3 "Burn" screen

 for burning slideshows to disc. 
4 Media Pool

 for navigating through the folders of your computer. 
5 Video monitor

 with universal preview function so that you always see what
the effects and settings do. 

6 Navigation buttons/Transport console
 of the video monitor. 

7 Toolbar
 which supplies different tools depending on the editing mode
activated. 

8 Buttons for quickly toggling between the three views:
Overview mode, Timeline mode, and Storyboard mode
. 

9 Arranger:
 All the pictures of your slideshow are shown here. 
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Overview of the program interface
 After starting MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, you'll see the following setup: 

1 Menu bar
2 "Slideshow" screen

 for creating and editing your slideshows. 
3 "Burn" screen

 for burning slideshows to disc. 
4 Media Pool

 for navigating through the folders of your computer. 
5 Video monitor

 with universal preview function so that you always see what
the effects and settings do. 

6 Navigation buttons/Transport console
 of the video monitor. 

7 Toolbar
 which supplies different tools depending on the editing mode
activated. 

8 Buttons for quickly toggling between the three views:
Overview mode, Timeline mode, and Storyboard mode
. 

9 Arranger:
 All the pictures of your slideshow are shown here. 
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Quick start
In this chapter
MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe – It's this easy!
Create a new slideshow with the wizard
Designing slideshows
Creating CD/DVD menus
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MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe – It's this easy!
 Disc projects, slideshows, and photos
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
 allows you to work with disc projects, slideshows, and photos. In order to work quickly and intuitively,
it is important to know the differences between these three hierarchically-ordered terms. 

Project
 A project includes everything that you want to put on your CD and DVD. This normally contains one or
more slideshows and includes a menu structure/menu design which allows you to choose a slideshow
later on the CD or DVD. Projects can be saved as "<Pojektdatei>" files on your hard drive and can be
loaded later, e.g. to edit individual slideshows. 

Slideshow
 A slideshow is a multimedia presentation of photos which is played like a film. Enjoy it on a PC or TV,
since it offers maximum multimedia entertainment value from your photos, videos, music, title texts,
transition effects, and much more. 
Any slideshow can be exported individually as a video. The "project" can be considered a type of drawer
into which you can put multiple slideshows for burning to CD or DVD later. 

Photos
 Photos are the main component of a slideshow. The formats supported can be accessed under "
Properties
". You can integrate photos and videos into your slideshow (provided that the corresponding video
codec is installed on your system). 
Summary
: Projects contain slideshows, and slideshows contain photos. A project's slideshows appear as menu
entries; photos (and videos) appear later on the CD or DVD as selectable menu entries. 
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Disc projects, slideshows, and photos
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
 allows you to work with disc projects, slideshows, and photos. In order to work quickly and intuitively,
it is important to know the differences between these three hierarchically-ordered terms. 

Project
 A project includes everything that you want to put on your CD and DVD. This normally contains one or
more slideshows and includes a menu structure/menu design which allows you to choose a slideshow
later on the CD or DVD. Projects can be saved as "<Pojektdatei>" files on your hard drive and can be
loaded later, e.g. to edit individual slideshows. 

Slideshow
 A slideshow is a multimedia presentation of photos which is played like a film. Enjoy it on a PC or TV,
since it offers maximum multimedia entertainment value from your photos, videos, music, title texts,
transition effects, and much more. 
Any slideshow can be exported individually as a video. The "project" can be considered a type of drawer
into which you can put multiple slideshows for burning to CD or DVD later. 

Photos
 Photos are the main component of a slideshow. The formats supported can be accessed under "
Properties
". You can integrate photos and videos into your slideshow (provided that the corresponding video
codec is installed on your system). 
Summary
: Projects contain slideshows, and slideshows contain photos. A project's slideshows appear as menu
entries; photos (and videos) appear later on the CD or DVD as selectable menu entries. 
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Create new project
 Start MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. After starting the program, the start dialog
"Welcome to MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe" will open. 

There are three options here: 
 "Open and existing project" that you have already created for further editing.
 "Create a new project manually" starts a new project.
 "Create a new project using the wizard" creates a new slideshow with the help of the wizard by

adjusting the most important settings for you.
Select "Create a new project manually
". 

New slideshow settings
 The dialog "Settings" follows: 

Select how your project should be optimized for playback in 4:3 or 16:9
 formats. The option "Automatically cut to fit screen" ensures that images don't have black edges inc ase
they don't fit into the given format. Enter a name under "Project name" to save the project as. "Disc
format" selects the medium for the capacity display to be shown at the edge of the screen in the lower left
side. 
Adjust the settings and click "OK". 

Load photos
 The "Slideshow
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" screen opens in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. The Media Pool is to the right. 

Once you have scanned in your photos from your digital camera, open the folder where the photo files
can be found. 
Tip
: You can also use presentations from standard presentation programs. To do so, export all slides from
your presentation program as JPEG files and open the MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe folder with the exported JPEGs. 

 If you click on an entry in the Media Pool, the corresponding photo will be shown on the Video
Monitor (preview function). This way, you can select all photos one after the other.

 The easiest way to load individual photos or entire folders is by double clicking your slideshow. If
you want to load multiple photos, you will have to select them in the Media Pool first. 

Quicker with the keyboard and mouse
: Click on the selected entries one after the other while holding down "Ctrl". If you would like to load a
sequence of files, hold the "Shift" key and first click on the first entry, then on the last. All entries present
in between will be selected. By holding down the left mouse button you can select drag out a selection
box over multiple pictures files to select them. "CTRL + A" selects every entry contained in a Media Pool
folder. 
Selected entries (including entire folders) can be selected by holding down the left mouse button and
dragging them into the slideshow (drag & drop). 

Burning CDs/DVDs

 Once you have all the photos you want in
your slideshow together, switch to the
"Burn" window. You can do this by
clicking on "Burn" to the top right.

 On the right hand side, you'll find the
"Burn disc" button. 
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Burning wizard:
 This button opens a wizard that
will help you set up the burning
project for various disc types.
There are a number of disc
types for different disc projects:
The slideshow or the film/video
which you can play in the DVD
player should be burned onto a
DVD, (S)VCD, miniDVD, or
JPEG disc. 

Disc projects which are meant for presentations on your computer monitor should be burned as
"Slideshows" or "High Definition Slideshows (WMV HD). 
Multi-disc:
 Finally, there is a disc type that can do anything, i.e. playback a slideshow on TV or PC as well as full
project backup: the multi-disc. The multi-disc combines slideshows for playback on a DVD player and
on the PC as well as the full project backup of all photo, video, and music files. 
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Burning CDs/DVDs

 Once you have all the photos you want in
your slideshow together, switch to the
"Burn" window. You can do this by
clicking on "Burn" to the top right.

 On the right hand side, you'll find the
"Burn disc" button. 

Burning wizard:
 This button opens a wizard that
will help you set up the burning
project for various disc types.
There are a number of disc
types for different disc projects:
The slideshow or the film/video
which you can play in the DVD
player should be burned onto a
DVD, (S)VCD, miniDVD, or
JPEG disc. 

Disc projects which are meant for presentations on your computer monitor should be burned as
"Slideshows" or "High Definition Slideshows (WMV HD). 
Multi-disc:
 Finally, there is a disc type that can do anything, i.e. playback a slideshow on TV or PC as well as full
project backup: the multi-disc. The multi-disc combines slideshows for playback on a DVD player and
on the PC as well as the full project backup of all photo, video, and music files. 
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More disc types
 To select other disc types, please click the top right to switch to "Advanced" mode: 

In advanced mode, the layout of the "Burn" window is far more complicated, since all functions are now
available at a glance. You can access the disc types by clicking the button for burning discs: 

In the disc selection dialog, you have to click on the "More options" button to view all available disc
types at once: 

 Disc projects that you can play in the DVD player to enjoy on TV should be burned onto a
DVD, (S)VCD, miniDVD, or JPEG disc. 

 Disc projects meant for presentation on your PC should be burned as slideshows or
high-definition slideshows (WMV HD). 

 In the deluxe version, you can also burn disc projects for high-resolution PC monitors. The
formats WMV HD or Blu-ray Disc are provided for this purpose.

 In the deluxe version, there is the disc type that can do anything – Playback a slideshow on TV
or PC as well as full project backup: the multi-disc. The multi-disc combines slideshows for
playback on a DVD player and on the PC in the WMV HD format as well as the full project
backup of all photo, video, and music files.

Ideally, hover the mouse over the buttons for a moment to view the popup information, and then read
important details about the corresponding disc type. 
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Create a new slideshow with the wizard
 The wizard helps you quickly and easily create great slideshows. 

Start MAGIX Xtreme
PhotoStory on CD &
DVD 8 deluxe and
select "Create new
project with wizard".
Then confirm the
selection with "OK". 

The wizard will now lead you through the steps required for creating a new project. 
Note: The slideshow wizard can be opened via "File
" in the "Wizards" submenu. 

Basic settings
Specify the ratio for the
project. You can also
determine how MAGIX
Xtreme PhotoStory on
CD & DVD 8 deluxe
should behave with
photos that do not
match the project's
formatting. 
Cut to fit screen automatically
: Images that do not correspond to the project's ratio are adjusted automatically. The zoom factor is set
in such a way that there are no black bars to the left or right or top to bottom. 
Project name
:Give your disc project a name. This name will be used as a preset title for the disc you are going to burn.
The slideshows will also be given this name. 
Disc format (capacity display)
: Set the disc type you prefer here. MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe estimates how
much space a disc project will occupy on a corresponding blank disc. This display can be found below
the slideshow. 

Load photos
Select photos via
"Load files..." that
should be added to the
project. 
"Delete" removes the
selected photos from
the list. 
The sequence of
photos can be
specified via drag &
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drop. 
Display time for each photo (seconds)
: By default, photos are displayed for the time entered here. Of course, you can later change the time
each photo is displayed. 
Total length of slideshow
: The approximate total length of the slideshow created is shown here. It adjusts to reflect any changes
that are made. 

Specify effects
 Simply select one of the styles that best suits the theme of your slideshow. If you don't want any effects,
then select the entry marked "No effects". 

Select background music
 You can select between the suggested pieces of music or one of your own by importing it into the list via
"Load file(s)". If the slideshow is long enough, then all of the pieces contained in the list will be loaded
into the photo one after the other. The sequence of songs can be specified via drag & drop. 
Play
: This button provides a preview of the selected song. 
Remove
: This deletes the selected song from the list. 

Finishing a new slideshow
 One click on "Finish" is enough for the wizard to create the slideshow. You now have the option to
watch your slideshow before you accept it. 
Manually edited slideshow: The slideshow created can be edited further however you want. 
Add a DVD menu to the slideshow and burn it: MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
now switches to the "Burn" screen. The slideshow can be fitted with a DVD menu and burned to DVD. 
You can now select how you would like to continue and then end the wizard. 
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Basic settings
Specify the ratio for the
project. You can also
determine how MAGIX
Xtreme PhotoStory on
CD & DVD 8 deluxe
should behave with
photos that do not
match the project's
formatting. 
Cut to fit screen automatically
: Images that do not correspond to the project's ratio are adjusted automatically. The zoom factor is set
in such a way that there are no black bars to the left or right or top to bottom. 
Project name
:Give your disc project a name. This name will be used as a preset title for the disc you are going to burn.
The slideshows will also be given this name. 
Disc format (capacity display)
: Set the disc type you prefer here. MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe estimates how
much space a disc project will occupy on a corresponding blank disc. This display can be found below
the slideshow. 

Load photos
Select photos via
"Load files..." that
should be added to the
project. 
"Delete" removes the
selected photos from
the list. 
The sequence of
photos can be
specified via drag &
drop. 

Display time for each photo (seconds)
: By default, photos are displayed for the time entered here. Of course, you can later change the time
each photo is displayed. 
Total length of slideshow
: The approximate total length of the slideshow created is shown here. It adjusts to reflect any changes
that are made. 

Specify effects
 Simply select one of the styles that best suits the theme of your slideshow. If you don't want any effects,
then select the entry marked "No effects". 

Select background music
 You can select between the suggested pieces of music or one of your own by importing it into the list via
"Load file(s)". If the slideshow is long enough, then all of the pieces contained in the list will be loaded
into the photo one after the other. The sequence of songs can be specified via drag & drop. 
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Play
: This button provides a preview of the selected song. 
Remove
: This deletes the selected song from the list. 

Finishing a new slideshow
 One click on "Finish" is enough for the wizard to create the slideshow. You now have the option to
watch your slideshow before you accept it. 
Manually edited slideshow: The slideshow created can be edited further however you want. 
Add a DVD menu to the slideshow and burn it: MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
now switches to the "Burn" screen. The slideshow can be fitted with a DVD menu and burned to DVD. 
You can now select how you would like to continue and then end the wizard. 
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Load photos
Select photos via
"Load files..." that
should be added to the
project. 
"Delete" removes the
selected photos from
the list. 
The sequence of
photos can be
specified via drag &
drop. 

Display time for each photo (seconds)
: By default, photos are displayed for the time entered here. Of course, you can later change the time
each photo is displayed. 
Total length of slideshow
: The approximate total length of the slideshow created is shown here. It adjusts to reflect any changes
that are made. 

Specify effects
 Simply select one of the styles that best suits the theme of your slideshow. If you don't want any effects,
then select the entry marked "No effects". 

Select background music
 You can select between the suggested pieces of music or one of your own by importing it into the list via
"Load file(s)". If the slideshow is long enough, then all of the pieces contained in the list will be loaded
into the photo one after the other. The sequence of songs can be specified via drag & drop. 
Play
: This button provides a preview of the selected song. 
Remove
: This deletes the selected song from the list. 

Finishing a new slideshow
 One click on "Finish" is enough for the wizard to create the slideshow. You now have the option to
watch your slideshow before you accept it. 
Manually edited slideshow: The slideshow created can be edited further however you want. 
Add a DVD menu to the slideshow and burn it: MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
now switches to the "Burn" screen. The slideshow can be fitted with a DVD menu and burned to DVD. 
You can now select how you would like to continue and then end the wizard. 
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Specify effects
 Simply select one of the styles that best suits the theme of your slideshow. If you don't want any effects,
then select the entry marked "No effects". 

Select background music
 You can select between the suggested pieces of music or one of your own by importing it into the list via
"Load file(s)". If the slideshow is long enough, then all of the pieces contained in the list will be loaded
into the photo one after the other. The sequence of songs can be specified via drag & drop. 
Play
: This button provides a preview of the selected song. 
Remove
: This deletes the selected song from the list. 

Finishing a new slideshow
 One click on "Finish" is enough for the wizard to create the slideshow. You now have the option to
watch your slideshow before you accept it. 
Manually edited slideshow: The slideshow created can be edited further however you want. 
Add a DVD menu to the slideshow and burn it: MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
now switches to the "Burn" screen. The slideshow can be fitted with a DVD menu and burned to DVD. 
You can now select how you would like to continue and then end the wizard. 
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Select background music
 You can select between the suggested pieces of music or one of your own by importing it into the list via
"Load file(s)". If the slideshow is long enough, then all of the pieces contained in the list will be loaded
into the photo one after the other. The sequence of songs can be specified via drag & drop. 
Play
: This button provides a preview of the selected song. 
Remove
: This deletes the selected song from the list. 

Finishing a new slideshow
 One click on "Finish" is enough for the wizard to create the slideshow. You now have the option to
watch your slideshow before you accept it. 
Manually edited slideshow: The slideshow created can be edited further however you want. 
Add a DVD menu to the slideshow and burn it: MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
now switches to the "Burn" screen. The slideshow can be fitted with a DVD menu and burned to DVD. 
You can now select how you would like to continue and then end the wizard. 
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Finishing a new slideshow
 One click on "Finish" is enough for the wizard to create the slideshow. You now have the option to
watch your slideshow before you accept it. 
Manually edited slideshow: The slideshow created can be edited further however you want. 
Add a DVD menu to the slideshow and burn it: MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
now switches to the "Burn" screen. The slideshow can be fitted with a DVD menu and burned to DVD. 
You can now select how you would like to continue and then end the wizard. 
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Designing slideshows
 Load and sort photos

1.  Start MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
2. Open the folder that points to your hard disk. This is located to the top right of the Media Pool,

and it is the location where you'll find the photos you wish to use.
3. Load all the photos that you wish to use in your slideshow. In the Media Pool, every object used

is marked red. This way you'll know which files are already in the storyboard.
 The space bar starts or stops playback. Each photo is shown one after the other in the video

monitor. Playback always occurs from the start marker above the photo bar. This marker can be
repositioned by clicking or by dragging with the mouse.

 The order of photos can be changed easily via dragging & dropping them and move to them to
the correct position.

The photo bar runs in three different views (arranger modes): In
"Overview" mode, you can use the entire screen to sort your
photos. In "Storyboard" mode, you can view pictures one after
the other and specify the duration, fades, effects, track names,
etc. In "Timeline" mode, you can edit the progress of your
slideshow precisely and define the fade-ins and fade-outs
exactly. 

Start and end markers
 The section between the start (S) and end marker (E) above the storyboard or the first track of the
timeline will be played back in your show each time. 

The start and end markers can be moved
in different ways by using the mouse. You
can move them to any position with drag
& drop or directly with a mouse click:
Left clicking in the timeline moves the
start marker, and right clicking moves the
end marker. 
The cursor is a red vertical line which
moves from left to right during playback
to show the current playback position. 

If you want to see play back your show, press the space bar or start the slideshow via the transport
console below the preview window. 

Optimizing your photos
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
 provides a lot of different editing functions for picture and sound. Let's start with "Storyboard" mode: 
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In this case, you'll see each
individual picture in a so-called
"photo box". Each photo box has
a number of settings for duration,
fades, effects, and text: 
 Set display time:
 Double clicking on the clock lets
you enter how long the photo
should be shown for. 

Add title and text:
 Titles (for example, subtitles, opening/closing credits)
can be added to every photo. Click on "Text". The
title editor is ready with a number of text design
variations. 
Fades:
 Between the photos you'll find the buttons for the
transitions (fades). Simply drag the start marker to just
before the beginning of a picture and the end marker
to behind it and press the space bar. The range
between the start and end markers will be played
back as an endless loop. Now you can try out the
fades one after the other and view the result
immediately in the video monitor. 
Picture editing:
 Press the "FX" button on the photo box to access the
effects and image processing tools which can be used
separately on each photo. Every photo's quality can
be optimized. 

If a photo is on its side or upside down, then click on the symbol with the rotating arrow. The photo will
rotate 90 degrees. You can control the effect directly on the video screen. 
To prepare photos for importing and optimizing for the slideshow, we recommend using MAGIX Photo
Manager. It has correctional tools for redeye, or auto-color and white balance for discoloration in
pictures. 
The program is installed automatically and can be used for quick previewing and easy management of
pictures from your database. Pictures sorted into the database can be loaded into the MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe Media Pool via the "Database" button. 
For more complex editing like photo panorama and photo filter effects, the deluxe version comes with a
separate image processing program MAGIX Xtreme Photo Designer. Users of the classic version can
download the latest software at any time for free. To load a photo into MAGIX Xtreme Photo Designer,
select the option "Edit photo" in the FX menu of the photo box. Read more on this in the MAGIX
Xtreme Photo Designer Help section. 
Dubbing sound:
 If you wish to add narration to your slideshow, then use the "Audio and video recording" function for
microphone recordings in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. The recording dialog
opens by clicking on the record button (with the red dot) in the transport console. You can also use
audio CDs, records, or tapes. Audio CD tracks of non copy-protected CDs and other audio files can be
dragged onto the photo box directly from the Media Pool. 
Editing and arranging ("Timeline" mode):
 "Timeline" mode displays your photos over the course of the slideshow. The longer the object remains in
the track, the longer the corresponding photo will be displayed during playback. Videos can also be
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used. 
The easiest way to access "Timeline" mode is via the "Tab"
key (you can also click on the corresponding link via the
left-hand border of the photo bar). 

You have four tracks in total: 
 on the first track there are photos or videos
 the second track is the audio track for narration and sound effects for individual photos and

videos
All audio material that you add to the second track directly below your photos and videos will be
attached to the corresponding photo and video material. If a picture or video already has sound material
attached to it (sound-in-picture support), it will be made visible in this track automatically. 

 on the third track you'll find the titles (that are created via the text input of StoryMaker or via the
title editor)

 the fourth track is suitable for background music. The audio material of this audio track can be
moved within a project any way you like.

The objects on the tracks can be re-sized with their lower edge "object handles". Move the mouse over
one of the lower corners of the object until the mouse pointer becomes a double arrow. You can now
stretch the object as much as you like. An object can be faded in or out with the handles to the top of the
object. This also applies to text and audio objects in the timeline. 

Cut slideshow or objects
 A simple cut can also be achieved by pressing the "T" shortcut key, or by using the symbol to the right of
the transport console. 
Hint
: Cuts are always made at the point where the red line is located. 
The arrow next to the cut button opens a selection menu with the following options: 
Split object ("T")
: This command splits the object at the position of the start marker to produce two separate objects. You
can also just press "T" on the keyboard for this action. 
Remove object beginning
: This command cuts the object at the point where the start marker is positioned and deletes all material
that precedes the start marker simultaneously. 
Remove object end
: This command cuts the object at the point where the start marker is positioned and deletes all material
that comes after the start marker simultaneously. 
Split slideshow
: This command splits the slideshow at the position of the start marker into two independent slideshows.
Both appear in the menu underneath the preview window in the "slideshow" area. 

Page 53



Load and sort photos
1.  Start MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
2. Open the folder that points to your hard disk. This is located to the top right of the Media Pool,

and it is the location where you'll find the photos you wish to use.
3. Load all the photos that you wish to use in your slideshow. In the Media Pool, every object used

is marked red. This way you'll know which files are already in the storyboard.
 The space bar starts or stops playback. Each photo is shown one after the other in the video

monitor. Playback always occurs from the start marker above the photo bar. This marker can be
repositioned by clicking or by dragging with the mouse.

 The order of photos can be changed easily via dragging & dropping them and move to them to
the correct position.

The photo bar runs in three different views (arranger modes): In
"Overview" mode, you can use the entire screen to sort your
photos. In "Storyboard" mode, you can view pictures one after
the other and specify the duration, fades, effects, track names,
etc. In "Timeline" mode, you can edit the progress of your
slideshow precisely and define the fade-ins and fade-outs
exactly. 

Start and end markers
 The section between the start (S) and end marker (E) above the storyboard or the first track of the
timeline will be played back in your show each time. 

The start and end markers can be moved
in different ways by using the mouse. You
can move them to any position with drag
& drop or directly with a mouse click:
Left clicking in the timeline moves the
start marker, and right clicking moves the
end marker. 
The cursor is a red vertical line which
moves from left to right during playback
to show the current playback position. 

If you want to see play back your show, press the space bar or start the slideshow via the transport
console below the preview window. 

Optimizing your photos
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
 provides a lot of different editing functions for picture and sound. Let's start with "Storyboard" mode: 
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In this case, you'll see each
individual picture in a so-called
"photo box". Each photo box has
a number of settings for duration,
fades, effects, and text: 
 Set display time:
 Double clicking on the clock lets
you enter how long the photo
should be shown for. 

Add title and text:
 Titles (for example, subtitles, opening/closing credits)
can be added to every photo. Click on "Text". The
title editor is ready with a number of text design
variations. 
Fades:
 Between the photos you'll find the buttons for the
transitions (fades). Simply drag the start marker to just
before the beginning of a picture and the end marker
to behind it and press the space bar. The range
between the start and end markers will be played
back as an endless loop. Now you can try out the
fades one after the other and view the result
immediately in the video monitor. 
Picture editing:
 Press the "FX" button on the photo box to access the
effects and image processing tools which can be used
separately on each photo. Every photo's quality can
be optimized. 

If a photo is on its side or upside down, then click on the symbol with the rotating arrow. The photo will
rotate 90 degrees. You can control the effect directly on the video screen. 
To prepare photos for importing and optimizing for the slideshow, we recommend using MAGIX Photo
Manager. It has correctional tools for redeye, or auto-color and white balance for discoloration in
pictures. 
The program is installed automatically and can be used for quick previewing and easy management of
pictures from your database. Pictures sorted into the database can be loaded into the MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe Media Pool via the "Database" button. 
For more complex editing like photo panorama and photo filter effects, the deluxe version comes with a
separate image processing program MAGIX Xtreme Photo Designer. Users of the classic version can
download the latest software at any time for free. To load a photo into MAGIX Xtreme Photo Designer,
select the option "Edit photo" in the FX menu of the photo box. Read more on this in the MAGIX
Xtreme Photo Designer Help section. 
Dubbing sound:
 If you wish to add narration to your slideshow, then use the "Audio and video recording" function for
microphone recordings in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. The recording dialog
opens by clicking on the record button (with the red dot) in the transport console. You can also use
audio CDs, records, or tapes. Audio CD tracks of non copy-protected CDs and other audio files can be
dragged onto the photo box directly from the Media Pool. 
Editing and arranging ("Timeline" mode):
 "Timeline" mode displays your photos over the course of the slideshow. The longer the object remains in
the track, the longer the corresponding photo will be displayed during playback. Videos can also be
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used. 
The easiest way to access "Timeline" mode is via the "Tab"
key (you can also click on the corresponding link via the
left-hand border of the photo bar). 

You have four tracks in total: 
 on the first track there are photos or videos
 the second track is the audio track for narration and sound effects for individual photos and

videos
All audio material that you add to the second track directly below your photos and videos will be
attached to the corresponding photo and video material. If a picture or video already has sound material
attached to it (sound-in-picture support), it will be made visible in this track automatically. 

 on the third track you'll find the titles (that are created via the text input of StoryMaker or via the
title editor)

 the fourth track is suitable for background music. The audio material of this audio track can be
moved within a project any way you like.

The objects on the tracks can be re-sized with their lower edge "object handles". Move the mouse over
one of the lower corners of the object until the mouse pointer becomes a double arrow. You can now
stretch the object as much as you like. An object can be faded in or out with the handles to the top of the
object. This also applies to text and audio objects in the timeline. 

Cut slideshow or objects
 A simple cut can also be achieved by pressing the "T" shortcut key, or by using the symbol to the right of
the transport console. 
Hint
: Cuts are always made at the point where the red line is located. 
The arrow next to the cut button opens a selection menu with the following options: 
Split object ("T")
: This command splits the object at the position of the start marker to produce two separate objects. You
can also just press "T" on the keyboard for this action. 
Remove object beginning
: This command cuts the object at the point where the start marker is positioned and deletes all material
that precedes the start marker simultaneously. 
Remove object end
: This command cuts the object at the point where the start marker is positioned and deletes all material
that comes after the start marker simultaneously. 
Split slideshow
: This command splits the slideshow at the position of the start marker into two independent slideshows.
Both appear in the menu underneath the preview window in the "slideshow" area. 
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Start and end markers
 The section between the start (S) and end marker (E) above the storyboard or the first track of the
timeline will be played back in your show each time. 

The start and end markers can be moved
in different ways by using the mouse. You
can move them to any position with drag
& drop or directly with a mouse click:
Left clicking in the timeline moves the
start marker, and right clicking moves the
end marker. 
The cursor is a red vertical line which
moves from left to right during playback
to show the current playback position. 

If you want to see play back your show, press the space bar or start the slideshow via the transport
console below the preview window. 

Optimizing your photos
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
 provides a lot of different editing functions for picture and sound. Let's start with "Storyboard" mode: 

In this case, you'll see each
individual picture in a so-called
"photo box". Each photo box has
a number of settings for duration,
fades, effects, and text: 
 Set display time:
 Double clicking on the clock lets
you enter how long the photo
should be shown for. 

Add title and text:
 Titles (for example, subtitles, opening/closing credits)
can be added to every photo. Click on "Text". The
title editor is ready with a number of text design
variations. 
Fades:
 Between the photos you'll find the buttons for the
transitions (fades). Simply drag the start marker to just
before the beginning of a picture and the end marker
to behind it and press the space bar. The range
between the start and end markers will be played
back as an endless loop. Now you can try out the
fades one after the other and view the result
immediately in the video monitor. 
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Picture editing:
 Press the "FX" button on the photo box to access the
effects and image processing tools which can be used
separately on each photo. Every photo's quality can
be optimized. 

If a photo is on its side or upside down, then click on the symbol with the rotating arrow. The photo will
rotate 90 degrees. You can control the effect directly on the video screen. 
To prepare photos for importing and optimizing for the slideshow, we recommend using MAGIX Photo
Manager. It has correctional tools for redeye, or auto-color and white balance for discoloration in
pictures. 
The program is installed automatically and can be used for quick previewing and easy management of
pictures from your database. Pictures sorted into the database can be loaded into the MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe Media Pool via the "Database" button. 
For more complex editing like photo panorama and photo filter effects, the deluxe version comes with a
separate image processing program MAGIX Xtreme Photo Designer. Users of the classic version can
download the latest software at any time for free. To load a photo into MAGIX Xtreme Photo Designer,
select the option "Edit photo" in the FX menu of the photo box. Read more on this in the MAGIX
Xtreme Photo Designer Help section. 
Dubbing sound:
 If you wish to add narration to your slideshow, then use the "Audio and video recording" function for
microphone recordings in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. The recording dialog
opens by clicking on the record button (with the red dot) in the transport console. You can also use
audio CDs, records, or tapes. Audio CD tracks of non copy-protected CDs and other audio files can be
dragged onto the photo box directly from the Media Pool. 
Editing and arranging ("Timeline" mode):
 "Timeline" mode displays your photos over the course of the slideshow. The longer the object remains in
the track, the longer the corresponding photo will be displayed during playback. Videos can also be
used. 

The easiest way to access "Timeline" mode is via the "Tab"
key (you can also click on the corresponding link via the
left-hand border of the photo bar). 

You have four tracks in total: 
 on the first track there are photos or videos
 the second track is the audio track for narration and sound effects for individual photos and

videos
All audio material that you add to the second track directly below your photos and videos will be
attached to the corresponding photo and video material. If a picture or video already has sound material
attached to it (sound-in-picture support), it will be made visible in this track automatically. 

 on the third track you'll find the titles (that are created via the text input of StoryMaker or via the
title editor)

 the fourth track is suitable for background music. The audio material of this audio track can be
moved within a project any way you like.

The objects on the tracks can be re-sized with their lower edge "object handles". Move the mouse over
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one of the lower corners of the object until the mouse pointer becomes a double arrow. You can now
stretch the object as much as you like. An object can be faded in or out with the handles to the top of the
object. This also applies to text and audio objects in the timeline. 

Cut slideshow or objects
 A simple cut can also be achieved by pressing the "T" shortcut key, or by using the symbol to the right of
the transport console. 
Hint
: Cuts are always made at the point where the red line is located. 
The arrow next to the cut button opens a selection menu with the following options: 
Split object ("T")
: This command splits the object at the position of the start marker to produce two separate objects. You
can also just press "T" on the keyboard for this action. 
Remove object beginning
: This command cuts the object at the point where the start marker is positioned and deletes all material
that precedes the start marker simultaneously. 
Remove object end
: This command cuts the object at the point where the start marker is positioned and deletes all material
that comes after the start marker simultaneously. 
Split slideshow
: This command splits the slideshow at the position of the start marker into two independent slideshows.
Both appear in the menu underneath the preview window in the "slideshow" area. 
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Optimizing your photos
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
 provides a lot of different editing functions for picture and sound. Let's start with "Storyboard" mode: 

In this case, you'll see each
individual picture in a so-called
"photo box". Each photo box has
a number of settings for duration,
fades, effects, and text: 
 Set display time:
 Double clicking on the clock lets
you enter how long the photo
should be shown for. 

Add title and text:
 Titles (for example, subtitles, opening/closing credits)
can be added to every photo. Click on "Text". The
title editor is ready with a number of text design
variations. 
Fades:
 Between the photos you'll find the buttons for the
transitions (fades). Simply drag the start marker to just
before the beginning of a picture and the end marker
to behind it and press the space bar. The range
between the start and end markers will be played
back as an endless loop. Now you can try out the
fades one after the other and view the result
immediately in the video monitor. 
Picture editing:
 Press the "FX" button on the photo box to access the
effects and image processing tools which can be used
separately on each photo. Every photo's quality can
be optimized. 

If a photo is on its side or upside down, then click on the symbol with the rotating arrow. The photo will
rotate 90 degrees. You can control the effect directly on the video screen. 
To prepare photos for importing and optimizing for the slideshow, we recommend using MAGIX Photo
Manager. It has correctional tools for redeye, or auto-color and white balance for discoloration in
pictures. 
The program is installed automatically and can be used for quick previewing and easy management of
pictures from your database. Pictures sorted into the database can be loaded into the MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe Media Pool via the "Database" button. 
For more complex editing like photo panorama and photo filter effects, the deluxe version comes with a
separate image processing program MAGIX Xtreme Photo Designer. Users of the classic version can
download the latest software at any time for free. To load a photo into MAGIX Xtreme Photo Designer,
select the option "Edit photo" in the FX menu of the photo box. Read more on this in the MAGIX
Xtreme Photo Designer Help section. 
Dubbing sound:
 If you wish to add narration to your slideshow, then use the "Audio and video recording" function for
microphone recordings in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. The recording dialog
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opens by clicking on the record button (with the red dot) in the transport console. You can also use
audio CDs, records, or tapes. Audio CD tracks of non copy-protected CDs and other audio files can be
dragged onto the photo box directly from the Media Pool. 
Editing and arranging ("Timeline" mode):
 "Timeline" mode displays your photos over the course of the slideshow. The longer the object remains in
the track, the longer the corresponding photo will be displayed during playback. Videos can also be
used. 

The easiest way to access "Timeline" mode is via the "Tab"
key (you can also click on the corresponding link via the
left-hand border of the photo bar). 

You have four tracks in total: 
 on the first track there are photos or videos
 the second track is the audio track for narration and sound effects for individual photos and

videos
All audio material that you add to the second track directly below your photos and videos will be
attached to the corresponding photo and video material. If a picture or video already has sound material
attached to it (sound-in-picture support), it will be made visible in this track automatically. 

 on the third track you'll find the titles (that are created via the text input of StoryMaker or via the
title editor)

 the fourth track is suitable for background music. The audio material of this audio track can be
moved within a project any way you like.

The objects on the tracks can be re-sized with their lower edge "object handles". Move the mouse over
one of the lower corners of the object until the mouse pointer becomes a double arrow. You can now
stretch the object as much as you like. An object can be faded in or out with the handles to the top of the
object. This also applies to text and audio objects in the timeline. 

Cut slideshow or objects
 A simple cut can also be achieved by pressing the "T" shortcut key, or by using the symbol to the right of
the transport console. 
Hint
: Cuts are always made at the point where the red line is located. 
The arrow next to the cut button opens a selection menu with the following options: 
Split object ("T")
: This command splits the object at the position of the start marker to produce two separate objects. You
can also just press "T" on the keyboard for this action. 
Remove object beginning
: This command cuts the object at the point where the start marker is positioned and deletes all material
that precedes the start marker simultaneously. 
Remove object end
: This command cuts the object at the point where the start marker is positioned and deletes all material
that comes after the start marker simultaneously. 
Split slideshow
: This command splits the slideshow at the position of the start marker into two independent slideshows.
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Both appear in the menu underneath the preview window in the "slideshow" area. 
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Cut slideshow or objects
 A simple cut can also be achieved by pressing the "T" shortcut key, or by using the symbol to the right of
the transport console. 
Hint
: Cuts are always made at the point where the red line is located. 
The arrow next to the cut button opens a selection menu with the following options: 
Split object ("T")
: This command splits the object at the position of the start marker to produce two separate objects. You
can also just press "T" on the keyboard for this action. 
Remove object beginning
: This command cuts the object at the point where the start marker is positioned and deletes all material
that precedes the start marker simultaneously. 
Remove object end
: This command cuts the object at the point where the start marker is positioned and deletes all material
that comes after the start marker simultaneously. 
Split slideshow
: This command splits the slideshow at the position of the start marker into two independent slideshows.
Both appear in the menu underneath the preview window in the "slideshow" area. 
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Creating CD/DVD menus
 Create multiple slideshows
 You can burn multiple independent slideshows together onto one disc. A new slideshow can be created
in the same project via "File -> New -> Slideshow
". You can switch between the individual slideshows via the arrow on the slideshow button in the
arranger. 

You can also embed slideshows from an existing project into your project. Select "File -> Open", find
the desired project on the hard drive, and then click "Open". MAGIX Xtreme PhotoStory on CD &
DVD 8 deluxe will now ask you if you would like to close the current project or add a new project.
Choose the latter to embed the slideshows into your project. 
To remove a slideshow, switch to the corresponding slideshow described above and select "File ->
Manage slideshow -> Remove slideshow". 

Menu view and menu navigation
In the middle of
the "Burn" screen
you'll see a
preview of the
selection menu. 

All slideshows appear in the uppermost entries, all photos appear as sub-entries. Use the dropdown
menu to the top left to deactivate the menus entirely or only work on the slideshow entries. 

Use the "Navigation" button to access the structure
of the selection menu. In this case, you can switch off
all photos that should not be in the photo menu.
Simply deactivate the corresponding box. 

This way, the entry will be removed from the menu only; the corresponding photo will not be removed
from the slideshow. (More than 99 ticks cannot be made as the DVD player cannot list more than 99
entries.) 
In the lower portion of the screen, you'll find a whole range of sample menu layouts. Use the scroll bar to
view each template. There are a lot of possibilities to choose from: 

 If you wish to fully apply a template, then click on "Layout" first in the template bar and double
click on the template of your choice. The complete template will then be applied.

 You can also change the various elements of the individual scenes. If, for example, you wish to
change the font, then select "Font" and double click on the template with the desired font. Then
select "Background" and double click on your favorite background. The template in the middle
immediately shows you the results.

 A double click on the preview picture or on a menu entry opens an editor to edit the name and
select a different preview picture.
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 Use the virtual remote control to test the behavior of finished CDs and DVDs so as to make sure
that everything works as planned.
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Create multiple slideshows
 You can burn multiple independent slideshows together onto one disc. A new slideshow can be created
in the same project via "File -> New -> Slideshow
". You can switch between the individual slideshows via the arrow on the slideshow button in the
arranger. 

You can also embed slideshows from an existing project into your project. Select "File -> Open", find
the desired project on the hard drive, and then click "Open". MAGIX Xtreme PhotoStory on CD &
DVD 8 deluxe will now ask you if you would like to close the current project or add a new project.
Choose the latter to embed the slideshows into your project. 
To remove a slideshow, switch to the corresponding slideshow described above and select "File ->
Manage slideshow -> Remove slideshow". 

Menu view and menu navigation
In the middle of
the "Burn" screen
you'll see a
preview of the
selection menu. 

All slideshows appear in the uppermost entries, all photos appear as sub-entries. Use the dropdown
menu to the top left to deactivate the menus entirely or only work on the slideshow entries. 

Use the "Navigation" button to access the structure
of the selection menu. In this case, you can switch off
all photos that should not be in the photo menu.
Simply deactivate the corresponding box. 

This way, the entry will be removed from the menu only; the corresponding photo will not be removed
from the slideshow. (More than 99 ticks cannot be made as the DVD player cannot list more than 99
entries.) 
In the lower portion of the screen, you'll find a whole range of sample menu layouts. Use the scroll bar to
view each template. There are a lot of possibilities to choose from: 

 If you wish to fully apply a template, then click on "Layout" first in the template bar and double
click on the template of your choice. The complete template will then be applied.

 You can also change the various elements of the individual scenes. If, for example, you wish to
change the font, then select "Font" and double click on the template with the desired font. Then
select "Background" and double click on your favorite background. The template in the middle
immediately shows you the results.

 A double click on the preview picture or on a menu entry opens an editor to edit the name and
select a different preview picture.

 Use the virtual remote control to test the behavior of finished CDs and DVDs so as to make sure
that everything works as planned.
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Menu view and menu navigation
In the middle of
the "Burn" screen
you'll see a
preview of the
selection menu. 

All slideshows appear in the uppermost entries, all photos appear as sub-entries. Use the dropdown
menu to the top left to deactivate the menus entirely or only work on the slideshow entries. 

Use the "Navigation" button to access the structure
of the selection menu. In this case, you can switch off
all photos that should not be in the photo menu.
Simply deactivate the corresponding box. 

This way, the entry will be removed from the menu only; the corresponding photo will not be removed
from the slideshow. (More than 99 ticks cannot be made as the DVD player cannot list more than 99
entries.) 
In the lower portion of the screen, you'll find a whole range of sample menu layouts. Use the scroll bar to
view each template. There are a lot of possibilities to choose from: 

 If you wish to fully apply a template, then click on "Layout" first in the template bar and double
click on the template of your choice. The complete template will then be applied.

 You can also change the various elements of the individual scenes. If, for example, you wish to
change the font, then select "Font" and double click on the template with the desired font. Then
select "Background" and double click on your favorite background. The template in the middle
immediately shows you the results.

 A double click on the preview picture or on a menu entry opens an editor to edit the name and
select a different preview picture.

 Use the virtual remote control to test the behavior of finished CDs and DVDs so as to make sure
that everything works as planned.
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Edit Fotoshow
In this chapter
Video monitor and transport control
Media Pool
Toolbar
Start and end markers
Overview mode
Storyboard mode
Timeline mode
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Video monitor and transport control
 Select the slideshow window to load photos and edit your slideshow. 

Use the video monitor to preview the current project or
slideshow. With the button "Full screen" you can switch to
full screen playback. Press "Esc" to return back to normal
playback. The transport console can be used to begin
playback of the slideshow. It can be found below the video
monitor. 

Play/Pause: The "Play" button in the middle starts endless
playback of the slideshow, i.e. the range between the start
and end markers
 is played back as a loop (infinite, recurring). Clicking on the
play button a second time pauses playback. 
Stop:
 The "Stop" button discontinues playback. 

Back:
 This button moves the start marker to the previous picture.
This is then displayed in the video monitor. During playback
this button can be used to go back. 
Forwards:
 This button moves the start marker to the next picture. This
is then displayed in the video monitor. During playback this
button can be used to move forwards through the
slideshow. 
Note:
 You can also skip forward or back using the arrow keys on
your PC keyboard. 
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Back to start:
 With this button the start marker is quickly moved to the
beginning of the slideshow. 
Recording: The "Slideshow" window provides a single
frame capture (only in the deluxe version) feature or an audio
recording feature
. With single frame capture you can take photos of single
snapshots from analog video sources. When recording
audio, new sound material can be inserted at the position of
the start marker (commentary, for example). 
Mute:
 The entire audio playback is switched off temporarily. This
only affects the preview, not the disc that is created. 

Use the position slider to move quickly within the project. The current position of the playback marker is
displayed numerically on the right. 
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Cut button and editing menu
 The cut button and cut menu next to it can be found on the right beside the transport console. 

Use the cut button to cut a selected object in two at the
position of the start marker. 

With a click on the small arrow beside the cut button you can access the cut menu which contains further
relevant commands. 
In this section
Split object
Remove start
Remove object end
Split slideshow

Split object
 This command cuts a scene at the point where the start marker is positioned. This way, two
free-standing objects are created. 
You can isolate a part of an object in order to delete it: 

1. Place the start marker where you'd like to have it by left clicking in the timeline.
2. Select the video object by clicking on it and click on the cut button. 
3. Place the start marker at the end of the part you wish to remove and click on the cut button

again.
4. Select the middle object that was created and press the "DEL" key.
5. Pull the object at the back to the front; it should automatically snap into place. All subsequent

objects will be moved along in unison so that no gaps appear.
You can also use this function to apply effects to a certain part of an object only. 
Keyboard shortcut: T 

Remove start
 This command cuts a scene at the point where the playback marker is positioned and removes the
material before the playback marker. 
Keyboard shortcut: K 

Remove object end
 This command cuts a scene at the point where the playback marker is positioned and removes the
material behind the back marker. 
Keyboard shortcut: U 

Split slideshow
 This command splits the slideshow at the point where the start marker is positioned to make two
separate slideshows. 
Note:
 You can use this function if you wish to include photo menus and if your slideshow already contains over
99 photos. Otherwise, only every second or third photo (depending on the number of photos) appears in
the photo menu, since the number of menu entries is technically limited to 99. 
Keyboard shortcut: Alt + T 
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Split object
 This command cuts a scene at the point where the start marker is positioned. This way, two
free-standing objects are created. 
You can isolate a part of an object in order to delete it: 

1. Place the start marker where you'd like to have it by left clicking in the timeline.
2. Select the video object by clicking on it and click on the cut button. 
3. Place the start marker at the end of the part you wish to remove and click on the cut button

again.
4. Select the middle object that was created and press the "DEL" key.
5. Pull the object at the back to the front; it should automatically snap into place. All subsequent

objects will be moved along in unison so that no gaps appear.
You can also use this function to apply effects to a certain part of an object only. 
Keyboard shortcut: T 

Remove start
 This command cuts a scene at the point where the playback marker is positioned and removes the
material before the playback marker. 
Keyboard shortcut: K 

Remove object end
 This command cuts a scene at the point where the playback marker is positioned and removes the
material behind the back marker. 
Keyboard shortcut: U 

Split slideshow
 This command splits the slideshow at the point where the start marker is positioned to make two
separate slideshows. 
Note:
 You can use this function if you wish to include photo menus and if your slideshow already contains over
99 photos. Otherwise, only every second or third photo (depending on the number of photos) appears in
the photo menu, since the number of menu entries is technically limited to 99. 
Keyboard shortcut: Alt + T 
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Remove start
 This command cuts a scene at the point where the playback marker is positioned and removes the
material before the playback marker. 
Keyboard shortcut: K 

Remove object end
 This command cuts a scene at the point where the playback marker is positioned and removes the
material behind the back marker. 
Keyboard shortcut: U 

Split slideshow
 This command splits the slideshow at the point where the start marker is positioned to make two
separate slideshows. 
Note:
 You can use this function if you wish to include photo menus and if your slideshow already contains over
99 photos. Otherwise, only every second or third photo (depending on the number of photos) appears in
the photo menu, since the number of menu entries is technically limited to 99. 
Keyboard shortcut: Alt + T 
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Remove object end
 This command cuts a scene at the point where the playback marker is positioned and removes the
material behind the back marker. 
Keyboard shortcut: U 

Split slideshow
 This command splits the slideshow at the point where the start marker is positioned to make two
separate slideshows. 
Note:
 You can use this function if you wish to include photo menus and if your slideshow already contains over
99 photos. Otherwise, only every second or third photo (depending on the number of photos) appears in
the photo menu, since the number of menu entries is technically limited to 99. 
Keyboard shortcut: Alt + T 
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Split slideshow
 This command splits the slideshow at the point where the start marker is positioned to make two
separate slideshows. 
Note:
 You can use this function if you wish to include photo menus and if your slideshow already contains over
99 photos. Otherwise, only every second or third photo (depending on the number of photos) appears in
the photo menu, since the number of menu entries is technically limited to 99. 
Keyboard shortcut: Alt + T 
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Media Pool
 The Media Pool
 is a central and important element in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. It offers a
series of functions like loading media objects, improving picture quality, design, etc. 

Page 76



Toolbar
 Important editing and effect menu commands are available as buttons on the slideshow window. There
are different buttons available for each mode. 

Top Toolbar
 This toolbar lies directly under the menu or the video monitor of the MAGIX Xtreme PhotoStory on CD
& DVD 8 deluxe. 

New project
This menu item creates a new MAGIX Xtreme PhotoStory on
CD & DVD 8 deluxe project. You can also open this feature
via the "New project" button above the video monitor. 

Keyboard shortcut: Shift + N 

Load project
This menu item loads a previously saved MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe project. Please note
that the related files must be accessible. 

MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe searches for the used sounds, pictures and videos
under the path to where you last saved the disc project. 
Keyboard shortcut: Ctrl + O 

Save project
The current disc project is saved with the name displayed in
the project window. If you have not yet specified a name for
your project, a dialog will open wherein MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe asks you to do so. 

Keyboard shortcut: Ctrl + Alt + S 

All modes
 The following buttons are visible in all modes of the "Edit" screen. 

MovieShow Maker
This opens MovieShow Maker
. 

Undo
You can undo the last steps you made. This means that you can
easily try out critical operations. If the result does not meet your
expectations, then you can simply "undo" it and return to the
initial status. 

Key: Ctrl + Z 

Restore
The "Redo" function undoes the previous "Undo" function. 
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Keyboard shortcut: Shift + Y 

Delete
This command deletes the selected photo (or selected object)
in Timeline mode. 

Keyboard shortcut: Del 

Exchange
Replaces the selected object with an object selected in the
Media Pool. Length adjustment moves the objects following it
correspondingly. 

If photo objects are removed/exchanged, then the display duration will remain. 

Also in Timeline mode and Overview mode
 The buttons listed here are also visible in the Timeline mode and Overview mode 

Cut
Cut
 This function deletes the selected photo (or the selected
object in the Timeline mode) and copies it to the clipboard.
You can then use the "Paste" command to copy it into any
slideshow. 

Keyboard shortcut: Ctrl + X 

Copy

 Copy
 This command copies the selected scenes (or the selected object in Timeline mode) to the clipboard.
From there you can paste it into any other slideshow using the "Paste" command. 
Key: Ctrl + C 

Paste
Insert
 This command inserts the clipboard material (photo or
object) at the current position of the start marker. 

Keyboard shortcut: Ctrl + V 

Title editor
Title Editor

 Key Ctrl+t 

Optimize grid view
The start and end markers are moved to the start or end so
that all scenes are visible and the complete film can be played.
Zoom is also set to 100% so that all objects are visible. 

Key: Shift + B 
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Only in Timeline mode
 The following buttons are found exclusively in Timeline mode. 

Optimize photo

 Optimize photos
 Key Shift + I 

Mouse mode for individual objects
This mouse mode for individual objects enables free
positioning of individual objects. 

Intelligent mouse mode
Intelligent mouse mode moves all objects together located
behind the one selected. 

Edit bitmap externally
Graphics files (BMPs or JPEGs) can be edited in MAGIX
Xtreme Photo Designer via the "Edit" button. 

The selected image file is loaded automatically and, once editing has been completed, is used in the
MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe instead of the original material. 

Only in overview mode

 Rotate 90° to the right
This button turns the selected photo 90° to the right. 

Page 79



Start and end markers
The range between the start and end markers
is played just above the first track. 

The start and end markers can be moved in different ways using the mouse. You can move them to any
position with drag & drop or directly with a mouse click. A left mouse click in the timeline moves the
start marker, and a right click moves the end marker. 
The play marker is a red vertical line which moves from left to right during playback. It indicates the
current play position. 
Note:
 The start marker can also be shifted using the arrow buttons on your computer keyboard. The
"Forwards"/"Back" buttons on the transport console move the start marker to the next or previous
picture, which can then be seen immediately in the Video Monitor. 
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Overview mode
"Overview mode" is a special slideshow viewing mode that
provides clarity and maintenance of the photos. 
All photos are listed one after the other (in multiple lines, just
like in a text program) and can be copied, cut, moved, deleted,
and inserted. 

As usual, a double click on a photo opens the Optimize video dialog. 
There are no start, play, or end markers in Overview mode. The photo that is to be played is fitted with a
border so that you can see where the photo that is currently playing can be found. 

This slider specifies how large
the photos will appear in the
storyboard. The smaller the
photos, the more you'll be able
to fit on screen. 

Use this button to maximize the overview mode to
fullscreen. 
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Storyboard mode

 What is the Storyboard mode?
 Storyboard mode is used to view the layout of slideshows. All photos are displayed in linear sequence
with preview images. It includes different buttons, text, effects, rotation, time settings, and transitions. 

Click "Text" to open the Title Editor. It allows you to enter
captions such as subtitles and credits. You can enter text for
subtitling or opening/closing credits. 

They can be displayed in all kinds of fonts and colors. Your can have your credits scroll down the screen
– just like in the movies! Many other text movements are also available from the template menu, such as
effects and designs. 

Effects: In the Effects menu (or by clicking on "FX") you can
select the effects
 for editing sounds and images. 

You can use the "Edit photo" option to open the photo in the separate image editing program MAGIX
Xtreme Photo Designer. After editing the image is transferred directly to the MAGIX Xtreme PhotoStory
on CD & DVD 8 deluxe storyboard. 
Hint:
 For more info on using MAGIX Xtreme Photo Designer, please read its Help file which you can open
by pressing the "F1" key. 

Rotate: If a photo is on its side or upside down, then click on
the Rotate button. 

The photo will rotate 90 degrees. You can control the effect directly on the video screen. 
Playback:
 The range between the start and end markers in the upper half of the storyboard is the section which will
be played back. Both markers can be moved with the mouse (or they can be placed with the left and
right mouse buttons). Use the space bar to start and stop playback most effectively. Of course, you can
also control the playback functions by using the transport control below the preview monitor. 
Playback marker:
 The playback marker will show which photo is currently being played along a horizontal line that runs
from left to right over the scene. Dependent upon how long a photo is shown, the speed of the playback
marker will vary. 

Transitions (Fades): You can also set up the transitions from
one photo to the next by mouse clicking on the symbol. A
menu will open for you to select different transitions
. 

Menus:
 In addition to the regular menus there are two more special menus for special tasks. 

 Below the video monitor you can use the "slideshow" flip menu to toggle between the slideshows
and the current disc project.

The Edit button next to the playback functions offers various options for cutting. Here it is important to
observe the difference between "cutting objects" and "separating slideshows": 

 "Cut object" cuts the photo (including all subtitles and additional audio or video material) and thus
raises the number of current photos by one.
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 "Separate slideshow" splits the current slideshow at two positions of the start marker into two
separate slideshows.
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Timeline mode

 What is Timeline mode?
 The easiest way to switch to Timeline mode is by clicking on the Timeline mode button in front of the
Arranger. 
In Timeline mode your photos are displayed in order: The longer the object remains in the track, the
longer the corresponding photo will be displayed during the slideshow. Unlike Storyboard mode, the
speed of the playback marker does not change during playback. You also have direct access to all media
files currently being used in the slideshow. 

Timeline

 The progress of the slideshow in the movie is displayed horizontally above the tracks. To structure this
progression, the actual timeline is visible at the very top above the first track. The unit of measurement of
the timeline is milliseconds. 
The range between the start and end markers in the timeline is played back as an endless loop. 

Tracks
 There are 4 tracks in total for loading, arranging, and editing media files via drag & drop or double-click
from the Media Pool: 

 The first track is for the photos, but videos can also be loaded.
 The next track is for the audio track of videos and for the frames. Additional audio recordings

(so-called overdubs) are placed here (commentaries, for example).
 The third track contains the titles (which can be created via the buttons "Text" in Storyboard

mode) and style elements. These can also be added via the MovieShow Maker.
 The fourth track is for additional sound material, i.e. everything you may wish to add to your

photo via drag & drop from the Media Pool. Additional audio recordings (so-called overdubs)
are placed here (commentaries, for example).

 Volume curves
 Volume on tracks 2 and 4 can be automated. This is achieved using so-called volume curves. 

A typical volume gradient for damping
background music during a spoken
commentary. 

 In context menu of tracks 2 or 4, select "Volume curves".
 Double click the curve to set an automation point.
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 Two automation points are required for a simple volume curve (start and end points).
 Curve points can be easily moved via drag & drop, during which the mouse cursor turns into a

cross.
 An additional double click on an automation point deletes it.

Hint: During audio recording, volume curves can be automatically created if the Volume damping
("Ducking")
 option is activated. 

Zooming
 Keyboard shortcut:
 The easiest way to zoom is by using the key combination "Ctrl+Page Up" (zoom in) and "Ctrl+Page
Down" (zoom out). 
Zoom menu:
 Right clicking on the start marker opens the context menu where you can select the most important zoom
levels. 

Zoom-enabled sliders:
 Use the slider ("fader") to set up the visible clip on the horizontal time axis. 
You can tell which part of the entire arrangement is being played by the size and position of the slider. In
the full view, the zoom sliders take up the entire sliding space. The full view can be accessed by double
clicking on the slider. 
If you move the mouse to the edge of the slider, then the cursor will turn into a stretch symbol which can
be used to select and compress/stretch the fader. This way you can zoom in and out quickly and it isn't
confined to a set number of steps, but is continuous. 
Exact zoom levels can be selected by right clicking on the fader or on the start marker via the context
menu. Here you can also jump to certain positions in the arrangement. 

Grid
 The snap grid ensures that the objects always "snap" to certain points so that they can be positioned
precisely according to the beat. Two consecutive objects will seamlessly snap together, even if they are
on different tracks. This prevents undesired gaps or overlapping objects. 

Objects
 Sound and picture tracks are displayed as separate objects and are edited independently of one
another. 
Sound material is displayed as a wave form. Where there's something to see, there's something to hear.
Picture material appears with regular preview pictures as an object in the track. 
All objects can be cut uniformly, edited with effects, and arranged any way you like. During playback, all
objects on all tracks are mixed together automatically. When moving a photo, all related objects will be
moved along with it (audio recordings, frames, and text objects, for example). 

Object cutting and fades
All objects can be re-sized with their lower edge "object handles".
Move the mouse over one of the lower corners of the object until
the mouse pointer becomes a double arrow. 

You can now stretch the object as much as you like. 
At the top ends of every object you'll find two
fade handles that can be adjusted to fade an
object in or out. 
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Adjust brightness/volume
 Using the brightness/volume handle located centrally at the top of the object, you can adjust the volume
of audio or MIDI
 objects or the brightness of video and image objects. Simply drag the handle either up or down. 
Even if several objects are playing simultaneously, the volume or brightness of individual objects can still
be altered. 

Select objects
 To edit or delete objects using the menus, you must first select them. To do so, simply click on the
object you wish to select. The handles of selected objects change color to show that the accompanying
object has been selected and can be edited using the menu functions or with effects. 

Context menu
 Right clicking on an object opens the context menu with effects. You can now use the same Effects
 as in Storyboard mode. 

Duplicate objects
 Small objects (for example, audio loops) can be duplicated very easily. First, the objects that need to be
duplicated must be selected. Activate the copy command and then the Insert command ("Edit" menu
 or via the buttons in the Timeline mode). 
Speed up this process by clicking on the object to be copied with the mouse while holding down the
"Ctrl" key. This generates a copy which you can immediately drag to the desired position. 

Mouse modes
 With these mouse modes you can specify various working methods of MAGIX Xtreme PhotoStory on
CD & DVD 8 deluxe when moving objects. 

Mouse mode for individual objects
This mouse mode for individual objects enables free
positioning of individual objects. 

Intelligent mouse mode
Intelligent mouse mode moves all objects together located
behind the one selected. 
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What is Timeline mode?
 The easiest way to switch to Timeline mode is by clicking on the Timeline mode button in front of the
Arranger. 
In Timeline mode your photos are displayed in order: The longer the object remains in the track, the
longer the corresponding photo will be displayed during the slideshow. Unlike Storyboard mode, the
speed of the playback marker does not change during playback. You also have direct access to all media
files currently being used in the slideshow. 

Timeline

 The progress of the slideshow in the movie is displayed horizontally above the tracks. To structure this
progression, the actual timeline is visible at the very top above the first track. The unit of measurement of
the timeline is milliseconds. 
The range between the start and end markers in the timeline is played back as an endless loop. 

Tracks
 There are 4 tracks in total for loading, arranging, and editing media files via drag & drop or double-click
from the Media Pool: 

 The first track is for the photos, but videos can also be loaded.
 The next track is for the audio track of videos and for the frames. Additional audio recordings

(so-called overdubs) are placed here (commentaries, for example).
 The third track contains the titles (which can be created via the buttons "Text" in Storyboard

mode) and style elements. These can also be added via the MovieShow Maker.
 The fourth track is for additional sound material, i.e. everything you may wish to add to your

photo via drag & drop from the Media Pool. Additional audio recordings (so-called overdubs)
are placed here (commentaries, for example).

 Volume curves
 Volume on tracks 2 and 4 can be automated. This is achieved using so-called volume curves. 

A typical volume gradient for damping
background music during a spoken
commentary. 

 In context menu of tracks 2 or 4, select "Volume curves".
 Double click the curve to set an automation point.
 Two automation points are required for a simple volume curve (start and end points).
 Curve points can be easily moved via drag & drop, during which the mouse cursor turns into a

cross.
 An additional double click on an automation point deletes it.

Hint: During audio recording, volume curves can be automatically created if the Volume damping
("Ducking")
 option is activated. 
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Zooming
 Keyboard shortcut:
 The easiest way to zoom is by using the key combination "Ctrl+Page Up" (zoom in) and "Ctrl+Page
Down" (zoom out). 
Zoom menu:
 Right clicking on the start marker opens the context menu where you can select the most important zoom
levels. 

Zoom-enabled sliders:
 Use the slider ("fader") to set up the visible clip on the horizontal time axis. 
You can tell which part of the entire arrangement is being played by the size and position of the slider. In
the full view, the zoom sliders take up the entire sliding space. The full view can be accessed by double
clicking on the slider. 
If you move the mouse to the edge of the slider, then the cursor will turn into a stretch symbol which can
be used to select and compress/stretch the fader. This way you can zoom in and out quickly and it isn't
confined to a set number of steps, but is continuous. 
Exact zoom levels can be selected by right clicking on the fader or on the start marker via the context
menu. Here you can also jump to certain positions in the arrangement. 

Grid
 The snap grid ensures that the objects always "snap" to certain points so that they can be positioned
precisely according to the beat. Two consecutive objects will seamlessly snap together, even if they are
on different tracks. This prevents undesired gaps or overlapping objects. 

Objects
 Sound and picture tracks are displayed as separate objects and are edited independently of one
another. 
Sound material is displayed as a wave form. Where there's something to see, there's something to hear.
Picture material appears with regular preview pictures as an object in the track. 
All objects can be cut uniformly, edited with effects, and arranged any way you like. During playback, all
objects on all tracks are mixed together automatically. When moving a photo, all related objects will be
moved along with it (audio recordings, frames, and text objects, for example). 

Object cutting and fades
All objects can be re-sized with their lower edge "object handles".
Move the mouse over one of the lower corners of the object until
the mouse pointer becomes a double arrow. 

You can now stretch the object as much as you like. 
At the top ends of every object you'll find two
fade handles that can be adjusted to fade an
object in or out. 

Adjust brightness/volume
 Using the brightness/volume handle located centrally at the top of the object, you can adjust the volume
of audio or MIDI
 objects or the brightness of video and image objects. Simply drag the handle either up or down. 
Even if several objects are playing simultaneously, the volume or brightness of individual objects can still
be altered. 
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Select objects
 To edit or delete objects using the menus, you must first select them. To do so, simply click on the
object you wish to select. The handles of selected objects change color to show that the accompanying
object has been selected and can be edited using the menu functions or with effects. 

Context menu
 Right clicking on an object opens the context menu with effects. You can now use the same Effects
 as in Storyboard mode. 

Duplicate objects
 Small objects (for example, audio loops) can be duplicated very easily. First, the objects that need to be
duplicated must be selected. Activate the copy command and then the Insert command ("Edit" menu
 or via the buttons in the Timeline mode). 
Speed up this process by clicking on the object to be copied with the mouse while holding down the
"Ctrl" key. This generates a copy which you can immediately drag to the desired position. 

Mouse modes
 With these mouse modes you can specify various working methods of MAGIX Xtreme PhotoStory on
CD & DVD 8 deluxe when moving objects. 

Mouse mode for individual objects
This mouse mode for individual objects enables free
positioning of individual objects. 

Intelligent mouse mode
Intelligent mouse mode moves all objects together located
behind the one selected. 

Page 89



Timeline

 The progress of the slideshow in the movie is displayed horizontally above the tracks. To structure this
progression, the actual timeline is visible at the very top above the first track. The unit of measurement of
the timeline is milliseconds. 
The range between the start and end markers in the timeline is played back as an endless loop. 

Tracks
 There are 4 tracks in total for loading, arranging, and editing media files via drag & drop or double-click
from the Media Pool: 

 The first track is for the photos, but videos can also be loaded.
 The next track is for the audio track of videos and for the frames. Additional audio recordings

(so-called overdubs) are placed here (commentaries, for example).
 The third track contains the titles (which can be created via the buttons "Text" in Storyboard

mode) and style elements. These can also be added via the MovieShow Maker.
 The fourth track is for additional sound material, i.e. everything you may wish to add to your

photo via drag & drop from the Media Pool. Additional audio recordings (so-called overdubs)
are placed here (commentaries, for example).

 Volume curves
 Volume on tracks 2 and 4 can be automated. This is achieved using so-called volume curves. 

A typical volume gradient for damping
background music during a spoken
commentary. 

 In context menu of tracks 2 or 4, select "Volume curves".
 Double click the curve to set an automation point.
 Two automation points are required for a simple volume curve (start and end points).
 Curve points can be easily moved via drag & drop, during which the mouse cursor turns into a

cross.
 An additional double click on an automation point deletes it.

Hint: During audio recording, volume curves can be automatically created if the Volume damping
("Ducking")
 option is activated. 

Zooming
 Keyboard shortcut:
 The easiest way to zoom is by using the key combination "Ctrl+Page Up" (zoom in) and "Ctrl+Page
Down" (zoom out). 
Zoom menu:
 Right clicking on the start marker opens the context menu where you can select the most important zoom
levels. 
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Zoom-enabled sliders:
 Use the slider ("fader") to set up the visible clip on the horizontal time axis. 
You can tell which part of the entire arrangement is being played by the size and position of the slider. In
the full view, the zoom sliders take up the entire sliding space. The full view can be accessed by double
clicking on the slider. 
If you move the mouse to the edge of the slider, then the cursor will turn into a stretch symbol which can
be used to select and compress/stretch the fader. This way you can zoom in and out quickly and it isn't
confined to a set number of steps, but is continuous. 
Exact zoom levels can be selected by right clicking on the fader or on the start marker via the context
menu. Here you can also jump to certain positions in the arrangement. 

Grid
 The snap grid ensures that the objects always "snap" to certain points so that they can be positioned
precisely according to the beat. Two consecutive objects will seamlessly snap together, even if they are
on different tracks. This prevents undesired gaps or overlapping objects. 

Objects
 Sound and picture tracks are displayed as separate objects and are edited independently of one
another. 
Sound material is displayed as a wave form. Where there's something to see, there's something to hear.
Picture material appears with regular preview pictures as an object in the track. 
All objects can be cut uniformly, edited with effects, and arranged any way you like. During playback, all
objects on all tracks are mixed together automatically. When moving a photo, all related objects will be
moved along with it (audio recordings, frames, and text objects, for example). 

Object cutting and fades
All objects can be re-sized with their lower edge "object handles".
Move the mouse over one of the lower corners of the object until
the mouse pointer becomes a double arrow. 

You can now stretch the object as much as you like. 
At the top ends of every object you'll find two
fade handles that can be adjusted to fade an
object in or out. 

Adjust brightness/volume
 Using the brightness/volume handle located centrally at the top of the object, you can adjust the volume
of audio or MIDI
 objects or the brightness of video and image objects. Simply drag the handle either up or down. 
Even if several objects are playing simultaneously, the volume or brightness of individual objects can still
be altered. 

Select objects
 To edit or delete objects using the menus, you must first select them. To do so, simply click on the
object you wish to select. The handles of selected objects change color to show that the accompanying
object has been selected and can be edited using the menu functions or with effects. 
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Context menu
 Right clicking on an object opens the context menu with effects. You can now use the same Effects
 as in Storyboard mode. 

Duplicate objects
 Small objects (for example, audio loops) can be duplicated very easily. First, the objects that need to be
duplicated must be selected. Activate the copy command and then the Insert command ("Edit" menu
 or via the buttons in the Timeline mode). 
Speed up this process by clicking on the object to be copied with the mouse while holding down the
"Ctrl" key. This generates a copy which you can immediately drag to the desired position. 

Mouse modes
 With these mouse modes you can specify various working methods of MAGIX Xtreme PhotoStory on
CD & DVD 8 deluxe when moving objects. 

Mouse mode for individual objects
This mouse mode for individual objects enables free
positioning of individual objects. 

Intelligent mouse mode
Intelligent mouse mode moves all objects together located
behind the one selected. 

Page 92



Tracks
 There are 4 tracks in total for loading, arranging, and editing media files via drag & drop or double-click
from the Media Pool: 

 The first track is for the photos, but videos can also be loaded.
 The next track is for the audio track of videos and for the frames. Additional audio recordings

(so-called overdubs) are placed here (commentaries, for example).
 The third track contains the titles (which can be created via the buttons "Text" in Storyboard

mode) and style elements. These can also be added via the MovieShow Maker.
 The fourth track is for additional sound material, i.e. everything you may wish to add to your

photo via drag & drop from the Media Pool. Additional audio recordings (so-called overdubs)
are placed here (commentaries, for example).

 Volume curves
 Volume on tracks 2 and 4 can be automated. This is achieved using so-called volume curves. 

A typical volume gradient for damping
background music during a spoken
commentary. 

 In context menu of tracks 2 or 4, select "Volume curves".
 Double click the curve to set an automation point.
 Two automation points are required for a simple volume curve (start and end points).
 Curve points can be easily moved via drag & drop, during which the mouse cursor turns into a

cross.
 An additional double click on an automation point deletes it.

Hint: During audio recording, volume curves can be automatically created if the Volume damping
("Ducking")
 option is activated. 

Zooming
 Keyboard shortcut:
 The easiest way to zoom is by using the key combination "Ctrl+Page Up" (zoom in) and "Ctrl+Page
Down" (zoom out). 
Zoom menu:
 Right clicking on the start marker opens the context menu where you can select the most important zoom
levels. 

Zoom-enabled sliders:
 Use the slider ("fader") to set up the visible clip on the horizontal time axis. 
You can tell which part of the entire arrangement is being played by the size and position of the slider. In
the full view, the zoom sliders take up the entire sliding space. The full view can be accessed by double
clicking on the slider. 
If you move the mouse to the edge of the slider, then the cursor will turn into a stretch symbol which can
be used to select and compress/stretch the fader. This way you can zoom in and out quickly and it isn't
confined to a set number of steps, but is continuous. 
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Exact zoom levels can be selected by right clicking on the fader or on the start marker via the context
menu. Here you can also jump to certain positions in the arrangement. 

Grid
 The snap grid ensures that the objects always "snap" to certain points so that they can be positioned
precisely according to the beat. Two consecutive objects will seamlessly snap together, even if they are
on different tracks. This prevents undesired gaps or overlapping objects. 

Objects
 Sound and picture tracks are displayed as separate objects and are edited independently of one
another. 
Sound material is displayed as a wave form. Where there's something to see, there's something to hear.
Picture material appears with regular preview pictures as an object in the track. 
All objects can be cut uniformly, edited with effects, and arranged any way you like. During playback, all
objects on all tracks are mixed together automatically. When moving a photo, all related objects will be
moved along with it (audio recordings, frames, and text objects, for example). 

Object cutting and fades
All objects can be re-sized with their lower edge "object handles".
Move the mouse over one of the lower corners of the object until
the mouse pointer becomes a double arrow. 

You can now stretch the object as much as you like. 
At the top ends of every object you'll find two
fade handles that can be adjusted to fade an
object in or out. 

Adjust brightness/volume
 Using the brightness/volume handle located centrally at the top of the object, you can adjust the volume
of audio or MIDI
 objects or the brightness of video and image objects. Simply drag the handle either up or down. 
Even if several objects are playing simultaneously, the volume or brightness of individual objects can still
be altered. 

Select objects
 To edit or delete objects using the menus, you must first select them. To do so, simply click on the
object you wish to select. The handles of selected objects change color to show that the accompanying
object has been selected and can be edited using the menu functions or with effects. 

Context menu
 Right clicking on an object opens the context menu with effects. You can now use the same Effects
 as in Storyboard mode. 
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Duplicate objects
 Small objects (for example, audio loops) can be duplicated very easily. First, the objects that need to be
duplicated must be selected. Activate the copy command and then the Insert command ("Edit" menu
 or via the buttons in the Timeline mode). 
Speed up this process by clicking on the object to be copied with the mouse while holding down the
"Ctrl" key. This generates a copy which you can immediately drag to the desired position. 

Mouse modes
 With these mouse modes you can specify various working methods of MAGIX Xtreme PhotoStory on
CD & DVD 8 deluxe when moving objects. 

Mouse mode for individual objects
This mouse mode for individual objects enables free
positioning of individual objects. 

Intelligent mouse mode
Intelligent mouse mode moves all objects together located
behind the one selected. 
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Zooming
 Keyboard shortcut:
 The easiest way to zoom is by using the key combination "Ctrl+Page Up" (zoom in) and "Ctrl+Page
Down" (zoom out). 
Zoom menu:
 Right clicking on the start marker opens the context menu where you can select the most important zoom
levels. 

Zoom-enabled sliders:
 Use the slider ("fader") to set up the visible clip on the horizontal time axis. 
You can tell which part of the entire arrangement is being played by the size and position of the slider. In
the full view, the zoom sliders take up the entire sliding space. The full view can be accessed by double
clicking on the slider. 
If you move the mouse to the edge of the slider, then the cursor will turn into a stretch symbol which can
be used to select and compress/stretch the fader. This way you can zoom in and out quickly and it isn't
confined to a set number of steps, but is continuous. 
Exact zoom levels can be selected by right clicking on the fader or on the start marker via the context
menu. Here you can also jump to certain positions in the arrangement. 

Grid
 The snap grid ensures that the objects always "snap" to certain points so that they can be positioned
precisely according to the beat. Two consecutive objects will seamlessly snap together, even if they are
on different tracks. This prevents undesired gaps or overlapping objects. 

Objects
 Sound and picture tracks are displayed as separate objects and are edited independently of one
another. 
Sound material is displayed as a wave form. Where there's something to see, there's something to hear.
Picture material appears with regular preview pictures as an object in the track. 
All objects can be cut uniformly, edited with effects, and arranged any way you like. During playback, all
objects on all tracks are mixed together automatically. When moving a photo, all related objects will be
moved along with it (audio recordings, frames, and text objects, for example). 

Object cutting and fades
All objects can be re-sized with their lower edge "object handles".
Move the mouse over one of the lower corners of the object until
the mouse pointer becomes a double arrow. 

You can now stretch the object as much as you like. 
At the top ends of every object you'll find two
fade handles that can be adjusted to fade an
object in or out. 

Adjust brightness/volume
 Using the brightness/volume handle located centrally at the top of the object, you can adjust the volume
of audio or MIDI
 objects or the brightness of video and image objects. Simply drag the handle either up or down. 
Even if several objects are playing simultaneously, the volume or brightness of individual objects can still
be altered. 
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Select objects
 To edit or delete objects using the menus, you must first select them. To do so, simply click on the
object you wish to select. The handles of selected objects change color to show that the accompanying
object has been selected and can be edited using the menu functions or with effects. 

Context menu
 Right clicking on an object opens the context menu with effects. You can now use the same Effects
 as in Storyboard mode. 

Duplicate objects
 Small objects (for example, audio loops) can be duplicated very easily. First, the objects that need to be
duplicated must be selected. Activate the copy command and then the Insert command ("Edit" menu
 or via the buttons in the Timeline mode). 
Speed up this process by clicking on the object to be copied with the mouse while holding down the
"Ctrl" key. This generates a copy which you can immediately drag to the desired position. 

Mouse modes
 With these mouse modes you can specify various working methods of MAGIX Xtreme PhotoStory on
CD & DVD 8 deluxe when moving objects. 

Mouse mode for individual objects
This mouse mode for individual objects enables free
positioning of individual objects. 

Intelligent mouse mode
Intelligent mouse mode moves all objects together located
behind the one selected. 
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Grid
 The snap grid ensures that the objects always "snap" to certain points so that they can be positioned
precisely according to the beat. Two consecutive objects will seamlessly snap together, even if they are
on different tracks. This prevents undesired gaps or overlapping objects. 

Objects
 Sound and picture tracks are displayed as separate objects and are edited independently of one
another. 
Sound material is displayed as a wave form. Where there's something to see, there's something to hear.
Picture material appears with regular preview pictures as an object in the track. 
All objects can be cut uniformly, edited with effects, and arranged any way you like. During playback, all
objects on all tracks are mixed together automatically. When moving a photo, all related objects will be
moved along with it (audio recordings, frames, and text objects, for example). 

Object cutting and fades
All objects can be re-sized with their lower edge "object handles".
Move the mouse over one of the lower corners of the object until
the mouse pointer becomes a double arrow. 

You can now stretch the object as much as you like. 
At the top ends of every object you'll find two
fade handles that can be adjusted to fade an
object in or out. 

Adjust brightness/volume
 Using the brightness/volume handle located centrally at the top of the object, you can adjust the volume
of audio or MIDI
 objects or the brightness of video and image objects. Simply drag the handle either up or down. 
Even if several objects are playing simultaneously, the volume or brightness of individual objects can still
be altered. 

Select objects
 To edit or delete objects using the menus, you must first select them. To do so, simply click on the
object you wish to select. The handles of selected objects change color to show that the accompanying
object has been selected and can be edited using the menu functions or with effects. 

Context menu
 Right clicking on an object opens the context menu with effects. You can now use the same Effects
 as in Storyboard mode. 

Duplicate objects
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 Small objects (for example, audio loops) can be duplicated very easily. First, the objects that need to be
duplicated must be selected. Activate the copy command and then the Insert command ("Edit" menu
 or via the buttons in the Timeline mode). 
Speed up this process by clicking on the object to be copied with the mouse while holding down the
"Ctrl" key. This generates a copy which you can immediately drag to the desired position. 

Mouse modes
 With these mouse modes you can specify various working methods of MAGIX Xtreme PhotoStory on
CD & DVD 8 deluxe when moving objects. 

Mouse mode for individual objects
This mouse mode for individual objects enables free
positioning of individual objects. 

Intelligent mouse mode
Intelligent mouse mode moves all objects together located
behind the one selected. 
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Objects
 Sound and picture tracks are displayed as separate objects and are edited independently of one
another. 
Sound material is displayed as a wave form. Where there's something to see, there's something to hear.
Picture material appears with regular preview pictures as an object in the track. 
All objects can be cut uniformly, edited with effects, and arranged any way you like. During playback, all
objects on all tracks are mixed together automatically. When moving a photo, all related objects will be
moved along with it (audio recordings, frames, and text objects, for example). 

Object cutting and fades
All objects can be re-sized with their lower edge "object handles".
Move the mouse over one of the lower corners of the object until
the mouse pointer becomes a double arrow. 

You can now stretch the object as much as you like. 
At the top ends of every object you'll find two
fade handles that can be adjusted to fade an
object in or out. 

Adjust brightness/volume
 Using the brightness/volume handle located centrally at the top of the object, you can adjust the volume
of audio or MIDI
 objects or the brightness of video and image objects. Simply drag the handle either up or down. 
Even if several objects are playing simultaneously, the volume or brightness of individual objects can still
be altered. 

Select objects
 To edit or delete objects using the menus, you must first select them. To do so, simply click on the
object you wish to select. The handles of selected objects change color to show that the accompanying
object has been selected and can be edited using the menu functions or with effects. 

Context menu
 Right clicking on an object opens the context menu with effects. You can now use the same Effects
 as in Storyboard mode. 

Duplicate objects
 Small objects (for example, audio loops) can be duplicated very easily. First, the objects that need to be
duplicated must be selected. Activate the copy command and then the Insert command ("Edit" menu
 or via the buttons in the Timeline mode). 
Speed up this process by clicking on the object to be copied with the mouse while holding down the
"Ctrl" key. This generates a copy which you can immediately drag to the desired position. 
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Mouse modes
 With these mouse modes you can specify various working methods of MAGIX Xtreme PhotoStory on
CD & DVD 8 deluxe when moving objects. 

Mouse mode for individual objects
This mouse mode for individual objects enables free
positioning of individual objects. 

Intelligent mouse mode
Intelligent mouse mode moves all objects together located
behind the one selected. 
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Mouse modes
 With these mouse modes you can specify various working methods of MAGIX Xtreme PhotoStory on
CD & DVD 8 deluxe when moving objects. 

Mouse mode for individual objects
This mouse mode for individual objects enables free
positioning of individual objects. 

Intelligent mouse mode
Intelligent mouse mode moves all objects together located
behind the one selected. 
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The "Burn" interface
 You can open the dialog for designing the disc menu and creating the actual disc, a PC show (WMV
HD Video is saved on the PC) or WebDVD by clicking on "Burn" with the mouse. 
In this chapter
Basic and advanced mode
Preview
Menu templates
Menu options
Design
Navigation
Remote Control
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Basic and advanced mode
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe supplies 2 modes for designing the disc menu. 
In Basic mode you can only access complete menu templates
 to create a DVD quickly and easily. 

The Advanced mode offers all functions for menu design. Here you have access to all individual
elements of the menu templates, menu options, navigation, and remote control. Only in Advanced mode
are all the disc types
 supported by MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe available. 
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Preview
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe automatically adds graphical selection menus to
your slideshows. The menu is also burned to disc and appears when inserted into your player. Just like
with a purchased DVD, you can easily select your slideshows with the help of preview pictures, or
access particular chapters within a slideshow. 

At the center of the screen you can see a preview of the selection menu. This menu also appears when
the disc is inserted into the player later. The numbers in the image previews correspond to the number
keys on the remote control (the ones on your DVD player as well as virtual ones). 
Note
: At a screen resolution of 1280 x 1024, the program display changes. This is not a documentation error,
it makes the program more manageable and easier to use. The work steps remain the same despite the
different display. 
In this section
Menu entries and preview pictures
Menu entry properties

Menu entries and preview pictures
 The preview pictures and the menu title can be moved freely in the preview monitor. To do so, hold
down the "Ctrl" key, click on the preview picture, and drag it wherever you want. 
A double click on the preview picture or on a menu entry opens an editor to adjust the preview picture
or text entry. Use the slider to scroll through the photos or videos to search for a suitable preview
picture. With "Use different graphic
" you can load bitmaps for your menu pictures. 

Menu entry properties
 A double click on the preview picture or on a menu entry opens an editor with which you can adjust the
preview picture or text entry. Use the slider to scroll through the photos or slideshow to search for a
suitable preview picture. 

Menu text
 In the text input box you can enter any text to match the chosen menu entry. 
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Here you can set the vertical direction of the text (upwards,
centered or downward). 

Here you can set the horizontal direction of the text (left,
centered or right). 

Font size:
 Here you can set the height of the text in pixels. 
Font color:
 Here you can define the foreground color of the text. 
Font:
 Here you can set which font and which style (bold, italic, etc.) should be used. 
Apply to all:
 Except for the text, all settings are applied to all entries in the current menu. 

Menu image
 Use frame from movie:
 Use the fader to set which frame should be used in the video as a preview picture. The numerical input
fields are sorted as follows: Hours:Minutes:Seconds:Frames. 
Use different graphic:
 You can also load your own bitmap images to be used as menu pictures. 
Hint:
 It may be the case that there are no menu pictures in some menu templates, so changing the menu picture
won't have any noticeable effect. 

Actions at the end of the slideshow (Slideshow menu only)
 Here, you can enter which action should be carried out once the slideshow has finished playing. You
have the choice of: 
Stop playback:
 This option depends on the DVD player being used. Most DVD players show the DVD player's own
menu (or background picture) after playback. 
Jump to slideshow menu/photo menu:
 Jumps back to the previously shown menu. 
Tip 
Should one of the two options not be available, then check which menu mode is set. 
Jump to next slideshow:
 The next slideshow will be played without having to do anything else. 
Play slideshow as an endless loop:
 You can burn every slideshow onto a miniDVD or DVD as a loop as well. This means that the
slideshow is played as an endless loop until the next menu entry is accessed using the remote control, or
until playback is stopped. This way you can transform your TV into an aquarium, a train journey, a
fireplace, or anything that you could watch over and over again. 
Note:
 This option only works with DVDs or miniDVDs. 
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Menu entries and preview pictures
 The preview pictures and the menu title can be moved freely in the preview monitor. To do so, hold
down the "Ctrl" key, click on the preview picture, and drag it wherever you want. 
A double click on the preview picture or on a menu entry opens an editor to adjust the preview picture
or text entry. Use the slider to scroll through the photos or videos to search for a suitable preview
picture. With "Use different graphic
" you can load bitmaps for your menu pictures. 

Menu entry properties
 A double click on the preview picture or on a menu entry opens an editor with which you can adjust the
preview picture or text entry. Use the slider to scroll through the photos or slideshow to search for a
suitable preview picture. 

Menu text
 In the text input box you can enter any text to match the chosen menu entry. 

Here you can set the vertical direction of the text (upwards,
centered or downward). 

Here you can set the horizontal direction of the text (left,
centered or right). 

Font size:
 Here you can set the height of the text in pixels. 
Font color:
 Here you can define the foreground color of the text. 
Font:
 Here you can set which font and which style (bold, italic, etc.) should be used. 
Apply to all:
 Except for the text, all settings are applied to all entries in the current menu. 

Menu image
 Use frame from movie:
 Use the fader to set which frame should be used in the video as a preview picture. The numerical input
fields are sorted as follows: Hours:Minutes:Seconds:Frames. 
Use different graphic:
 You can also load your own bitmap images to be used as menu pictures. 
Hint:
 It may be the case that there are no menu pictures in some menu templates, so changing the menu picture
won't have any noticeable effect. 

Actions at the end of the slideshow (Slideshow menu only)
 Here, you can enter which action should be carried out once the slideshow has finished playing. You
have the choice of: 
Stop playback:
 This option depends on the DVD player being used. Most DVD players show the DVD player's own
menu (or background picture) after playback. 
Jump to slideshow menu/photo menu:
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 Jumps back to the previously shown menu. 
Tip 
Should one of the two options not be available, then check which menu mode is set. 
Jump to next slideshow:
 The next slideshow will be played without having to do anything else. 
Play slideshow as an endless loop:
 You can burn every slideshow onto a miniDVD or DVD as a loop as well. This means that the
slideshow is played as an endless loop until the next menu entry is accessed using the remote control, or
until playback is stopped. This way you can transform your TV into an aquarium, a train journey, a
fireplace, or anything that you could watch over and over again. 
Note:
 This option only works with DVDs or miniDVDs. 
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Menu entry properties
 A double click on the preview picture or on a menu entry opens an editor with which you can adjust the
preview picture or text entry. Use the slider to scroll through the photos or slideshow to search for a
suitable preview picture. 

Menu text
 In the text input box you can enter any text to match the chosen menu entry. 

Here you can set the vertical direction of the text (upwards,
centered or downward). 

Here you can set the horizontal direction of the text (left,
centered or right). 

Font size:
 Here you can set the height of the text in pixels. 
Font color:
 Here you can define the foreground color of the text. 
Font:
 Here you can set which font and which style (bold, italic, etc.) should be used. 
Apply to all:
 Except for the text, all settings are applied to all entries in the current menu. 

Menu image
 Use frame from movie:
 Use the fader to set which frame should be used in the video as a preview picture. The numerical input
fields are sorted as follows: Hours:Minutes:Seconds:Frames. 
Use different graphic:
 You can also load your own bitmap images to be used as menu pictures. 
Hint:
 It may be the case that there are no menu pictures in some menu templates, so changing the menu picture
won't have any noticeable effect. 

Actions at the end of the slideshow (Slideshow menu only)
 Here, you can enter which action should be carried out once the slideshow has finished playing. You
have the choice of: 
Stop playback:
 This option depends on the DVD player being used. Most DVD players show the DVD player's own
menu (or background picture) after playback. 
Jump to slideshow menu/photo menu:
 Jumps back to the previously shown menu. 
Tip 
Should one of the two options not be available, then check which menu mode is set. 
Jump to next slideshow:
 The next slideshow will be played without having to do anything else. 
Play slideshow as an endless loop:
 You can burn every slideshow onto a miniDVD or DVD as a loop as well. This means that the
slideshow is played as an endless loop until the next menu entry is accessed using the remote control, or
until playback is stopped. This way you can transform your TV into an aquarium, a train journey, a
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fireplace, or anything that you could watch over and over again. 
Note:
 This option only works with DVDs or miniDVDs. 
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Menu templates
 At the bottom of the screen, you'll see an array of preset menu templates. A tree structure is located on
the left-hand side for you to choose the type of menu template. 

 Animated (DVD): These templates contain background and introductory videos as well as
music. The DVD menu tools are displayed in various modes (selected buttons, for example). The
templates can only be used for mini DVDs and DVDs. If you burn a VCD or SVCD, then still
pictures and normal tools will be shown. Music can also be used.

 Static (DVD, VCD, SVCD): Here you will find templates suitable for use with DVDs, VCDs
and SVCDs. They consist of normal background pictures and tools

 Unique: These templates adjust to your disc project; the photos you use are integrated directly
into the menu. Every menu is unique and matches the project in its own way.

 TV ShowTime DVD: Use these templates (suitable for miniDVDs and WMV HD) to show
your pictures, not as small preview pictures in the slideshow menu, but rather as a full-size
preview photo on every menu page.

 This way you can use the "Skip" keys of the remote control to present the photos like a
slideshow - with the option of being able to start the slideshow at any time from the current photo
onwards.

Note:
 For these menus you have to leave the modes "slideshow and photo menus" activated! 

 HD DVD, WMV HD, miniHD-DVD: These templates contain super-sharp, high-resolution
background images that are particularly noticeable on HD TV devices. 

Note: 
This function is only available in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe deluxe! 
If you selected a specific type of menu template, you can use the horizontal scroll bar to view all the
templates. There are several possibilities when using the templates: 

 If you wish to apply a template to all menu pages, click on "Complete" in the template bar and
double click on the template of your choice. The complete template will then be applied.

 You can also combine the various elements of the individual templates. If, for example, you wish
to combine the text format of a template with another background, select "Text" and double click
on the template with the desired text. The preview in the middle shows you the results
immediately. 

You can load the template (or individual template elements) for the current menu (slideshow or photo) as
well as for all menus. 

Click on this button to load the current
selection for the entire disc menu. 

Clicking on the small arrow next to the button opens a menu containing additional options for applying the
current selection to the disc menu or current menu page. 

Menu options
The "Menu options"
 button lets you deactivate the
menus entirely or customize them. 

Mode
 "Menu
 design" lets you deactivate the menus entirely or only use the slideshow entries. 
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You can choose from 3 different
mouse modes: 

 No menus: The slideshows are burned to CD/DVD sequentially. When the disc is inserted, it
starts playing the slideshow automatically. 

Use the skip buttons on your remote control to
change to the previous/next slideshow. Since there is
no menu burned to CD, a menu preview is not
available. 

 Slideshow menu only: When the disc is inserted, the menu appears and you can choose a
slideshow on the disc by pressing the corresponding number key on your remote control. The
slideshow is then started. If, after a while, you haven't selected a slideshow, then the first
slideshow on the disc will start automatically. 

 Slideshow and photo menus: In addition to the slideshow menu, each slideshow also has a
photo menu. When selecting a slideshow, switch to the accompanying photo menu to choose
individual scenes via the numbers on your remote control.

Warning: 
A slideshow menu can have a total of 99 entries max. If your slideshow contains more than 99 photos,
then you should either burn the slideshow without the photo menu or split your slideshow into several
parts (see Cut menu). 
Note on SVCD compatibility:
 Some DVD players may have difficulty playing created SVCDs despite fault-free burning. If the disc
project contains slideshow and photo menus as well as several slideshows and/or a large number of
photos, then you can avoid such compatibility problems by: 
not using photo menus for SVCDs, 
only adding a single slideshow to the disc, or 
deactivating the PBC (Playback Control) feature
 - i.e. the menu navigation of the DVD player 
Preview pictures:
 Shows/Hides the preview pictures in the disc menus. 
Numbering:
 The numbers beside the menu entries can be selected directly using the remote control, but sometimes
they become bothersome. This option lets you turn them on and off. 
Frame:
 A frame borders the preview pictures. If you think it gets in the way, then you can easily remove it using
this option. 
TV cut:
 Use this to select whether the picture selected for the TV cut should also be used in the disc menu. 
Background graphic:
 Use this to include your own background picture for the menu (.bmp or .jpg format). It is also possible
to use individual pictures (frames) from your slideshows. 
Background video:
 Load a video for the menu background. 
Background video options:

  Create animated menu buttons: The preview pictures for individual movies from the film
menu are shown as small movie samples. You can set the start point and length of the animation
using the sequence options faders.

 Use the audio track of the video: The audio track of the background video is used with the
menu.

 Play menu animation as a loop: The background video (audio and/or video) will be played
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back as a loop.
 Length of the menu view is set by the audio/video or whichever medium is longer. Here you

can specify how long the background video should be. The other medium will be played as a
loop.

Background sound:
 This menu button allows you to load your own music files for the menu's background animation. 
Intro video: 
You can use this button to load videos to be used as introductions to your DVD or mini DVD. The *.avi,
*.mpg, *.mxv, *.vob formats are supported. The intro is played immediately after the DVD has been
inserted into the player. The DVD menu will then appear. 
Load ondisc editing project from disc:
 Use this button to load the DVD-/+RW in your drive for ondisc editing. 
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Menu options
The "Menu options"
 button lets you deactivate the
menus entirely or customize them. 

Mode
 "Menu
 design" lets you deactivate the menus entirely or only use the slideshow entries. 
You can choose from 3 different
mouse modes: 

 No menus: The slideshows are burned to CD/DVD sequentially. When the disc is inserted, it
starts playing the slideshow automatically. 

Use the skip buttons on your remote control to
change to the previous/next slideshow. Since there is
no menu burned to CD, a menu preview is not
available. 

 Slideshow menu only: When the disc is inserted, the menu appears and you can choose a
slideshow on the disc by pressing the corresponding number key on your remote control. The
slideshow is then started. If, after a while, you haven't selected a slideshow, then the first
slideshow on the disc will start automatically. 

 Slideshow and photo menus: In addition to the slideshow menu, each slideshow also has a
photo menu. When selecting a slideshow, switch to the accompanying photo menu to choose
individual scenes via the numbers on your remote control.

Warning: 
A slideshow menu can have a total of 99 entries max. If your slideshow contains more than 99 photos,
then you should either burn the slideshow without the photo menu or split your slideshow into several
parts (see Cut menu). 
Note on SVCD compatibility:
 Some DVD players may have difficulty playing created SVCDs despite fault-free burning. If the disc
project contains slideshow and photo menus as well as several slideshows and/or a large number of
photos, then you can avoid such compatibility problems by: 
not using photo menus for SVCDs, 
only adding a single slideshow to the disc, or 
deactivating the PBC (Playback Control) feature
 - i.e. the menu navigation of the DVD player 
Preview pictures:
 Shows/Hides the preview pictures in the disc menus. 
Numbering:
 The numbers beside the menu entries can be selected directly using the remote control, but sometimes
they become bothersome. This option lets you turn them on and off. 
Frame:
 A frame borders the preview pictures. If you think it gets in the way, then you can easily remove it using
this option. 
TV cut:
 Use this to select whether the picture selected for the TV cut should also be used in the disc menu. 
Background graphic:
 Use this to include your own background picture for the menu (.bmp or .jpg format). It is also possible
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to use individual pictures (frames) from your slideshows. 
Background video:
 Load a video for the menu background. 
Background video options:

  Create animated menu buttons: The preview pictures for individual movies from the film
menu are shown as small movie samples. You can set the start point and length of the animation
using the sequence options faders.

 Use the audio track of the video: The audio track of the background video is used with the
menu.

 Play menu animation as a loop: The background video (audio and/or video) will be played
back as a loop.

 Length of the menu view is set by the audio/video or whichever medium is longer. Here you
can specify how long the background video should be. The other medium will be played as a
loop.

Background sound:
 This menu button allows you to load your own music files for the menu's background animation. 
Intro video: 
You can use this button to load videos to be used as introductions to your DVD or mini DVD. The *.avi,
*.mpg, *.mxv, *.vob formats are supported. The intro is played immediately after the DVD has been
inserted into the player. The DVD menu will then appear. 
Load ondisc editing project from disc:
 Use this button to load the DVD-/+RW in your drive for ondisc editing. 
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Background graphic
 Here you can integrate you own background picture into the menu (BMP or JPEG format). Individual
pictures (frames) from slideshows can also be selected. 

 Background video
 Press this button to load a video or graphic and use it as an animation in the menu background. In
addition to the options for the background graphic (see above), you can also use a sequence from a
loaded slideshow or from a different video file.
Options: 

 Create animated menu buttons: The preview pictures for individual slideshows from the
slideshow menu are shown as small slideshow samples. You can set the start point and length of
the animation using the sequence option's faders.

 Use the audio track of the video: The audio track of the background video is used with the
menu.

 Play background slideshow in loop mode: The background slideshow is played as a loop.
In the Disc Simulator, click on "Play" to start the animation. 

Background music
 Press this button to load a sound file and use it as an animation in the menu background. 

Intro video
 You can use this button to load videos into the preview monitor to be used as introductions to your
DVD or miniDVD. The following formats are supported: "*.avi", "*.mpg", "*.mxv", "*.vob". The intro is
played immediately after the DVD has been inserted into the player. The DVD menu will then appear. 
Note: 
Animations (background videos, intro videos) can only be used with DVDs and miniDVDs, but not with
CD formats. 

OnDisc Editing – Load project from disc

 Use this button to load the DVD-/+RW in your drive for OnDisc-Editing. For more information on this,
consult the On Disc Editing section. 

Design
 The preview pictures, slideshow/photo names, and the menu title can be moved freely in the preview
monitor. 

Click on the wrench symbol. You can now
freely position and scale text fields and the
preview picture. Hold down the left mouse
button and drag a section to the desired
position. 
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You can adjust the size by dragging out the corners
and edges of the frame. 

Set page proportions: To avoid distortions you can
use this button to set the page proportions of the menu
elements. 
Grid button: You can precisely align the frame
positions with one another using the grid button. 
Group: Scales or moves menu elements together if
they belong to the same group. 
Copy button: With the help of the copy button you
can apply the menu settings to every template menu. 
Edit in MAGIX Xtreme Photo Designer (MAGIX
Xtreme PhotoStory on CD & DVD 8 deluxe deluxe
only): Use the last two buttons to open MAGIX
Xtreme Photo Designer for further editing of your
background pictures or menu elements. 
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OnDisc Editing – Load project from disc

 Use this button to load the DVD-/+RW in your drive for OnDisc-Editing. For more information on this,
consult the On Disc Editing section. 

Design
 The preview pictures, slideshow/photo names, and the menu title can be moved freely in the preview
monitor. 

Click on the wrench symbol. You can now
freely position and scale text fields and the
preview picture. Hold down the left mouse
button and drag a section to the desired
position. 

You can adjust the size by dragging out the corners
and edges of the frame. 

Set page proportions: To avoid distortions you can
use this button to set the page proportions of the menu
elements. 
Grid button: You can precisely align the frame
positions with one another using the grid button. 
Group: Scales or moves menu elements together if
they belong to the same group. 
Copy button: With the help of the copy button you
can apply the menu settings to every template menu. 
Edit in MAGIX Xtreme Photo Designer (MAGIX
Xtreme PhotoStory on CD & DVD 8 deluxe deluxe
only): Use the last two buttons to open MAGIX
Xtreme Photo Designer for further editing of your
background pictures or menu elements. 
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Design
 The preview pictures, slideshow/photo names, and the menu title can be moved freely in the preview
monitor. 

Click on the wrench symbol. You can now
freely position and scale text fields and the
preview picture. Hold down the left mouse
button and drag a section to the desired
position. 

You can adjust the size by dragging out the corners
and edges of the frame. 

Set page proportions: To avoid distortions you can
use this button to set the page proportions of the menu
elements. 
Grid button: You can precisely align the frame
positions with one another using the grid button. 
Group: Scales or moves menu elements together if
they belong to the same group. 
Copy button: With the help of the copy button you
can apply the menu settings to every template menu. 
Edit in MAGIX Xtreme Photo Designer (MAGIX
Xtreme PhotoStory on CD & DVD 8 deluxe deluxe
only): Use the last two buttons to open MAGIX
Xtreme Photo Designer for further editing of your
background pictures or menu elements. 
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Navigation
When you click on "Navigation" you
will see the structure of the menu. 
The disc menu can have two layers
at most: All of the project's
slideshows are listed as the first
entries. This menu level is the "
Slideshow
" menu. 
All photos (photos/objects in the
"Edit" window) are listed as
secondary entries next to the
slideshow entries. This menu level is
the Photo
 menu (this level is only available in
slideshow and photo menu modes). 
Removing the check deactivates the
corresponding entry in the photo
menu. The photos are still
displayed, but you can no longer
select them directly from the menu. 

With the slideshow positions
 you can restore the order of the slideshows/photos in the menu by highlighting the corresponding
slideshow or photo and using the arrow buttons to move them up or down. 

Page 120



Remote Control
 The virtual remote control is an important tool for checking the state of the disk to be burned. 
You can activate it with this button on the top
right. 
If you insert the CD or DVD with your disk project into the player, it controls the preview image just as a
"real" remote control controls the picture on a TV monitor. 

The number keys
 select the applicable entry in the menu. All menu
entries are marked with corresponding numbers.
Within a photo menu the playback is started from
the corresponding photo; in the slideshow menu it
switches to the corresponding photo menu (if
available) or starts playback of the slideshow. 
Navigation keys
 These keys are for navigating through the menu of
the disc you want to burn. You can either switch
between individual entries or confirm with "OK".
The remote control behaves the same way as that
of a real DVD player. 
Skip forward/back
 Skips to the next/previous scene during playback.
In the menu you can use it to skip through the
menu pages. 
Play Playback is started with the first menu entry.
If the scene menu is available (see Menu
 modes) you switch back to the scene menu first.
If you press Play again, then playback will
commence from the first scene of the slideshow. 

Stop
 stops playback. 
Disc menu
 switches to the first page of the slideshow menu, i.e. back to the starting point. 
Sub menu 
switches to the sub menu of the currently played movie. 
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Media Pool
 The design and operation of the Media Pool is very similar to Windows Explorer. It serves to control
and load multimedia files of all kinds: video files, audio files, fades, effects, and even entire projects. At
the same time, it is used as a window for editing different tasks. 
In this chapter
Media
Fades
Titles
Effects
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Media
 Navigation buttons
 The navigation buttons let you navigate through your computer's drives and folders. 

Forward/Ba
ck

The "Back" button always returns you to the
folder where you were previously. 

Upwards The "Up" button brings you to the next
highest folder level. 

Browse history list and
path details

The current folder's path is displayed in the
top center. 
Use the arrow button to open the menu to
find the folders you previously visited. 

Options All functions of the context menu (switch
views, rename, or delete files, etc.) can also
be accessed via the options button. 

Display options Settings for how detailed the entries should
be listed can be made here. 

Computer
 The link button "Computer" displays the drives in the Media Pool. All drives will be listed along with
their drive letters and can be opened with a double click. 

User directory 
The second button featuring the user's name opens their personal folder in the Media Pool. 

My media
 The "My media" button lets you select "Projects", "My videos", "My music", "My images", and
"Recordings". 

Projects (My media, etc.)
 Projects:
 Switches to the folder where your projects and videos are usually stored. 

My pictures
 My Pictures:
 Switches to the "My documents\My pictures" folder. This folder is often used by digital cameras and
scanners to store transferred images by default. The included MAGIX Photo Manager program also uses
this folder (e.g. during image import). 

My videos
 My videos:
 Displays all usable files found in "My documents\My videos." 

My music
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 My Music:
 Displays the contents of the "My Documents\My Music" folder. MAGIX Music Manager also suggests
this folder for importing your music collection into the database. 

MAGIX media
 The "MAGIX media" link enables selection of "Manage...", "Database", "Online Album", and "Web
import", and "Downloads". 
"Manage...": This opens the management program MAGIX Photo Manager for the database. This allows
you to create and organize the database accessed by MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe. 
Database
: Use this button to open the database view. Right clicking opens the database search. The database first
has to be created using the supplied additional programs MAGIX Photo Manager or MAGIX Music
Manager. 
Online album
: This buttons opens MAGIX Online Album. This provides a shortcut to uploading and deleting data. To
do this, you must first register on MAGIX Online Album. 
There are many ways to upload data: 

1. While holding "Ctrl" down, select the data to be uploaded in the Media Pool, and select "Copy"
in the context menu (opened by right clicking). Switch to the MAGIX Online Album screen,
open the desired folder, and select "Paste" in the context menu.

2. In the Media Pool, click on "Online Album", and go to the desired directory. Open the Windows
Explorer, select the desired data with "Ctrl" held down, and drag it into the Media Pool.

Both options will result in your desired data being uploaded to your MAGIX Online Album. 
Hint
: This function requires an Internet connection. To gain access, make sure you have your log in
information (email address and password) ready. 
Web import: You can open MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe's integrated browser
 here. It offers you the possibility to collect media from the Internet to use in the current project. 
Downloads: Use this button to access the media files that you downloaded with Catooh
. 

Deleting, copying and moving files
 All files listed in the file list can be selected, deleted, or moved/shifted (by holding down the mouse
button and using drag & drop to move them) into other folders just like in Windows® 

Explorer. This way all objects that come into question for a movie can be compiled into a separate folder
beforehand. 
The selection of these functions can be executed via the context menu which can be opened by right
clicking the entry. 

All functions of the context menu can also be accessed via
the context menu button. 

Load pictures, texts and audio files
 To preview, click on the corresponding file in the Media Pool. The bitmap/video is played in the video
monitor. If you want to use the bitmap file for your slideshow, drag it to the Storyboard while holding
down the mouse key or to a target track in Timeline mode. You can also load with a simple double click.
Videos and graphics are always added to the end; titles and audio files are placed at the position of the
start marker. 
If you would like to load several files, then hold down the "Ctrl" key while clicking on the entries you
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would like to use. 
If you would like to load a sequence of files, then hold down the "Shift" key, click on the first entry, and
then on the last. All entries in between are marked. 
The files are moved automatically into the tracks that have been set up for them: Videos and single frame
pictures in track one, sound in the second track, text objects (titles) in track three, additional sound files
in track four. 
If there are a lot of files, then those already selected are highlighted in the Explorer to help you keep an
overview. 

Preview
 The preview function can be used for all files. If an audio or video file is selected in the file list, the
transport console switches to preview mode. The transport functions of the transport console no longer
apply to the objects in the Arranger but rather to the file selected in the Media Pool. You will be able to
tell this by the flashing play button in the transport console. Use this button to start the preview. Graphics
and text objects are displayed immediately in the video monitor. 

Exchange
Replaces the selected object with an object selected in the
Media Pool. Length adjustment moves the objects following it
correspondingly. 

If photo objects are removed/exchanged, then the display duration will remain. 

Sound in picture support
 Some digital cameras have an audio recording function and save a WAV
 file with each photo. The PC identifies these cameras as separate drives. The audio file is automatically
included in the database overview when you import the photo from the camera. 
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Deleting, copying and moving files
 All files listed in the file list can be selected, deleted, or moved/shifted (by holding down the mouse
button and using drag & drop to move them) into other folders just like in Windows® 

Explorer. This way all objects that come into question for a movie can be compiled into a separate folder
beforehand. 
The selection of these functions can be executed via the context menu which can be opened by right
clicking the entry. 

All functions of the context menu can also be accessed via
the context menu button. 

Load pictures, texts and audio files
 To preview, click on the corresponding file in the Media Pool. The bitmap/video is played in the video
monitor. If you want to use the bitmap file for your slideshow, drag it to the Storyboard while holding
down the mouse key or to a target track in Timeline mode. You can also load with a simple double click.
Videos and graphics are always added to the end; titles and audio files are placed at the position of the
start marker. 
If you would like to load several files, then hold down the "Ctrl" key while clicking on the entries you
would like to use. 
If you would like to load a sequence of files, then hold down the "Shift" key, click on the first entry, and
then on the last. All entries in between are marked. 
The files are moved automatically into the tracks that have been set up for them: Videos and single frame
pictures in track one, sound in the second track, text objects (titles) in track three, additional sound files
in track four. 
If there are a lot of files, then those already selected are highlighted in the Explorer to help you keep an
overview. 

Preview
 The preview function can be used for all files. If an audio or video file is selected in the file list, the
transport console switches to preview mode. The transport functions of the transport console no longer
apply to the objects in the Arranger but rather to the file selected in the Media Pool. You will be able to
tell this by the flashing play button in the transport console. Use this button to start the preview. Graphics
and text objects are displayed immediately in the video monitor. 

Exchange
Replaces the selected object with an object selected in the
Media Pool. Length adjustment moves the objects following it
correspondingly. 

If photo objects are removed/exchanged, then the display duration will remain. 

Sound in picture support
 Some digital cameras have an audio recording function and save a WAV
 file with each photo. The PC identifies these cameras as separate drives. The audio file is automatically
included in the database overview when you import the photo from the camera. 
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Load pictures, texts and audio files
 To preview, click on the corresponding file in the Media Pool. The bitmap/video is played in the video
monitor. If you want to use the bitmap file for your slideshow, drag it to the Storyboard while holding
down the mouse key or to a target track in Timeline mode. You can also load with a simple double click.
Videos and graphics are always added to the end; titles and audio files are placed at the position of the
start marker. 
If you would like to load several files, then hold down the "Ctrl" key while clicking on the entries you
would like to use. 
If you would like to load a sequence of files, then hold down the "Shift" key, click on the first entry, and
then on the last. All entries in between are marked. 
The files are moved automatically into the tracks that have been set up for them: Videos and single frame
pictures in track one, sound in the second track, text objects (titles) in track three, additional sound files
in track four. 
If there are a lot of files, then those already selected are highlighted in the Explorer to help you keep an
overview. 

Preview
 The preview function can be used for all files. If an audio or video file is selected in the file list, the
transport console switches to preview mode. The transport functions of the transport console no longer
apply to the objects in the Arranger but rather to the file selected in the Media Pool. You will be able to
tell this by the flashing play button in the transport console. Use this button to start the preview. Graphics
and text objects are displayed immediately in the video monitor. 

Exchange
Replaces the selected object with an object selected in the
Media Pool. Length adjustment moves the objects following it
correspondingly. 

If photo objects are removed/exchanged, then the display duration will remain. 

Sound in picture support
 Some digital cameras have an audio recording function and save a WAV
 file with each photo. The PC identifies these cameras as separate drives. The audio file is automatically
included in the database overview when you import the photo from the camera. 
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Preview
 The preview function can be used for all files. If an audio or video file is selected in the file list, the
transport console switches to preview mode. The transport functions of the transport console no longer
apply to the objects in the Arranger but rather to the file selected in the Media Pool. You will be able to
tell this by the flashing play button in the transport console. Use this button to start the preview. Graphics
and text objects are displayed immediately in the video monitor. 

Exchange
Replaces the selected object with an object selected in the
Media Pool. Length adjustment moves the objects following it
correspondingly. 

If photo objects are removed/exchanged, then the display duration will remain. 

Sound in picture support
 Some digital cameras have an audio recording function and save a WAV
 file with each photo. The PC identifies these cameras as separate drives. The audio file is automatically
included in the database overview when you import the photo from the camera. 
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Fades
 This provides a list of all fades sorted into categories. Clicking on a category shows all of the fades
contained therein. 
To load a fade, click on it and drag it onto a scene which you would like to blend into. Alternatively, you
can select the scene into which you would like to blend into before and double click on the fade in the
Media Pool later. 
Tip:
 All fades will appear in the menu between two scenes, and they can also be selected there. 
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Titles
 Here you will find the title presets, all of which are also available in the title editor
. They are sorted into various categories and can be loaded via a double click. You will also find
templates for 3D titles here. The title object texts can be changed via the Media Pool. 
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Effects
 Access the effects presets via "Video effects", "Movement effects", "Audio effects", and "Design
elements". 
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Templates
 Most effects categories contain many useful templates that can be added simply by double clicking them.
A single click provides a preview. 
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Image optimization
In this section
Brightness & Contrast
Color
Sharpness
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Brightness & Contrast
 Brightness/Contrast
: Use the sliders to increase or reduce the brightness and the contrast of the picture. 
Selective brightness (gamma)
: "Gamma" determines the mean grayscale that can be calculated from the various color ranges. "Selective
brightness" is the most important function for enhancing images. In the preset list select various adjustment
curves and edit the dark, middle, or brightest points in the picture. 
Using the fader you can also set the power of the brightness/darkness adjustments. 
Auto exposure
: With this button you can automatically optimize the exposure and contrast with a click. 
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Color

 White balance
 All light is not the same. Depending on whether it is sunlight or artificial light, this will have an effect on
color variation. The human brain is able to compensate for this variation: A white sheet of paper will still
look white under candlelight, although it is in fact much more yellow than by daylight. 
In order to imitate this filtering done by the brain, a camera must also analyze and correct the light. White
balance does the same thing to a picture that the brain does by setting the camera to the so-called "color
temperature" of the surroundings. 
If you do not possess a camera which performs this function automatically, you can apply the white
balance function in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
An incorrect white balance can lead to an unnatural blue or red hue. 
Directions
: To use the white balance, click on the button to the right of the label "White balance" and then select a
point which represents white or a neutral gray to the "outside world". The color temperature is then
corrected automatically. 
Tip
: Cool color effects can be achieved by setting a different color as the white benchmark. There is
definitely room for experimentation! 

Red-eye-removal
 This photo function removes unnatural redeye that the results from using a flash. Click on the eye symbol
and then select the red pupils in the preview monitor using the mouse. 
Hint:
 For photo optimization, we recommend you use MAGIX Photo Manager. The program is installed
automatically and can be used for quick previewing and easy management of pictures from your
database. It has a tool for correcting redeye and setting auto color and white balance to control
discoloration in pictures. 

Saturation
 You can increase or reduce the color portions of images with the "saturation" fader. A newly developed
algorithm is applied which makes color changes related to other parameters (for example contrast
settings) in order to achieve the most natural coloration possible. With just a little bit of experimentation,
you can achieve astounding results – anything from turning summer snapshots into autumnal scenes to
funky pop art! 

Hue
 Select a color for coloring the image from the color chart. 

Red/Green/Blue
 Using the "Red/Green/Blue" slider, you can change the color portion mix for each color. 
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Sharpness
 The fader allows you to regulate the level of image sharpness or apply a soft filter. 
"Fine adjustment" allows you to set how sharp surfaces or edges should appear. This enables you to
effectively reduce image distortions (noise). 
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Distortion
 A large palette of effects for transforming your image material is available. 
In this section
Artistic filter
Distortion
Speed

Page 137



Artistic filter
 Erosion
: The image is broken up by means of small rectangles and resembles a "patchwork". 
Dilate
: The image is broken down into cell-like elements. 
Emboss
: The edges are strongly highlighted. 
Substitution
: Using the rainbow scale red, green, and blue parts are exchanged. Quickly create surreal landscapes
and green faces. 
Shift
: The color values are increasingly inverted. Blue colors turn red; green ones appear purple. 
Quantize
: Depending on the setting, colors are either rounded up or down so that the overall number of colors is
reduced. This creates impressive grids and patterns. 
Color fill:
 Using this slider, you can color in your video using red, green and blue colors (the basic TV colors). 
Contour
: The image is reduced to its contours in two sizes (3 x 3 or 5 x 5); vertical or horizontal contours may be
selected. 
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Distortion
 Motion
: Moving parts of the image are enhanced and warped. 
Echo
: The moving images create an optical "echo"; previous images stand still and gradually turn paler until
they completely disappear. 
Whirlpool
: The image is twisted into an "S" shape. 
Fisheye
: The perspective is distorted as if the image were viewed through a fisheye lens. 
Mosaic
: The video is depicted as a mosaic. 
Lens
: The image is dynamically distorted at the edges. 
Sand
: The image is depicted in a granulated manner. 
Kaleidescope
: The left upper corner is mirrored horizontally and vertically. 
Horizontal/Vertical mirror
: The object is reflected vertically or horizontally –  it appears on its side or upside down. 
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Speed
 The playing speed can be adjusted with the slider control. The range between 0 and 1 plays the video
slowly; values above 1 accelerate playback. If the playing speed is increased, the object length in the
arranger is automatically shortened. 
Reverse
: This button reverses the playback direction (with the same tempo). 
Note
: Since the soundtrack of a movie cannot be played backwards, you have to first separate the movie
object from its soundtrack. The speed effects cannot be animated! 
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View & animation
In this section
Section & zoom
Size & position
Mirror & Rotate
Angle & shape
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Section & zoom

 Section
 Cropped cutaways can be used to: 

 display just one section of the photo, 
 move the clip through the picture with the help of a movement effect – the result is a type of

camera pan. Please read more on this in the next chapter, "Movement".
In the program monitor, you can set a picture section to serve as the basis for the movement effect. Press
the left mouse button and drag out the section you want to use. 
Keep proportions
: Select the format for the section via this menu's settings. The format of the original picture is used as the
default. 

Movement in direction
Determine the direction in which the selected section or
image will move in the process during the time selected
under "time period". In addition to horizontal and
vertical movements, diagonal movements are also
possible. 

Fullscreen: If this check box is active, the opened section will zoom to fullscreen. If this option is switched
off, it won't be possible to add movement to the section. 
Preview
: Displays a preview of the section at the playback marker location. 

Direction and time
Zoom in
: The entire picture is displayed and then zoomed in to show
only a smaller picture section according to the time set in
"Length of movement". If no portion is previously set, a
central portion of 50% of the picture is set. 
Zoom out
: The selected picture section is displayed and is then
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zoomed out to display the entire picture according to the
time set in "Length of movement". If no portion is previously
set, a central portion of 50% of the picture is set. 

Direction and time
 The value specified here determines the position at which the keyframes for the corresponding
movement effect are set as standard. They determine the positions at which the pan start and stops. 
Note
: Automatically placed keyframes can be edited retroactively, and the option will then be set to "User
defined". Read the section "Changing an effect's keyframes" in the chapter "Animating objects". 

Movement & zoom
Reset
: This option applies a static zoom to show the
selected section of the picture only. 
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Size & position

 Values in
: Set whether the values are displayed in percent or pixels. 

Position
 Left: 
Enter the start position from the left image border. 
Top: 
Enter the start position from the top image border. 
Center:
 Based on the current image size, the image starting points (left and top) will be positioned so that they
are centered. 
Note:
 Negative values can, of course, also be entered. The image borders will then be outside of the visible
area. 

Size
 Width:
 Enter the width of the image. 
Height:
 Enter the height of the image. 
Note:
 The size and the position of the image can be roughly entered in the program monitor by simply moving
the image into it and dragging on the handles. 
Maximize:
 The image will be maximized according to the movie's resolution. 
Set original size:
 The image will be scaled to its original size. 
Retain proportions:
 This option makes sure that the image will not be stretched or distorted. The proportions of width to
height will remain the same. 
Edit:
 In the "Edit" mode you can change the position and size of the image using handles that can be displayed
or hidden. 
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Mirror & Rotate

This button resets all of the current settings. 

Note
: If you animated the object using keyframes, resetting will affect the entire animation. Individual
keyframes can be deleted during animation. 

Rotate
Rotates the image on the horizontal axis. 

Rotates the image on the vertical axis. 

Rotates the image around its center point. 

Straighten horizon 
The image can be rotated around the axis via the slider. The image is automatically zoomed to avoid
black edges. 
Show guidelines
: Activating this check box displays a grid in the program monitor for orientation during horizontal
straightening. 

Mirror
Mirrors the image on the vertical axis. 

Mirrors the image on the horizontal axis. 

Rotates the image 90° clockwise. 

Rotates the image 90° counterclockwise. 
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Angle & shape
 This makes real 3D positioning of images possible, letting you distort the image in space and move it.
Here you can enter the individual corner points numerically or move them in the program monitor using
the mouse. 

This button resets all settings. 
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Design

 decoration
 Under "Decoration" you will find tons of choices for pepping up your movie. You will find various
categories of decorative objects which serve to orient you during selection. 
All you need to do is click the corresponding element and you can start playback by pressing the space
bar. 
Filmstrips: 
With the start and end markers in the filmstrip you can specify at which point you wish the decoration to
appear and when it should finish. 
Size/Position:
 Here you can open an editor to set the size and position of the decoration. 
Double arrows:
 A category usually contains more elements than can be seen at first. Use the double arrows to switch to
the previous and next pages of each category. 

Magnetic objects
 Decorative elements in the Media Pool ("Design -> Decorations") can easily be linked to videos. 

 First, select the decorative element, position it exactly, and then set the desired size.
 Next, define the size of the element

and click "Follow object".
 Then sketch a frame over the moving

image section, e.g. over the head of
a person.

Upright-format effects
 Here you can select individual effects that are especially made for vertically formatted photos. 
Hint:
 This option does not appear for photos in horizontal format. 

Background
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides diverse backgrounds that can be used
in many different ways. Simply drag & drop the desired background at the position you want. 

Intros/Outros: 
These are beginning and end scenes for films with various themes. 
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decoration
 Under "Decoration" you will find tons of choices for pepping up your movie. You will find various
categories of decorative objects which serve to orient you during selection. 
All you need to do is click the corresponding element and you can start playback by pressing the space
bar. 
Filmstrips: 
With the start and end markers in the filmstrip you can specify at which point you wish the decoration to
appear and when it should finish. 
Size/Position:
 Here you can open an editor to set the size and position of the decoration. 
Double arrows:
 A category usually contains more elements than can be seen at first. Use the double arrows to switch to
the previous and next pages of each category. 

Magnetic objects
 Decorative elements in the Media Pool ("Design -> Decorations") can easily be linked to videos. 

 First, select the decorative element, position it exactly, and then set the desired size.
 Next, define the size of the element

and click "Follow object".
 Then sketch a frame over the moving

image section, e.g. over the head of
a person.

Upright-format effects
 Here you can select individual effects that are especially made for vertically formatted photos. 
Hint:
 This option does not appear for photos in horizontal format. 

Background
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe provides diverse backgrounds that can be used
in many different ways. Simply drag & drop the desired background at the position you want. 

Intros/Outros: 
These are beginning and end scenes for films with various themes. 
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Picture-in-picture collages
 These work similarly to normal picture-in-picture effects, but more objects are used. Depending on the
collage, arrange the selected objects one after the other and drag the collage onto the first object. 
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Animate objects
 Different kinds of animations are provided in the Media Pool. In the "Effects" tab, "Video effects" and
"Movement effects" provide you with the effects that can animated using keyframes. 
The following objects can be animated: 

 Image objects (still images)
 Title objects
 MAGIX 3D Maker objects (3D texts)
 Video objects

In this section
Preparing animations
Set keyframes
Copy keyframes
Display keyframes of individual parameters
Retroactively editing an effect's keyframes
Soft movement
Delete keyframe

Preparing animations
  First, select the object in the arranger to animate.
 In the Media Pool, open the "Effects" tab, and then click on the effect you would like to animate.

Most of the effects listed here can be animated, with the exception of the "Speed" effect.
 If necessary, set up the effect however you would like it for the start of the animation.
 A timeline is located at the bottom of the Media Pool where keyframes can be set, selected,

moved, and deleted.
There are two lines in the timeline
to help you orientate yourself
while you retroactively edit
movement. These lines will help
you recognize the start or end of
the transition. 

Note
: The figure corresponds to the display in "Timeline" mode. 

Set keyframes
 Click the timeline to set the playback marker at the locations where a keyframe should be added. 
Note
: You can also use the timeline in the arranger for exact positioning. 

 The button places keyframes for all parameters required in the
animation.

 Additional keyframes can be added simply by placing the playback marker at the next keyframe
location and changing the effect accordingly.

 The positioned keyframes can also be retroactively moved via drag & drop.

 Copy keyframes

Select the keyframes to be copied by clicking them and then
press the "Copy" button. 
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Next, set the playback marker at the location for insertion and
the press the "Insert" button. 

Display keyframes of individual parameters
 Multiple keyframes are added simultaneously to effects if they include multiple parameters. 

Click the small arrow beside the name of the
animated effect to display all of its parameters. 

Now all keyframes of the effects parameter can be
individually moved, deleted, activated, and
deactivated. 

Note
: Only those parameters are listed which are used for the animation. As soon as another parameter is
required for editing the effect, it becomes visible to you here. 

Retroactively editing an effect's keyframes
 Previously set keyframes can be retroactively moved and their values can edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe to be moved and drag it to the
desired position. 
To change an effects setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan is the result at set
keyframes. 

This option makes sure that the progression of these movements is executed more softly and more
naturally. 

Delete keyframe

Select the keyframe to be deleted by
clicking it. 

This button removes the selected keyframe. 
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Preparing animations
  First, select the object in the arranger to animate.
 In the Media Pool, open the "Effects" tab, and then click on the effect you would like to animate.

Most of the effects listed here can be animated, with the exception of the "Speed" effect.
 If necessary, set up the effect however you would like it for the start of the animation.
 A timeline is located at the bottom of the Media Pool where keyframes can be set, selected,

moved, and deleted.
There are two lines in the timeline
to help you orientate yourself
while you retroactively edit
movement. These lines will help
you recognize the start or end of
the transition. 

Note
: The figure corresponds to the display in "Timeline" mode. 

Set keyframes
 Click the timeline to set the playback marker at the locations where a keyframe should be added. 
Note
: You can also use the timeline in the arranger for exact positioning. 

 The button places keyframes for all parameters required in the
animation.

 Additional keyframes can be added simply by placing the playback marker at the next keyframe
location and changing the effect accordingly.

 The positioned keyframes can also be retroactively moved via drag & drop.

 Copy keyframes

Select the keyframes to be copied by clicking them and then
press the "Copy" button. 

Next, set the playback marker at the location for insertion and
the press the "Insert" button. 

Display keyframes of individual parameters
 Multiple keyframes are added simultaneously to effects if they include multiple parameters. 

Click the small arrow beside the name of the
animated effect to display all of its parameters. 

Now all keyframes of the effects parameter can be
individually moved, deleted, activated, and
deactivated. 

Note
: Only those parameters are listed which are used for the animation. As soon as another parameter is
required for editing the effect, it becomes visible to you here. 

Retroactively editing an effect's keyframes
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 Previously set keyframes can be retroactively moved and their values can edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe to be moved and drag it to the
desired position. 
To change an effects setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan is the result at set
keyframes. 

This option makes sure that the progression of these movements is executed more softly and more
naturally. 

Delete keyframe

Select the keyframe to be deleted by
clicking it. 

This button removes the selected keyframe. 
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Set keyframes
 Click the timeline to set the playback marker at the locations where a keyframe should be added. 
Note
: You can also use the timeline in the arranger for exact positioning. 

 The button places keyframes for all parameters required in the
animation.

 Additional keyframes can be added simply by placing the playback marker at the next keyframe
location and changing the effect accordingly.

 The positioned keyframes can also be retroactively moved via drag & drop.

 Copy keyframes

Select the keyframes to be copied by clicking them and then
press the "Copy" button. 

Next, set the playback marker at the location for insertion and
the press the "Insert" button. 

Display keyframes of individual parameters
 Multiple keyframes are added simultaneously to effects if they include multiple parameters. 

Click the small arrow beside the name of the
animated effect to display all of its parameters. 

Now all keyframes of the effects parameter can be
individually moved, deleted, activated, and
deactivated. 

Note
: Only those parameters are listed which are used for the animation. As soon as another parameter is
required for editing the effect, it becomes visible to you here. 

Retroactively editing an effect's keyframes
 Previously set keyframes can be retroactively moved and their values can edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe to be moved and drag it to the
desired position. 
To change an effects setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan is the result at set
keyframes. 

This option makes sure that the progression of these movements is executed more softly and more
naturally. 

Delete keyframe
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Select the keyframe to be deleted by
clicking it. 

This button removes the selected keyframe. 
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Copy keyframes

Select the keyframes to be copied by clicking them and then
press the "Copy" button. 

Next, set the playback marker at the location for insertion and
the press the "Insert" button. 

Display keyframes of individual parameters
 Multiple keyframes are added simultaneously to effects if they include multiple parameters. 

Click the small arrow beside the name of the
animated effect to display all of its parameters. 

Now all keyframes of the effects parameter can be
individually moved, deleted, activated, and
deactivated. 

Note
: Only those parameters are listed which are used for the animation. As soon as another parameter is
required for editing the effect, it becomes visible to you here. 

Retroactively editing an effect's keyframes
 Previously set keyframes can be retroactively moved and their values can edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe to be moved and drag it to the
desired position. 
To change an effects setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan is the result at set
keyframes. 

This option makes sure that the progression of these movements is executed more softly and more
naturally. 

Delete keyframe

Select the keyframe to be deleted by
clicking it. 

This button removes the selected keyframe. 
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Display keyframes of individual parameters
 Multiple keyframes are added simultaneously to effects if they include multiple parameters. 

Click the small arrow beside the name of the
animated effect to display all of its parameters. 

Now all keyframes of the effects parameter can be
individually moved, deleted, activated, and
deactivated. 

Note
: Only those parameters are listed which are used for the animation. As soon as another parameter is
required for editing the effect, it becomes visible to you here. 

Retroactively editing an effect's keyframes
 Previously set keyframes can be retroactively moved and their values can edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe to be moved and drag it to the
desired position. 
To change an effects setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan is the result at set
keyframes. 

This option makes sure that the progression of these movements is executed more softly and more
naturally. 

Delete keyframe

Select the keyframe to be deleted by
clicking it. 

This button removes the selected keyframe. 
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Retroactively editing an effect's keyframes
 Previously set keyframes can be retroactively moved and their values can edited. 
Keyframes can be moved via drag & drop. Simply click on the keyframe to be moved and drag it to the
desired position. 
To change an effects setting for an already positioned keyframe, click the keyframe and adjust the effect
in the Media Pool. 

Soft movement
Normally, a hard, unnatural pan is the result at set
keyframes. 

This option makes sure that the progression of these movements is executed more softly and more
naturally. 

Delete keyframe

Select the keyframe to be deleted by
clicking it. 

This button removes the selected keyframe. 
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Soft movement
Normally, a hard, unnatural pan is the result at set
keyframes. 

This option makes sure that the progression of these movements is executed more softly and more
naturally. 

Delete keyframe

Select the keyframe to be deleted by
clicking it. 

This button removes the selected keyframe. 
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Delete keyframe

Select the keyframe to be deleted by
clicking it. 

This button removes the selected keyframe. 
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Audio recording
 Songs, noises, or instruments can be easily recorded in MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe using the recording function. In Storyboard mode the wave file is visible directly below the photo
box. 
For the recording to be correct it is necessary to connect and calibrate
 the corresponding sound sources correctly. 

Recording dialog

 Add sound to entire slideshow: 
Use this option to begin playback of your slideshow from the start marker while recording in order to be
able to comment on each photo one after the other. The recording is cut simultaneously after every
photo. This way you can move your photos after recording; the corresponding comment is moved
automatically. 
Add sound to selected photo:
 Use this option to play the selected photo and add text to it directly. If your audio recording lasts longer
than the duration set for the photo, then the length of time for each photo is automatically extended. 
Audio driver:
 Selects the sound card for the recording. 
Save audio file as/ save in the following folder:
 Select the title of the audio file you wish to record. You can also select the folder where you wish to
store the file. 
Recording quality:
 Sets the sound quality of the recording. In the preset menu you can choose between medium wave radio
("AM tuner"), UKW ("FM Radio"), DAT (Digital Audio Tape), and CD quality. 
Peak meter (monitor): Using the peak meter, you can monitor the level of the incoming signal. Please
read more on this in the chapter "Adjusting levels"
 Recording:
 This button starts the actual recording. 
Stop: Click this button to stop recordingHint: To remove noise that developed while recording, you
should try out the effects in the Audio Cleaning
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Advanced audio recording settings

 Driver info
 Shows the name of the chosen recording device. 

General options
  "Mono" can be activated for recording in mono. This reduces the required memory space in

half. This is useful for spoken commentary as the microphone only communicates a mono signal.
 "Real-time sample rate adjustment" automatically matches the sample rate of a new file to

be recorded with the sample rate of the selected slideshow (set in the video recording).
 Automatic damping of volume levels on other tracks ("Ducking"): If you slideshow

already has a well-modulated soundtrack, and you would like to add some spoken comments or
other sound material, activate "Automatic damping of volume level on other tracks" in the record
dialog. This automatically lowers the volume of audio objects in the arranger during the recording
session. This is achieved using an automatically configured volume curve: Before and after the
recording other tracks will be faded in or out, resulting in a homogeneous total volume level.
(Lowering of volume level during spoken comments is also called "Ducking".)

 Track damping options
 Intensity of damping:
 Here you can determine by how many dB (Decibels) the volume should be lowered. A signaled lowered
by about 6 dB will be perceived by the human ear to be about half as loud. 
Tip:
 Depending on the kind of music or original sound, different settings should be given a try. If the music is
already soft, lowering by 6 dB will probably be enough; a hectic original audio track or loud rock music
damping should be stronger. 
Cross fade duration [sec]:
 Here you can enter, in seconds, how quickly the signal should be lowered or raised before and after the
recording. 
Hint:
 Volume damping can be edited later on in the track. You can read more about this topic in Volume
curves. 
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Connecting the source for recording
 First of all, the source of the audio material must be connected to the sound card input. Again, there are
several possibilities which primarily depend on the type of equipment you have. 
If you want to record material from a stereo system, then you can use the line-out or AUX out jacks on
the back of your amplifier or tape deck. This involves connecting them to the sound card input (usually
red). 
If your amplifier has no separate output (other than for the speakers), then you can use the connection
intended for headphones for your recordings. In most cases, you will need a cable with two mini-stereo
jacks. This type of connection has the advantage of being able to set the headphone input signal level with
a separate volume. As headphone connections generally are not the best, it is advised that you use the
line outputs if possible. 
When recording cassettes from a tape deck, you can connect the tape deck's line out directly to the
sound card input. 
When recording from vinyl records, you should not connect the record player's output directly with the
sound card because the phono signal needs to be pre-amplified. A more suitable method would be to use
the headphone connection or an external pre-amp. 
If you are recording from a microphone, then please connect the microphone to the microphone jack on
your sound card (usually red). 
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Adjusting the signal level
 Adjusting the signal level to the sound card is also recommend to get the best sound quality during digital
recording. 
Once a recording source is connected to the sound card, the "Record" button opens the recording dialog
and starts the recording source. 
You can now adjust the recording level with the help of the LED display in the recording dialog. For this,
you must first check off "Show levels". 
If the adjustment is set too high, distortion occurs and the incoming signal must be reduced. If you have
connected the source through either an amplifier or tape deck output to the sound card, you can only
reduce the signal level in your sound card's software mixer interface. You can access the mixer directly
from within the recording dialog via the "Recording level" button. 
If you reduce input sensitivity by using the input fader, the resolution at which the analog signal is digitized
is also reduced. Try to set these automatic controllers to the loudest sound level possible! 
The maximum setting for an optimal level is the loudest part of the material. The loudest part should be
adjusted to be the maximum. The actual recording begins when you press the "Record" button.  At the
end of the the recording you will be asked if you want to use the recording. Upon confirmation, the
newly-recorded material will be placed in the next free track at the position of the start maker in the
arrangement. 
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Individual Frame Capture
 Use individual frame capture to record snapshots straight from the connected video source. A
DirectShow compatible video recording/TV card or a corresponding USB device (for example,
webcam) is required. 
Use the time control to automate snapshot recordings. This can be used in the following areas: 

 For creating photo stories from videos
 Animations (stop-motion animation)
 Video monitoring
 Fast motion recordings

All pictures taken are added to the open slideshow. 

Video source:
 The video card for captures can be set up here. 
Save individual frame as:
 Here you can enter the title of the snapshot you wish to take. These will be saved with this name and an
incremented number. You can also select the folder where the photos are to be saved. 
Resolution: Here you can set the resolution of the recording. The resolution is based on the resolutions
that the camera supports. You can adjust the picture quality using the fader. The higher the quality, the
larger the file size of the individual recordings. "Reset"
 reverts the picture quality to its previous setting. 
Advanced...: Opens the advanced settings dialog of the video driver
. 
Camera noise during recording: 
You can check the acoustics by setting up a click sound for each snapshot. 
Recording:
 Pressing the red record button takes the picture (or starts the recording procedure for time-delayed
capture). 

Time control
 Photo duration in frames: 
Specifies how long the photo should be displayed in the slideshow. 
Interval:
 When activated, a series of pictures are taken. Snapshots are taken automatically at the selected interval
and then saved with an incremented number. If, for example, you set it up to take photos every two
seconds and each of these photos is to be 5 frames in length in the slideshow, the result will be a
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10-times accelerated fast motion recording. 
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Advanced settings in the video recording dialog
 Specify various settings for the video capture driver in this dialog. 
These dialogs, so-called "Property sheets", are made available by the video card drivers. The
driver-specific features can change from card to card, and the MAGIX team has only limited influence on
the behavior of these drivers. If there are problems, please contact the manufacturer of your video card
for driver updates. 
Input:
 Sets up the video card's so-called "Crossbar". 
This specifies which video and audio inputs will be used for recording. The crossbar feature precedes the
video recording module. It feeds the input signal to the recording module. 
In the "Input" field, you can select the signal source that the video card should use to record for this input.
Many video cards have separate crossbars for audio and video. If there are problems, try various
settings until the appropriate sound plays with the matching picture. 
Composite in = the normal video input (also called cinch box) 
SVHS in = SVHS input (special cable) 
Tuner in = TV signal from the integrated tuner 
Picture setting 
Video decoder: If your picture is only in black and white, or if it flickers, it's possible that the video
standard has been set up incorrectly. In the United Kingdom and Ireland PAL_I is used, in North
America, NTSC 
standard is used. 
VideoProcAmp:
 Fine tuning for colors, brightness, contrast, etc. Changing the manufacturer's settings is not
recommended. 
Picture format: Please do not make any changes here. Capture format settings can be configured in the
video recording dialog under "Recording quality
". 
Station selection (tuner):
 This option is only available when a TV tuner is integrated with the video card. If your TV software
doesn't support a recording function, then you can select the TV tuner as the input and use MAGIX
Xtreme PhotoStory on CD & DVD 8 deluxe as the video recorder for your PC's TV program. You can
then set up the TV channel of the tuner but cannot save it. It is therefore far more convenient to use the
TV software supplied with your PC for recording from TV and then import the recordings into MAGIX
Xtreme PhotoStory on CD & DVD 8 deluxe. 
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Transitions (fades)
 If you drag photos into the Arranger they are usually in sequence in Timeline/Storyboard mode. This is
called a "hard" transition. 
Transitions (fades) are a very important style tool for bringing the slideshow to life. With MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe there are many and diverse ways of fading between a slideshow
and photos. 
For the duration of a transition two scenes my be shown at once and mixed together in different ways.
These are called "Transitions" or "Fades". You will find a multitude of different variations in the transitions
folder in the Media Pool. 
Advanced settings
 There are special settings dialogs for all transitions of the first part of the menu and for the transitions in
the sub-menus "3D morph" and "3D tile". These are opened with the "Settings..." button. Here you can
make further adjustments depending on the type of transition. The dialogs are self-explanatory, the best
way of getting to know them is by trial and error. 
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Transitions in Storyboard Mode
You can open the transitions menu by simply clicking on the
transition symbol between two individual photos. 

Here's where you'll find all of the transitions that MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
has to offer. Simply select a transition. 
You can also choose the length of the transition. "Apply to all
" applies the setting to your entire slideshow. Additionally, you can set random presets for each transition
("Random Transitions") or apply the selected preset to all. 
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Simple crossfade in Timeline Mode
A simple transition can be created in the
Arranger of the Timeline mode by
dragging one object over another. A 
crossfade
 is automatically created. 

Using this basic transition the brightness of both images will be added together, and then one will be
faded in as the other is faded out simultaneously. The duration of the crossfade is displayed in the
Arranger by white crossing lines. You can adjust the length of the crossfade
 by dragging the upper object handle of the second object to the left or to the right. 

To select a transition type click on the transition symbol
displayed on each selected object, and then choose your
favorite from the menu. 

The transition icon will change depending on your selection. 
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Drag & drop onto a "hard" transition
 Click on the "Fades" button in the Media Pool. The transitions folder will now appear in the file list. Like
always, clicking on a transition once will bring up a preview. 
Now just drag the desired transition and drop it onto the second of two photos you want to crossfade.
Only when the mouse pointer with the transition preset is placed over a scene change will it turn into an
object symbol. The object at the back will be shifted to the front to accommodate the transition. 
The length of a transition is decided by you. If a transition is shortened, it means that the resulting effect is
speeded up. There are two types of transitions: vfx transitions and alpha transitions. They can be found in
the Media Pool and are displayed as blue/yellow icons with the letters A/B on them. 
If you have selected this type of fade, then you can access it again by clicking on the fades button in the
menu and then selecting "Settings..."
 at the very bottom, which, in turn, opens a dialog for fade effect settings. Thus, an object's fade symbol
in the Media Pool can represent an entire group of different effects. 
The alpha fades (iris, objects, random, etc.) are actually pre-produced black and white videos combined
with the alpha keying effect. 

3D transitions
 General options
 3D power effects offer exciting and varied opportunities for creating transitions between two videos.
You will find the 3D effects in the Media Pool's transitions directory. 
To display the 3D fades as smoothly as possible, the program uses the accelerator features of your
graphics adaptor. 3D functions can be used with both software standards: Direct3D and OpenGL. These
standards are variably supported by the respective graphics card drivers. For this reason, you can switch
between different fade settings for each standard. 

Settings
 In the transition settings you can adjust the look and reaction of the 3D transitions. To do so, click the
corresponding fade symbol in the timeline or in the storyboard and select "Settings". 
The following options are then available to you: 
Anti-aliasing
: An undesirable step effect is usually created at the borders of 3D objects. Anti-aliasing reduces this
effect, but also requires more computer power. This setting applies globally for all 3D fades. Switching
anti-aliasing for a 3D transitions therefore ensures that this setting is applied to all other 3D transitions 
Mirror X/Y: This option lets you influence the movement curve of the 3D objects within the transitions.
The "X axis mirror" option mirrors the movement of the object horizontally. The option "Y axis mirror"
mirrors the movement of the object vertically
 (along the Y axis). 
Rendering
: Determine which software standard (see above) you would like to use to render the 3D objects, i.e.
OpenGL or Direct3D. Both modes use the hardware functions of the graphics card to render the 3D
transition. Nevertheless, they can produce different results, both in performance as well as in the final
look of the transitions. 
To use Direct3D, you have to have DirectX9.0a installed. OpenGL requires an OpenGL1.1 driver. 
This setting applies globally to all 3D transitions. Switching between the render modes of a 3D transition
therefore ensures that all other 3D transitions also use this setting. 
Hardware acceleration deactivation
: Hardware-accelerated rendering on the graphics card increases the performance multiple times over;
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however, it may lead to problems on some systems. If errors should occur in connection with the 3D
transitions, you can deactivate hardware acceleration for calculating 3D transitions. 
To do this, select the "Program settings" item from the file menu and deactivate the options "Hardware
acceleration for 3D effects". To apply these changes, you will need to restart the program. 

Troubleshooting

 Problem
: The 3D transition display in the video monitor is sluggish and jittery. 
Solution: The performance of the 3D power effects is dependent on your graphics adapter's CPU
 power. To achieve a smoother display you can deactivate anti-aliasing in the 3D transitions settings
dialog, or you can choose a lower resolution for your screen. Furthermore, you should ensure that you
have the latest driver for your graphics card installed. During export or burning to disc, transitions will be
displayed fluidly in any case. 
Problem
: The screen remains black or displays errors during 3D transitions. 
Solution
: The 3D transitions use hardware-accelerated rendering on your graphics card to calculate the image.
This can lead to compatibility problems on certain systems. Please ensure that you have the latest driver
for your graphics card installed. In certain circumstances, this may also fix the switchover between the
render modes (in the settings dialog of the transitions) or solve the problem by deactivating anti-aliasing. 
If there are still problems, however, you can deactivate hardware acceleration completely. Refer to
"Deactivating hardware acceleration" for more info. 
Problem
: A warning that there is insufficient graphics card memory for rendering the transition is displayed when
exporting or burning a slideshow containing 3D transitions. 
Solution
: The video memory on your graphics card is insufficient to render the 3D effect at the desired resolution.
Select a lower resolution (e.g. 720 x 576) in the export dialog. If the problem persists, deactivate the
hardware acceleration as described in the section "Deactivating hardware acceleration". 
Problem
: Only a crossfade is displayed when previewing a 3D transition. A warning is displayed that insufficient
graphics card memory is available 
Solution
: The video memory of your graphics card is insufficient to render the 3D effect at the desired resolution.
Right click the video monitor and then select a lower resolution in "Resolution presets". If the problem
persists, try deactivating hardware acceleration as described above. 
Problem
: Only a crossfade is displayed when previewing a 3D transition. A warning is displayed that the 3D
transition may not be displayed correctly. 
Solution
: Deactivate hardware acceleration; see "Deactivating hardware acceleration". 
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3D series
 The 3D series are an advanced development of the already known 3D fades
 and open up new thematic possibilities. The 3D effect and a practical sequence of transitions are put to
the fore here. For instance, you can let photos pop up and disappear on a notice board or make it look
as if the photos were hung on the walls of a gallery. The series stretch out over several photos or even
entire slideshows. 
In MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe there are several options to call up 3D series
for photos: 

1. In the Media Pool, click on Fade and open the
3D series. Select the desired 3D series and drag
it onto the photo from which the series should
start. 

2. In the Fades menu the various 3D series
between two photos are listed under the menu
point "3D Series". Click on the desired 3D
series to select it. 

A dialog opens in which you can select how many of the subsequent fades should be replaced by the 3D
series. 
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Effects
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Effects in menus
You can access the effects menu for fine tuning via the
Effects menu (in Storyboard
 mode) or via the context menu. 

The entries for "Image optimization", "Transform", "View & animation", and "Design" access the
corresponding Effects in the Media Pool. "Image optimization" provides additional entries for "TV image
". The other effects are mentioned in the Effects
 menu. 
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Effects from the Media Pool
 The effect files in the Media Pool "Effects" settings
 can be applied by clicking them or via drag & drop. 
Simply click on one of the effects to view a short preview on the video monitor to see what an effect can
do. If you want to use the effect, simply drag & drop it onto a photo or video. 
To deactivate all effects of a photo, select "No effect" (you can also deactivate the effects via "Turn of
effects" from the "Effects" menu). 
Other effects can be set directly in the Media Pool; they have a direct effect on the selection. 
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Optimize picture
 For more exact settings, there are multiple effects in the Media Pool for "Image optimization". 
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Video stabilization
 The video stabilizer reduces unsteady camera motion and helps to smooth recordings. This option can
be accessed from the context menu of a video object or via the "Effects" menu. 
Functionality
 Video stabilization balances undesired picture movement. The motion stabilizer equalizes inadvertent
movements in the image by moving the image in the opposite direction in accordance with the wrong
movements. This produces unusable edges in the footage that are cut off automatically, and black strips
replace the edge of the shifted picture, which are then removed using a zoom shot. The result: A clearly
more stable, almost imperceptibly larger picture. 
Application
 Activate the motion stabilizer in the video object FX or context menus. You will see the current video
object in the preview monitor. 
First you have to check the movie material for shaky scenes. To do this click on the "Stabilize" button.
Based on the preset parameters, a relative shift between the pictures is calculated. After concluding the
analysis, take a look at the suggested correction, then use the slider for further adjustments. Use the fader
to do this. Once you are happy with the final correction click OK. If the first scan did not provide a
satisfactory result, try changing the parameters below and repeat the process. 
In this section
Image stabilization dialog
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Image stabilization dialog

 Stabilizing radius
: To prevent the image stabilizer from recognizing every camera movement as unwanted shakiness, you
can determine the radius within which movement is accepted; the larger the stabilization radius, the more
shakiness is corrected. Changing this parameter will require re-analysis of the source footage. 
Analysis area
: This area determines the area of the footage that should be analyzed. The center of the image is preset.
If shaking occurs in one area more than in another,  then you can move the analysis area (e.g. a
foreground element at the edge is especially shaky). To do this, use the mouse to "capture" the shaky
area. The smaller the area, the quicker the analysis will be calculated. Generally, changing this parameter
will require re-analysis of the source footage. 
Maximum movement
: Correction moves the image accordingly to the shaking movements. This means that the edge of the
image will be removed. This value determines how large the edge area is which may be cut away by the
stabilization feature; the smaller the value, the less movement correction. Changes to this value are
immediately applied. 
Temporal smoothing
: This value determines the speed of the movements considered shaky. This allows you to differentiate
between a panning shot and a nervous hand-held shot. Changes to this value are immediately applied. 
Cancel
: Exits the dialog without accepting changes to settings. 
Reset
: Resets the current settings. 
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MovieShow Maker
The MovieShow Maker transforms your photos into
spectacular slideshows. With a single mouse click
you can adapt the edits to the rhythm of the
background music. 

Style:
 Styles combine your photos with short movies, effects, and crossfades. 
Apply styles between start and end markers: When this checkbox is activated the style is only
applied between the start and end markers. 
Otherwise, the styles are applied to the entire slideshow material. 
Apply audio file:
 In the dialog you can select a song or other audio material to add to the soundtrack. 
Volume: Fader
 for matching the music and the original soundtrack of the photo file. 
Slideshow duration:
 Fader for specifying the duration of a slideshow. Photo display duration and crossfades are subsequently
increased or decreased. 
Effect frequency and intensity:
 The effect slider controls the intensity of the automatic effects. 
Use the Enhance
 button to specify effects. 
Try out the different styles with your photos – you'll be amazed! 
Style Preview:
 The dialog preview monitor shows you how your settings will affect your slideshow. 
Using your own rolling credits:
 This is where you enter text for credits. You can edit the credit texts at any time using the "Edit rolling
credit texts" button. 
Use Style:
 Assigns text to slideshow rolling credits. 

Page 182



Advanced
 In this dialog, you can specify which effects you want to use and which you don't, and the higher the
frequency and intensity, the more effects appear in the list. 
Tip:
 To select or deselect all effects in the current style, first set the "effect frequency and intensity" controller
to "maximum" and then deselect the desired effect. 
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Sound optimization
 This option opens an editor for correcting audio material discrepancies. 
Select the cleaning function you desire from the upper part of the dialog: 

 The equalizer allows you to manipulate the frequency spectrum – perfect for cleaning up muffled
dialog. 

 The compressor is a dynamic volume control that lends the overall sound a deeper, richer quality.
 The stereo FX processor justifies the position of the sound in the stereo panorama.
 DeNoiser, DeClipper, and DeHisser are professional noise reduction tools that do exactly what

their titles say they do.
Presets:
 You can try out the suitability of a number of presets in the preset menu. 
Temporarily deactivate all effects:
 Switches all the effects off. 
Apply to all
: Applies the current settings of all effects to every photo in the selected slideshow. 

DeClipper
 Should the input level of an audio recording be too high, then overmodulation (digital distortion) may
result at the loudest parts (the signal peaks). This digital distortion can also be called "clipping". At the
overmodulated area, the values that are too high are simply cut off, and the typical, quite unpleasant
sounding crackling distortions are heard. 
MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe contains a special function for dealing with digital
clipping and analog distortions. 
Using the fader, you can set at what level the DeClipper should register a signal as being overmodulated
and, if required, correct it (clip level
). This is important, since different sound cards show different clipping methods. The more the fader is
turned up, the lower the level recognized by the program as overmodulated. If the clip level is set too
high, unwanted sound modification may occur. 
Get clip level:
 The clip level is gauged automatically. 

Page 184



DeClipper
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Noise Reduction: Denoiser and Dehisser
 DeNoiser
 The DeNoiser is especially useful for clearing long-lasting disruptive noise like mains humming, hissing,
noises from sound charts, disturbance noise from ground circuits, interference from audio-equipment with
high mic outputs (record players), impact noise, or the rumbling of records. 
The DeNoiser requires a noise sample. Some typical sounds are at your disposal. 
Set the degree to which the noise should be reduced with the fader. It is often better to reduce
interference signals by 3-6 dB rather than as much as is possible so as to keep the sound "natural". 
Another possibility is to create a noise sample yourself. You need a short sample from the sound track in
which only the background noise can be heard. Then switch to the DeNoiser dialog with the "Advanced"
button. 

Step 1: Select noise sample
 First you have to select a noise sample of the noise you want to remove. 
You have two options: 
Pick out typical background noise:
 You can select and use a number of typical background noises from the flip menu. Select one and listen
to it via the "Play" button. If it is similar to the background noise in your sound track, go ahead and use it
(see "Step 2: Removing background noise"). 
Extracting a new noise sample from a sound track: 
You can also pick out a short passage (from the existing sound track) in which you can hear the
background noise. 
Automatic search:
 Searches especially quiet passages in which background noise most probably resides. 
Previous/play/next: 
These buttons allow you to play all of the passages found for easy comparison. 
Save as: 
Once found, you can save noise samples on the hard drive which then appear as an entry in the "Typical
background noises" drop-down menu to be used in other projects. There's no need to save it if you only
want to use it once, and in this case switch to "Remove background noise". 
If you only want to use the noise sample in the current project, then you don't have to save it. You can
immediately switch to the "Remove category". 

Step 2: Remove background noise
 Noise level:
 The level of the noise reduction function should be set as precisely as possible. Low settings result in
incomplete deletion of the hissing. An incomplete deletion of the hissing produces artifacts and should be
avoided. High settings produce dull results and useful signals which are similar to hissing (woodwinds, for
example) are also filtered away. It's worth your time to find the best setting. 
Reducer:
 Here you can set the balance between the original signal and the signal with depressed interference. It is
often better to reduce interference signals by 3-6 dB rather than as much as is possible so as to keep the
sound natural. For buzzing it's best to apply complete removal. 

Dehisser
 The DeHisser eliminates regular "white" noise typically produced by analog tape recordings, microphone
pre-amplifiers, A/D converters, or transformers. 
Noise reduction can be regulated in decibels with the fader. It is often better to reduce interference
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signals by 3-6 dB rather than as much as possible in order to keep the sound "natural". 
Noise level: 
You can choose between different noise levels. The level of the noise reduction function should be set as
precisely as possible. Low settings result in incomplete deletion of the hissing. Incomplete deleting of
hissing produces artifacts and should be avoided, since high settings will produce dull results and some
useful signals (i.e. woodwinds) which are similar to hissing are also filtered away. 

Equalizer
 The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and supplies them with
separate volume controls to allow you to achieve many impressive effects, from the simple rising of the
bass to total sound transformation. If you raise the low frequencies too much throughout the whole level,
it might cause distortions. 
Fader: 
The volume of each of the 10 frequency bands can be set separately with the 10 volume controls. 
Link frequency bands:
 The frequency fields can be bundled together flexibly in order to avoid artificial-sounding exaggeration in
individual frequency fields. 

Compressor
 The compressor is essentially an automated dynamic volume control tool. Pitch dynamics are limited,
loud passages stay loud, and low passages become louder. Compression is often used to make the
material more powerful, particularly for bass recordings and vocals, but also as master effects in the
mixer for adding to the overall sound. 
Ratio: 
Regulates the compression ratio. 
Function: 
Defines the compressor's mode of operation depending upon the sound material. 

Stereo FX
 The stereo FX processor provides adjustment of the alignment of the audio material in the stereo
balance. If the stereo recordings sound weak and undifferentiated, an extension of the stereo base width
can often provide better transparency. 
Bandwidth control: 
Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum
bandwidth ("wide" on the extreme right). 
Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels
include identical material and the bandwidth control is pushed to the extreme left on "mono", the result
can be a level increase of 3 decibels. 
Raising the bandwidth (values of 100) diminishes the mono compatibility. 

Title
 Titles can be used for many applications, e.g. as a running text (ticker), subtitles, speech and thought
bubbles, to display date and time, and much more. 
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Title Editor

The text button
opens the Title
Editor from which
you can enter text
(e.g. for subtitles
or credits) in any
number of fonts
or colors. The
text can be made
to scroll (perfect
for rolling credits)
or be furnished
with effects,
designs, or other
forms of
movement. 

To include and edit a title in your project proceed as follows: 
 Select a template. Simply click on it to preview it in the video window. This way you can see

how certain title settings will look and what effect they will have. 
 The Title Editor is basically a small text program that you can use to enter text and format it

however you like. Write your text for your video subtitles and format it to fit your requirements.
You can enter text, font, size, color, typeface, and more directly from the Title Editor by clicking
on the font button. 

 In the Templates drop-down menu you can set even more effects and dynamic animations
for your text (have the text wander from the top of the page to the bottom, for example). 

 If you wish to format the entire text, then you don't have to select the entire text beforehand. If a
selection has not been made the entire text will be formatted (clicking on "underline" underlines
the entire text). You can select the entire text's color from all possible text colors (symbol
color in the font dialog only supports the standard text colors, which may not be suitable
depending on video material). 

 In the "Text effects" chapter under "Display" you can add shadows, borders, and/or 3D
effects to the text. Fine tuning settings can be found in the "Advanced" button.

 To arrange your text in the video monitor use the scroll bars and the Title Editor above the text
window. You can freely position the writing vertically and horizontally. If you have chosen a
movement for the title this position sets the start position of the title. Double clicking on the scroll
bars brings the title back to the middle of the video monitor. 

 Please note that when setting up a movement the start position of the title is set outside of the
video window by default. You can, however, change the start position by moving the vertical
position slider (to the left of the video monitor). 

 In the category "Title length" you can set how long the title should be shown. 
 The "Preview" button provides a title preview in the video monitor whenever you need it. The

complete video also shows with the title. If you've selected a movement for your title, then the
title will be animated in the video window. You can interrupt the preview at any time with the
"Stop" button. 

 When you have finished working on your title close the Title Editor by pressing the "OK" button.
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 Advanced settings in the Title Editor
 Options
 High title resolutions:
 Draw the font at larger resolutions. This option should always be active. 
Smooth fonts:
 Hard edges are smoothed. This works especially well when using italics. 
Background
 Here you can specify how the background should look. This affects the display of the text effects. 
Text effects
 Here you can specify the strength and color of the borders, the shadows, and the 3D effects. 
Note:
 The color is set by default to black upon activation of a text effect when the background is white, and
vice versa. 

Titles in the Media Pool
 You can also use the tab "Titles" in the Media Pool. Select title presets from the title editor just like any
other object, and then drag them onto an object via drag & drop. You can open a preview in the source
monitor by double clicking on the title. 
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Titles in the Media Pool
 You can also use the tab "Titles" in the Media Pool. Select title presets from the title editor just like any
other object, and then drag them onto an object via drag & drop. You can open a preview in the source
monitor by double clicking on the title. 
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3D text
 3D text can be created directly from the title editor. Click the title editor and then press the "As a 3D
title" button. The title object will now be turned into a MAGIX 3D object. If you have also installed
MAGIX 3D maker, the program will open for you to work on the text. 
Presets are also located in the Media Pool under "Titles -> 3D". You can enter or process text here. 
For more information about MAGIX 3D Maker, try the help file. You can open it by pressing "F1" from
within the program. 
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Remix Agent
 The Remix Agent in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe deluxe is required for
musical cut adjustment and will be launched for this purpose. It analyzes the rhythm of a musical piece.
The basis for this analysis is the rhythm speed, measured in BPM (Beats per Minute). 
MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe then ensures that photos located at the beats
detected are moved such that the images change in time with the rhythm. 
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Prerequisites for using the beat recognition assistant
  Songs must be longer than 15 seconds
 Songs must be "rhythmic" (i.e. they can be danced to)
 Songs must be in stereo format
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Preparation: Setting the start marker and object end
 Before opening the Auto Remix Assistant, you should set the start marker at the position in the song
object in the arranger where you want detection to start. If the song contains a long intro without beats,
set the start marker after the intro. As a rule of thumb, the Auto Remix Assistant should always be "fed"
dance music. 

 The start marker should be set before a quarter note beat or, better still, briefly before a beat at
the start of a bar.

 If the start marker lies before the song object, the object is examined from the beginning. 
 If detection is not performed by the end of the song, the object can be shortened accordingly

with the object handle at the end of the object. 
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Automatic Tempo Recognition
 When the Auto Remix Assistant is launched, the selected song object is analyzed and played back. A
metronome begins to click according to the result and lines visualize the positions of the quarter notes
found in the wave-shaped display. 
The following cases are differentiated: 

 Position of the start of a measure (the one): red line.
 Position of the other quarter notes (the two, three, and four): green lines.
 Reliably recognized positions: thick lines.
 Unreliably recognized positions: thin lines.
 When tapped, blue lines appear.

If the tact and tempo information is already present, points are indicated above the display at the
appropriate positions. The metronome volume can be regulated below and to the left of the wave-shaped
display. To the right, the BPM value is indicated. If a valid BPM value was found, it is displayed in
green. 
If the metronome clicks in time with the music, the measure start is correct. If not, you can correct the
tempo manually. 
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Setting the manual and and Onbeat/Offbeat 
If the result is incorrect, you can help the Auto Remix Assistant with a few mouse clicks on the correction
buttons. 
There are two possibilities: 
On the one hand, the "Tempo correction" list offers alternative BPM numbers which could also fit with
the music. The adjustable BPM values are detected automatically – the total BPM can therefore deviate
from song to song. 
For more difficult audio material, we recommend using the "Tapping input" mode. Either the "T" key must
be pressed or the "Tap tempo" button must be clicked with the mouse in time with the music. With
repeated tapping of the tempo correction button, one should keep an eye on the color in the BPM
display. In the "unlocked" condition (red), the tapping is not in time with the music. One should tap until
the "locked" condition is displayed. After a short time, you will hear if the result is correct via the
metronome. 
Subsequently, offbeat correction takes place as required. If the detected quarter note beats lie around the
length of an eighth note (transferred behind the real positions of the quarter note beats), one or more
alternatives can be selected from the onbeat/offbeat correction list. 
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Determining the start of a measure
 Next, the starting point of the measure is corrected. The beat at the start of the measure must always
agree with the high tone of the metronome and/or the red line in the wave-shaped display. 
Corrections can be made by tapping; If the start of the measure can be be heard, tap with the mouse or
press the "T" key. Alternatively, you can also select how many quarter notes the "one" is to be pushed to
back. 
If the starting marker was set briefly before the first beat of a measure, this correction is not necessary. 
Note
: With all corrections, the metronome and visualization react to the lines in the wave-shaped display only
after a short delay. 
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Applying BPM and beat detection
 Close the Remix Agent by clicking "Apply". MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe will
now move the photos at the detected beats so that they change in time with the music. 

Slideshow effects
 In the slideshow Effects menu you can recall the slideshow effects by clicking on "Slideshow
 effect settings". The dialog is almost identical to the Optimize photo dialog. 
The slideshow effects apply to the entire slideshow and are intended to regulate the color saturation in the
slideshow as a whole. 
You can find special TV screen size
 options for cropping the screen edge, since the image usually exceeds the screen size for a normal TV
set. 

General use
 Presets
: Try out the presets from the preset menu. 
Auto
: This button usually offers a good effects setting. Pick out a picture that is typical for this type of
distortion using the position slider, and then click "Automatic setting". The optimum cleaning setting will
be applied to the whole scene (or the entire slideshow when using as master effect). 
Temporarily deactivate all effects
: Switches off all the effects. This way, you can quickly compare the original with the edited version. 
OK
: The adjustments made to the settings will be applied. 
Cancel
: Closes the dialog, the settings will not be applied. 
Help
: Opens the program's help file. 
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Brightness/Contrast
 Brightness/Contrast: 
Use the faders to increase or reduce the brightness and contrast of the image. 
Selective brightness (gamma):
 "Gamma" sets the middle gray value transmitted from various color areas. In the presets menu you can
determine which color areas should be used. Using the fader you can also set the intensity of the
brightness or darkness. 
Color space correction (master effect):
 This option combats colors that are too strong and cannot be properly displayed on your TV. The color
saturation of the photos in question are "turned down" to the maximum level at which they can be
properly displayed. 

Color
 White balance:
 All light is not the same. Depending on whether it is sunlight or artificial light, this will have an effect on
color variation. The human brain is able to compensate for this variation: a white sheet of paper will still
look white under candlelight, even though it is in fact much more yellow than by daylight. 
In order to imitate filtering done by the brain, a camera must also analyze and correct the light. White
balance does the same thing to a picture that the brain does. Thus the camera is set to the so-called
"color temperature" of the surroundings. 
If you are not fortunate enough to possess a camera which performs this function automatically, then you
can apply white balance in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
An incorrect white balance can lead to an unnatural blue or red hue. 
Directions:
 To use the white balance, please click on the button to the right of the label "White balance" and then
select a point which represents white or a neutral gray to the "outside world". 
The color temperature will be corrected automatically. 
Tip:
 Cool color effects can be achieved by setting a different color as the "white" benchmark. There is
definitely room for experimentation! 
Remove redeye:
 Using this photo function you can remove unnatural redeye that is the result of using a flash. Click on the
eye symbol and then select the red pupils in the preview monitor using the mouse. 
Hint:
 For photo optimization we recommend you use MAGIX Photo Manager. The program is installed
automatically and can be used for quick previewing and easy management of pictures from your
database. It has tool for correcting redeye and setting auto color and white balance to control
discoloration in pictures. 
For more complex editing like photo panorama and photo filter effects a separate image processing
program MAGIX Xtreme Photo Designer is included. Users of the classic version can download the
latest software at any time for free. To load a photo into MAGIX Xtreme Photo Designer, select the
option "Edit photo" in the FX menu of the photo box. Read more about this in the MAGIX Xtreme
Photo Designer Help file. 
"Saturation"
: Using the "Saturation" slider you can increase or reduce the hue proportions in the image. A newly
developed algorithm is now used, which carries out color changes in relation to other parameters (for
example contrast settings), in order to get the most natural coloration possible. With just a little bit of
experimentation, you can achieve the most astounding results. Anything from turning summer snapshots
into autumn scenes or funky pop art is possible... 
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Hue:
 On the palette you can select a hue to color in the picture. 
Red/Green/Blue:
 The red/green/blue slider corrects the color proportion mix. 

Sharpness
 This fader allows you to regulate the level of image sharpness. 
The "fine tuning" option allows you to determine the level of focus for particular surfaces or borders. 
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TV image size (Slideshow master effects)
 This option ensures that the image size is adapted to fit the real television picture (anti-cropping).
Without adjustment the television might otherwise crop the image borders. 
The four image margins can be proportionally adjusted by means of the four input fields. Here it is
important to find the optimal balance between distortion, reduction, bar formation, and image cropping: 

 If the same value is entered for every margin, then the image size is reduced proportionally. In this
case no distortions will occur, but there will be bars along the edges.

 If different values are entered for the 4 fields, then the image size is reduced unproportionally.
This causes image distortion.

Apply TV screen size:
 On (for photos!): This option enables the input values for the four image borders to be applied to the
respective photos in reduced form. The result can immediately be viewed on the preview monitor. 
Fade in TV display area in the preview monitor:
 This option displays the image borders of the television as lines in the preview monitor.The four image
borders of the TV display area can be set by means of the 4 input fields. It is necessary to know the
actual size of the TV picture. To determine it proceed as follows: 
Determining the visible TV frame size
 To determine the picture properties of your television as well as optimal image size editor settings you
should perform a test run. 

1. Load the Visible TV picture.mvm film from the "My projects > visible TV picture" folder.
2. Play back the film and read the instructions on the video screen.
3. Copy the slideshow to CD or DVD.
4. Place the disc into your player and play back the film.Compare the TV picture to the picture

displayed on your video screen by MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
5. Determine the proportional value of the borders cropped by the television with the 4

measurement scales along the edges of the test picture.
6. Enter the values in the "Full TV size" editor.

The image size is now optimized to your TV picture. Depending on device settings and disc carrier type
the cropping values may vary slightly. 
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Create panorama pictures
 This function will turn your photos into a sensation. Add new life to your holiday memories and create
great panoramas with only a few clicks. You don't need to create only "proper" panoramas; let your
imagination run wild and put together anything you want to! You'll see your photos in a new light and
create stunning montages. 

Select pictures for panorama
 Load all necessary photos into the slideshow project as usual. The images that should make up the
panorama should be selected one after the other while holding down the "Shift" button. Select the entry
"Panorama photo" from the context menu "Effects 
> Video object effects". 

Invert image sequence for panorama image
 Sometimes photos are accidentally loaded in the wrong sequence or were created from left to right. If
you forgot to sort your photos correctly beforehand, then simply click "Invert sequence". 

Calculating the panorama image
 If you click "Create", the panorama image will be processed. Depending on the resolution and number of
original images included, this may take some time. The original photos are replaced in your slideshow
with the panorama image you've created, but the original files on the hard drive will remain intact. 
Hint:
 You can create a panorama image from a maximum of six images. Click on "More options" for more
information on the upgrade. 

Finished panorama (2 images)

 Finished panorama from 2 images 
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MAGIX Soundtrack Maker
 The MAGIX Soundtrack Maker gives your movie just the right mood! Music tracks corresponding to
the specified mood are generated automatically. Even mood changes are possible. 
You can open MAGIX Soundtrack Maker via the File
 menu. The work is split into 3 steps. 
Then close the dialog by clicking on "Apply". If you click on "Cancel" the dialog will be closed and all
changes will be discarded. 
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Choose music style

 First choose a music style. Clicking on "Buy more styles" will open the MAGIX Online Content Library
. Here you can buy more music styles for MAGIX Soundtrack Maker. 
The option "Apply only between start and end marker" lets you limit the length of the background music
you want to create. You can also set the start and end markers 
with the left and right mouse key if MAGIX Soundtrack Maker is open. 
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Set mood change

 Select a mood from the list. 
Preview:
 Here you can preview your selected emotion. 
Position:
 With the position slider you can move to a certain position to set the emotions at a certain position.
Instead, you can also move the start marker with the left mouse button. The preview will be displayed in
the video monitor. 
Add emotion:
 This button inserts the emotion at the current position. MAGIX Soundtrack Maker will then suggest a
new position for the next emotion by repositioning the position slider. Of course you can also put it
elsewhere and insert further moods. 
Delete emotion: 
Deletes the current emotion. 
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Generate background music

 One click on "Create soundtrack" creates a new soundtrack. "Progress" shows the current status. 
Variations
 If you don't like the background music that was created, then you can create variations. You can do this
for the entire background music as well as for individual emotions. 

 If you want to vary the entire background music, then simply click "Create variations".
 If you only want this to apply to a certain emotion, then you should first go to it with the position

slider in the dialog (or the start marker on the main acreen). Then activate the option "Vary only
selected emotions" and click on "Create variations".
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Options for using the final
movie
In this chapter
Export
Export audio/video
Burn disc
Create PC show
Create webDVD
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Export
 You can export your slideshow in various video formats; the format entries can be found in the "File"
menu under "Export". The options available vary according to the selected format. 
Note: Burning a disc takes place on the "Burn" screen. Read more on this in the chapter "Burning a disc
". 
Presets
: These are the typical settings for the selected format and the most important applications. 

You can save your settings by pressing the "Save"
button and remove them by pressing "Delete". 

Export settings
: You can set up the general export parameters like resolution, page proportions, and frame rate in the
dialogs. Select the most-used values from the list field; to set your own values click the "..." button. The
"Advanced" button opens the specific settings for the selected video format. "File" lets you to export your
file to a different folder than that specified in the preset. "Overwrite file automatically" performs multiple
exports using the same file. 
Other
: "Other" provides the option to switch off your computer automatically after long encoding processes
and to limit the export to the selected area (start to end marker). 
In this section
Video as AVI
Video as MPEG video
MAGIX video export
Video als Quicktime Movie
Windows Media Export
Real Media Export
Video as MPEG-4 video
Animated GIF
Single frame as BMP
Single frame as JPG
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Video as AVI
 When exporting to AVI video, you can set and configure the size and frame rate of the AVI video and
the compression codec for audio (audio compression) and video (codec
). 
Please also note the general info on AVI videos
! 
Keyboard shortcut: Alt + A 
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Video as MPEG video
 MPEG is short for "Motion Picture Experts Group" and is a very powerful compression format for audio
and video files. 
MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe is equipped with the high performance Ligos
GoMotion encoder. In the MPEG export dialog you can fine tune the options for the MPEG encoder.
MPEG files are created when you burn a CD/DVD. Usually standardized MPEG-1/-2 is used for
creating (S)VCDs or DVDs. However, many DVD players can also process (S)VCDs with
non-standard bit rates, so there is room for experimenting here. 
Simply export your movie to MPEG via the File menu. When burning the disc the program recognizes
that the file is already available and uses this instead. 
Details on the MPEG encoder settings can be found in the MPEG Encoder help
! 
Shortcut MPEG-2 (DVD) Alt + H 

MPEG-2 (miniDVD) Alt + I 
MPEG-2(Super Video CD) Alt + J 
MPEG-1 (Video CD) Alt + K 

MAGIX video export
 Exports the movie in MAGIX video format. This format is used for video recording by MAGIX video
software and is optimized for digitally edited high-quality video material. 
Keyboard shortcut: Alt + D 
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Video als Quicktime Movie
 Exports the movie in QuickTime movie format. This enables streaming playback of audio and video files
over the Internet. 
As with RealMedia export, appropriate adjustments can also be made for video site, frame rate, and
codec settings. However, the export dialog does not permit you to add commentary to the video. 
For QuickTime files (*.mov) you have to install the QuickTime library. 
Keyboard shortcut: Ctrl + E 
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Windows Media Export
 Exports the arrangement in Window Media format. This audio/video format is optimized for the
Internet. 
You can also use it to archive your movies in high-quality when compared to MPEG-sized files.
Windows Media is an alternative if you would like to view your movies primarily on your PC. Pocket PC
and Smartphone movies are also created with the Windows Media Format. 
Depending on your requirements you can choose between different profiles. If the Windows Media
Encoder 9 is installed (which can be downloaded free of charge from Microsoft) you can edit the profiles
or add your own. 
Two pass:
 The video is compressed in 2 stages in order to export highly-compressed videos for the Internet
optimally. 
Slideshow:
 Lets you create slideshows with audio soundtracks. The created files are very small despite their high
image quality, since only still images (no transitions or movement effects) are displayed. 
In the dialog you can add the author name, copyright details, and a description. 
Keyboard shortcut: Alt+F 

Advanced settings
 Here you'll find more on the advanced settings in the Windows Media Video Export section. You can
enter precise details for the format you wish to create. Profiles from the system or from another file can
also be imported. 
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Real Media Export 
Exports the arrangement in RM format. 
RealMedia enables streaming playback of video files via the Internet. This has a very high compression
rate, but the quality is noticeably reduced. After choosing a name for your file you can specify the bit rate
of the transmission speed (modem, ISDN, etc.) at which the audio file can be played without errors. 
There are many embedding options for meta information for this format. 
Audio settings/Video settings: Here you can select the presets for the quality of the audio or video
material.
 An additional dialog is opened via the "Advanced" button. In advanced video options you can select the
frame rate per second (fps). The lower the rate, the less data will be transferred and the poorer the
quality of the picture will be. 
Clip information: 
Enter the author, video name, etc. to appear in the RealPlayer during playback. 
Clip meta information: 
Enter keywords for search engines. If the RealVideo clip is loaded onto a homepage, then search engines
will find it. However, these search engine tags can be deactivated. 
Video preprocessing:
 The "2-pass encoding" field is of special interest, since you can improve the quality (audio and video files
are compressed separately). Furthermore, you can select various filters. 
Video size:
 Set up video sizes between 160x120 and 720x576 pixels. 
Profile: 
Select the bandwidth for the video, i.e. over which data connection it will be played in real time
("streamed"). The settings selected may limit the other selections as files for 28k modems cannot be
created at high quality. Streaming videos require a server application that must be installed on the server
for the video to be played ("streamed") in real time. If you don't have this application it has to be
downloaded. "RealServer" is a server application that enables streaming video in RealVideo format. 
Key: Alt + G 
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Video as MPEG-4 video
 Hint:
 In order to use the MPEG-4 video export feature, you will have to activate this function first. 
MPEG-4 is the most advanced video format available at the moment. Unlike others, it can provide
high-quality pictures at the same file size. 
Behind MPEG-4, you'll find a highly complex "academic" standard that operates and is supported
variably according to make. To go into detail on these differences and parameters would be beyond the
scope of this documentation. For this reason, indications, along with the operational manual of your
device, are given that should help create executable MPEG-4 files. For more experimental users, the
complete setup options of the MPEG-4 codec can be found behind the "Advanced settings..." buttons. 
Video/Audio: 
The MPEG-4 format and the advanced AVC format are also available but have, as of yet, only been
used in a few devices. MPEG4 video can be combined with AAC or AMR sound, the latter mostly in
conjunction with mobile phones. The combination ACC/AAC doesn't appear very often (Apple iPod
Video), ACC with AMR in contrast, not at all. 
Multiplexer: Here you can find teh so-called container formats and special options for Apple iPod and
Sony PSP. MPEG-4 is usually used as an output format
, mobile phones mostly use 3GPP. 
Keyboard shortcut: Alt + K 
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Animated GIF
 The video will be exported as an animated GIF file (also called "AniGIF). This file format is supported
by many mobile phones. 
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Single frame as BMP
 Exports the image at the position of the start marker and displayed on the video screen as a BMP file. 
Keyboard shortcut: Alt + M 
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Single frame as JPG
 Exports the picture located at the current start marker and displayed in the video monitor as a JPG file. 
Keyboard shortcut: Alt + N 
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Export audio/video

 This window lets you transfer your finished video to external devices. Besides the camcorder options for
digital camcorders (DV/HDV) and VHS recorders for playing analog video, many options for further
players such as mobile video players, SmartPhones, PDAs or games consoles are also included. These
are explained in the section "Exporting to mobile devices
". 
In this chapter
Video playback via TV output
Playing videos on digital devices
Export to mobile devices
Transfer with Bluetooth
Transfer via infrared
My device is not in the list, what should I do?

Video playback via TV output
 Video or graphics cards with TV outputs allow you to transfer videos directly to external analog video
recorders. The arrangement must be displayed in fullscreen mode and recorded by the external device.
Make sure that the TV output in the Windows Control Panel (in "Display") is active. 
Warning: For many graphic cards, the TV output can only be activated when a television or video
recorder is connected before
 turning on the computer! 
For the best video monitor quality via TV output, select "Overlay" mode. When in doubt, make sure that
"Overlay" mode is selected as the video mode in the program settings ("File -> Program settings ->
Display options"). 
You can play the video directly from the arrangement. Errors may result if the processor is overloaded by
real-time calculations of video effects and transitions. 
If direct playback doesn't work without errors, open the menu item "Output video" and select "VCR ->
Render and output in fullscreen". All tracks and effects are then combined as a single file. The file will be
played back after this analysis. 
If you would like to play a finished movie several times, export it as an AVI
 file and reload it into a new movie! It should then be possible to play the file directly without constant
rendering. 
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Video playback via TV output
 Video or graphics cards with TV outputs allow you to transfer videos directly to external analog video
recorders. The arrangement must be displayed in fullscreen mode and recorded by the external device.
Make sure that the TV output in the Windows Control Panel (in "Display") is active. 
Warning: For many graphic cards, the TV output can only be activated when a television or video
recorder is connected before
 turning on the computer! 
For the best video monitor quality via TV output, select "Overlay" mode. When in doubt, make sure that
"Overlay" mode is selected as the video mode in the program settings ("File -> Program settings ->
Display options"). 
You can play the video directly from the arrangement. Errors may result if the processor is overloaded by
real-time calculations of video effects and transitions. 
If direct playback doesn't work without errors, open the menu item "Output video" and select "VCR ->
Render and output in fullscreen". All tracks and effects are then combined as a single file. The file will be
played back after this analysis. 
If you would like to play a finished movie several times, export it as an AVI
 file and reload it into a new movie! It should then be possible to play the file directly without constant
rendering. 
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Playing videos on digital devices
 The digital output always consists of two processes: 

1. Exporting, i.e. compiling all tracks, video, music, effects, transitions, and titles into one single
video file. This video file is created in the format required by the target device and then
temporarily saved to your computer's hard disk.

2. Output: In this case the created video file is transferred to the mobile device or to the camera.
The data is either written to the device via FireWire as a removable device if connected to the
USB port or transferred by Bluetooth or infrared.

Both processes are normally performed together. However, you can only export vie "File -> Export
movie" or export via the option "Output file" in the dialog "Output audio/video
". 
The Settings button opens the "Export" dialog 
of the file format for your selected device. 
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Export to mobile devices
 Most devices require certain format settings (file format, resolution, bit rate, picture repeat rate, etc.) to
be able to play a video. 
The menu is divided into various device classes (mobile phones, organizers and PDAs, games consoles,
and video players) to make it easier to select your device. The last three selections are saved as favorites
in the top part of the device list if you have more than one device or want to present your movies to your
friends. 
If your device is listed here, you won't have to worry about the format settings, because the necessary
settings of the export dialog
 are automatically customized to the target device. Simply select your device, and then click the "OK"
button - that's all. 
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Transfer with Bluetooth
 Warning! The procedure described here refers to Windows XP with Service Pack 2! 
Dialogs may be different depending on the Bluetooth driver and operating system version, or their order
may vary (e.g. for password allocation) when transferring to your mobile phone. However, the process is
usually similar if other drivers are used. Read more on this in the help file or the corresponding chapters
of your operating system's manual and Bluetooth adapter. 

 If you own a Bluetooth device, you can export the movie straight to your device. To do so, your
device and your PC must both have Bluetooth interfaces. If your system has a Bluetooth device,
you can activate the "Transfer via Bluetooth" option.

 After converting the movie into the desired format, the Bluetooth file transfer assistant opens.
 The first time you try to transfer files to your device via Bluetooth, you have to specify your

device as the receiver in the dialog by clicking on "Search...", selecting your device and then
pressing "OK". The name of your device in the Bluetooth network is specified in the Bluetooth
settings of the device. Check your device manual for this. Select your device and confirm your
choice by pressing "OK".

 Now enter a password of your choice, which you will later have to confirm on your device and
click on the "Continue" button in the assistant. Since connections between multiple Bluetooth
devices can be set up simultaneously in a room, the password serves to identify certain
connections as well as to safeguard your data.

The order may be the other way around, depending on the Bluetooth device driver, i.e. the mobile phone
will request a password which must be confirmed on your PC. It's important that you use the same
password in each case. 

 You may be asked once again to enter the file name and path of the movie. In this case, we
recommend using a folder that you will be able to find again quickly to export the file (e.g. "...My
Files/My Videos").

 Click the "Scan..." button, open the set up folder, and select your video file by double clicking it.
Now, in the wizard, click the "Continue" button.

 Next, you may have to activate the reception of files on the device and re-enter the password.
Afterwards, the transfer of the videos will begin automatically.

 Once the transfer has been completed successfully, "1 new message" will display on your device.
Read more on how to save and play videos in the corresponding device manual.

Warning!
 We only recommend activating data reception via Bluetooth on your device once this function is actually
required, e.g. for transferring files. Once you have completed the uploading process, you should
deactivate Bluetooth again, since permanently activated Bluetooth reception constitutes a security risk! 
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Transfer via infrared
 For devices with infrared interfaces, the transmission of movies works similarly to using the Bluetooth
transfer method. To do this, your PC and your device have to have infrared interfaces. Many notebooks
are already fitted with such IrDA interfaces. 

 Before starting the export, an infrared connection must already be established between the
computer and the device. Activate the infrared interface on your device and establish the
connection to your computer. You can check if a connection has been established via a
corresponding symbol in the task bar. More information on this can be found in the Windows
help under the keyword "Wireless connection".

 Note: Some devices deactivate the infrared interface when no data is exchanged after a
certain amount of time. In this case, you can search for the exported movie in the Media
Pool again, reactivate the infrared interface of your device, open the context menu of the
file, and then send the video to your device again by clicking "Transfer".

 Open the "Export" dialog via the export button, and under "Play after export", select the option
"Export with infrared". Confirm with "OK". A window will now be displayed which informs you
of the current status of the transmission.

 Once the transfer has been completed successfully, "1 new message" will display on your device.
Read more on how to save and play videos in the corresponding device manual.
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My device is not in the list, what should I do?
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Update devices online
 The assortment of playback devices is constantly changing. Every day, new devices or versions are
coming onto the market. The list of supported devices may therefore not be up-to-date and may not (yet)
contain your specific device. MAGIX continuously maintains updated preset lists for the available
devices, and these can be downloaded by pressing the update button. Internet access is necessary. 
The command "Download presets for new device" in the "Help" menu opens a website containing an
up-to-date list of all supported devices and device versions. Just search for the desired device and click
the corresponding link. The settings for the device will be downloaded and made available to you in
MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
Warning
: Some browsers display a warning if you try to download an executable file (.exe). You can ignore this
warning. 
If your device is not listed on the website, you can report your unsupported device so that it will be
included in later updates. 
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User-defined:
 If your device does not appear in the list after the online update, you can set up the export settings
manually. No need to worry though; you only have to do it once, since these settings can be saved as a
preset. 
Read the instruction manual of your mobile device
 to find out which file format is required for this. If your device supports multiple formats, then you can
experiment with the formats to get the best results. 
Specify the file format by opening the target device's menu and selecting "User-defined -> Video ->
...Format". If you then click on "Export", you arrive at the Export dialog
 of the selected file format where you can set all the advanced settings. 
For details on these settings, please consult your device manual. Explanations for the file format's
settings can be found in the Overview of the device classes chapter, for the special settings of the
export dialogs see "Export movie
" in the "File menu" chapter. 
Tip:
 If the format settings for your device are not accessible, then you can try out a different device from the
same manufacturer and, using it as a template, make adjustments accordingly. 

If you find settings you like, we recommend saving these as a
preset for further use. 

Overview of the device classes
 This chapter explains the various supported device classes and which peculiarities should be noted when
manually setting the export format. 

Quick overview of the device types*

Sample devices MPEG-4 profile (audio + video formats
within MPEG-4 container format)

iPod & PSP AVC (Video) + AAC (Audio) 
Mobile phones 3GP (Video) + AMR or AAC (Audio) 

Further video formats
Symbian mobile
phones 

Real / MPEG4 

Video player DivX / XviD 
PDAs,
PocketPCs 

WMV9 

*No guarantee taken for correctness of information 
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Overview of the device classes
 This chapter explains the various supported device classes and which peculiarities should be noted when
manually setting the export format. 

Quick overview of the device types*

Sample devices MPEG-4 profile (audio + video formats
within MPEG-4 container format)

iPod & PSP AVC (Video) + AAC (Audio) 
Mobile phones 3GP (Video) + AMR or AAC (Audio) 

Further video formats
Symbian mobile
phones 

Real / MPEG4 

Video player DivX / XviD 
PDAs,
PocketPCs 

WMV9 

*No guarantee taken for correctness of information 
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Mobile phones
 This refers to multimedia mobile phones and SmartPhones. 
File format:
 For SmartPhones running the Symbian operating system, you should ideally use the Real format for
maximum compatibility, since RealPlayer is integrated into the system. Many mobile phones also play
MPEG-4. It's important in this case that the correct container format (for mobile phones, usually 3GPP)
is set up ("Video as MPEG-4 video export") 
Resolution
: The resolution corresponds to the display size of your mobile phone in pixels. Standard resolutions are
128 x 96 pixels (sub QCIF), 176 x 144 pixels (QCIF), 300 x 180 pixels, and 320 x 240 pixels
(SmartPhones). You can find out the resolution of your mobile phone from its documentation. Many
mobile phones require the precise setting in order to play back videos. If the aspect ratio does not
correspond to the display resolution (300 x 180 corresponds to 5:3 instead of 4:3), then black bars are
added. For broad displays (optimized for 16:9) we recommend the video effects Aspect ratio 16:9
(anamorph/letterbox). 
Frame rate
: Picture repeat rate, i. e. the number of frames per second (fps). For mobile phones this is usually
reduced from 25fps to around 10 or 15fps in order to save memory space and because mobile phone
processors are not powerful enough. If you don't have to save on memory, select the largest frame rate
possible (see device manual) because at low frame rates the video can be very jerky. 
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Organizers and PDAs
 Under "Organizers and PDAs", Pocket PCs and similar devices are listed. 
File format
: For Pocket PCs, you should ideally use Windows Media Video format for maximum compatibility,
since it usually only runs on modified Windows Operating Systems (Windows Mobile), and the Windows
Media Player is integrated in the operating system. 
Resolution: The resolution corresponds to the display size of the PDA, mostly 320 x 240 pixels. You
can find out the resolution of your PDA from its documentation. A PDA can also play back at higher
resolutions than those set; mostly, however, the CPU
 is usually not able to handle this as it must scale the picture before output, which can cause errors. 
Frame rate
: Picture repeat rate, i. e. the number of frames per second (fps). If you don't have to save on memory,
use the largest frame rate possible (see device manual) because at low frame rates the video can be very
jerky. 
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Games consoles
 Some portable games consoles (Sony PSP, Nintendo Wii) can also play videos. The consoles are
extremely particular with regard to file format settings, and they sometimes use their own file format
variations. 
Warning
: Do not change the presets! 
MAGIX tries to supply presets for all games consoles with video functions on the market, but you may
have to update your device list. 
Warning
: Sony PSP and Apple iPod video only play movies when they are copied with a specific name into a
pre-defined target folder. Always copy movies for these devices from the export dialog along with the
corresponding presets (at the top of the "Preset" list and at the bottom beside "Play after export"). 
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Video players
 Video players are considered to be video devices if they have been developed especially for mobile
video playback. They usually have relatively large displays and their own hard disk or a very large flash
card memory (in GB). 
File format: Mostly DivX AVI or WMV (Windows Media Video) are used. While WMV is its own
format, AVI is a so-called container format. This means that the actual file format is set via the medium's 
codec
. 
In addition to the AVI format, you will also have to set up a codec that your mobile device supports
when exporting AVI files. 
A much-used codec for AVI is the DivX codec. This is supported by a large number of portable video
players. Specific standards have been set up between the codec manufacturer DivX and the device
manufacturers (profiles) that a certified DivX device has to fulfill. 
Unlike Windows Media or MPEG4, a separate audio codec (ACM codec) is required for the sound in
order to encode the sound track in the same high compression at acceptable quality. Select the codec
you wish to use for the sound under Audio compression. MP3
 56kBps is used as a preset. For improved sound quality, you should read your device manual to find out
which sound formats AVI audio still supports and, if required, install further ACM codecs from the
Internet. 
The DivX codec can be downloaded from www.divx.com.
 Resolution
: Video players can handle almost every resolution up to TV resolution (720x576), as most models can
display your video picture in TV resolution via an analog TV output. For the optimum picture quality on
the device display (if you do not wish to use the TV output) use the resolution that the device can
display. 
Frame rate
: Picture repeat rate, i. e. the number of frames per second (fps). This isn't problematic, since the frame
rate of the output material is used. 
Warning
: Sony PSP and Apple iPod video only play movies when they are copied with a specific name into a
pre-defined target folder. Always copy movies for these devices from the export dialog along with the
corresponding presets (at the top of the "Preset" list and at the bottom beside "Play after export"). 
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Burn disc
 Click "Burn" to open the screen where you create DVDs, Blu-ray Discs, or another video medium,
including a menu. 
In this section
Burn in 16:9 format
Burning wizard
Burn as a DVD, Mini-HD DVD, SVCD, VCD, Mini DVD or Blu-ray Disc.
Burn WMV HD
Burn JPEG disc
OnDisc Editing
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Burn in 16:9 format
 Using MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe you can, of course, burn your slideshows
in 16:9 format. 
To do this, please proceed as follows: 

1. Switch to the "Slideshow" screen.
2. Select "File > Disc project > Settings" (shortcut: E) to open the corresponding dialog. 
3. Activate both functions here.
4. Click on "OK" to save the settings for the total disc project which is currently open.
5. You can now take your time to see how the desired slideshow looks.
6. Return to the "Burn" interface.

Burning wizard
Click this button to open the burning wizard. 

Here you can select what kind of disc you would like to create. Under "Additional options" you will find
other disc formats that are used more seldom. 
Note: For each disc format there are different limitations. For example, with many formats animated
menus are not possible or no menus and transitions at all are possible. You can find an overview of these
limitations in the PDF manual or in "Help" under "Appendix: Digital videos and storage media". 
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Burning wizard
Click this button to open the burning wizard. 

Here you can select what kind of disc you would like to create. Under "Additional options" you will find
other disc formats that are used more seldom. 
Note: For each disc format there are different limitations. For example, with many formats animated
menus are not possible or no menus and transitions at all are possible. You can find an overview of these
limitations in the PDF manual or in "Help" under "Appendix: Digital videos and storage media". 
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Burn as a DVD, Mini-HD DVD, SVCD, VCD, Mini DVD or
Blu-ray Disc.
 During the burning process the picture files are converted into video files. 
Here you can select your burner, the type of disc, and the ecoder settings. For video CDs it is MPEG-1,
for Mini DVDs, Super Video CDs, and DVDs, please use MPEG-2. Mini-HD DVD and Blu-ray Disc
uses MPEG-2, and higher bit rates are employed in order to reach the higher HD resolutions. 
Hint:
 No menu will be burned to a Blu-ray disc. All slideshows will be played back one after the other. 

Creating an ISO image
 The simplest way to create an ISO image is to select "Image
 recorder" under "Burner". When starting the "Burning process", you have to specify a name for the image
file you wish to create. 

1. Set up burner and burn speed: If you have multiple burners installed, you can select which
device you wish to use in this menu.

2. Encoder settings: Use the "Encoder" button to access the selection dialog where you can
specify the properties of the MPEG Encoder (memory requirements, quality and duration of the
MPEG conversion). 

2. The "Advanced" button opens the "Advanced settings" dialog. Here you can adjust all the fine
settings of the MPEG encoder. 

3. Burning disc/starting video encoding: "Burn disc" starts the disc burning process. Every
time you burn and every time a simulation is carried out, the disc project is encoded (for VCDs
with MPEG-1, with SVCD, DVD and mini-DVD with MPEG-2). You have the option of
choosing a storage location for the MPEG file on the hard disk. Please note that the MPEG file is
not deleted from the hard disk after the burn process has finished. Depending on the length of the
project, encoding and burning may take some time. The time required can be seen in the dialog.

 Burn options
 Simulate first
: If you are not sure about the write speed or memory requirements of the selected disc, you can simulate
the write process before burning. 
Add project backup
: Use this option to add additional project data to the CD/DVD together with the selected video format.
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You can then load the project from the finished disc to re-edit it and create a different version. 
Activate buffer underrun protection
: Lots of burner support techniques that prevent the much-feared "buffer underrun". Use this option to
activate this protective feature and burn your files at higher speeds without risking making a coaster out of
your blank disc. 
Completely format DVD/CD-RW media
: This option reformats the RW media and deletes all existing file material. 
Prepare disc for On-Disc Editing: With a DVD±RWs it is possible to add more slideshows to the disc,
or to edit the menu at a later date. The disc has to be burned with the option "Prepare disc for OnDisc
Editing" activated. 
Shutdown computer after burning: Activate this option to automatically turn off the computer after
encoding and burning has been completed.
You could, for instance, start the encoding and burning process in the evening, and then you don't have to
wait for the process to finish to switch off your computer. 

Encoder settings
 Use the "Encoder" button to access the selection dialog to specify the properties of the MPEG encoder
(memory requirements, quality, and duration of the MPEG conversion). 
Preset: 
Here you will find additional settings for the selected disc type. 
Longplay DVD DVD with extra-long play time. The bit rate is

reduced (this compromises quality). 
Standard PAL Normal DVD 
Standard PAL 16:9 Normal DVD in 16:9 widescreen format 
Bit rate
: The bit rate determines the memory requirements of the completed video. The greater the bit rate, the
larger the file, and the shorter the maximum play time of the movie that fits on a disc. 
Adjust bit rate: 
The expected file size of the finished video is estimated, depending on the set bit rate. If the movie does
not fit onto the disc, then the bit rate is corrected accordingly. 
Quality: 
Determines the quality of the encoding process. The higher the quality, the better the finished video will
look; however, encoding will take considerably longer. 
Smart Rendering: With Smart Rendering you can considerably reduce the encoding processing strain
for MPEG files. During production of MPEG files only those parts of the movie that were changed in the
program (e.g. by video cleaning or effects) are re-encoded. The MPEG files contained in the movie must
have the same format, i.e. the bit rates (variable or constant), audio formats, image resolutions, and video
formats must
 match. 
Anti-flicker filter: 
This option should only be activated for playback on a TV screen, since it reduces line flickering. 
To return to the standard settings, please use the Reset 
button. 
The "Advanced" button opens the "Advanced settings" dialog. Here you can adjust all the fine settings of
the MPEG encoder. Please also read the Annexe MPEG Encoder Settings
. 

Memory
 Information on how much memory space each disc format requires and how this relates to the quality
can be found in "Appendix: Digital video and data storage". 
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Especially with the MPEG-2 encoder, which is used on SVCDs, DVDs and mini-DVDs (that is, on CD
ROMs written in DVD file format), it can be difficult to supply reliable information relating to the required
memory space. If the "Variable bit rate" of the MPEG-2 encoder is activated, encoding will occur
according to the movements in the picture. The required memory space is dependent on the film material,
therefore resulting in an action film needing more memory space than a period drama, for instance. A
slideshow needs less storage space than normal because hardly any movement is found there, except for
transitions, text, and photo effects. 
If you cannot save your disc project on a blank CD, you will have to divide it up into different sections. 

Test series for variable encoder settings
 If you would like to know how much memory space you require for various encoder settings, you should
run some simulations before burning. 
So you don't waste any blank CDs while testing, you should activate the "Simulate first" option. 
Then create, for example, a short (ca. 5 min.) disc project and simulate burning in multiple cycles with
various settings. 
After every simulation you can access the MPEG 1 or MPEG 2 file on the hard disk in the subdirectory
"My audio video" to check how large the resulting file is. 
From the results, you can extrapolate how much disc space your disc project will require. The memory
requirements of a 5-minute disc project would have to be multiplied by 20 in order to estimate the space
required for a 100-minute movie. 
Hint
: It's better to add some buffer time. 

Burn WMV HD
 WMV HD (Windows Media High Definition Disc) is a type of disc optimized for playback of
slideshows on PC. The slideshow(s) are converted in a high-resolution format into the Windows Media 9
format and a menu is added, like with DVDs. You must have Windows Media Player 9 or higher
installed on your PC. 
Video encoding will be preset for HDTV
 resolution (1280 x 720, also known as "720p"). To select different resolutions, click on the button
"Encoder settings" and in "Presets" choose the following: 

 Standard PAL (720x576) or NTSC (720 x 480)
 Standard PC resolutions (1024 x 768 or 1280 x 1024)
 HDTV 720p (1280x720) or 1080i (1920x1080)

 Burn JPEG disc
 The JPEG disc
 is a special case. No video file is created to be burned, but rather every photo in the disc project is
exported individually with effects and burned to CD or DVD. Many modern DVD players can play
JPEG files directly. 
If a project contains several slideshows, a subfolder will be created for each one, and the corresponding
images will be placed into each one.
This means that there are no menus, no sound, no animated effects or transitions – although it does offer
the best possible quality available for playback on TV. 

Page 242



Burn options
 Simulate first
: If you are not sure about the write speed or memory requirements of the selected disc, you can simulate
the write process before burning. 
Add project backup
: Use this option to add additional project data to the CD/DVD together with the selected video format.
You can then load the project from the finished disc to re-edit it and create a different version. 
Activate buffer underrun protection
: Lots of burner support techniques that prevent the much-feared "buffer underrun". Use this option to
activate this protective feature and burn your files at higher speeds without risking making a coaster out of
your blank disc. 
Completely format DVD/CD-RW media
: This option reformats the RW media and deletes all existing file material. 
Prepare disc for On-Disc Editing: With a DVD±RWs it is possible to add more slideshows to the disc,
or to edit the menu at a later date. The disc has to be burned with the option "Prepare disc for OnDisc
Editing" activated. 
Shutdown computer after burning: Activate this option to automatically turn off the computer after
encoding and burning has been completed.
You could, for instance, start the encoding and burning process in the evening, and then you don't have to
wait for the process to finish to switch off your computer. 

Encoder settings
 Use the "Encoder" button to access the selection dialog to specify the properties of the MPEG encoder
(memory requirements, quality, and duration of the MPEG conversion). 
Preset: 
Here you will find additional settings for the selected disc type. 
Longplay DVD DVD with extra-long play time. The bit rate is

reduced (this compromises quality). 
Standard PAL Normal DVD 
Standard PAL 16:9 Normal DVD in 16:9 widescreen format 
Bit rate
: The bit rate determines the memory requirements of the completed video. The greater the bit rate, the
larger the file, and the shorter the maximum play time of the movie that fits on a disc. 
Adjust bit rate: 
The expected file size of the finished video is estimated, depending on the set bit rate. If the movie does
not fit onto the disc, then the bit rate is corrected accordingly. 
Quality: 
Determines the quality of the encoding process. The higher the quality, the better the finished video will
look; however, encoding will take considerably longer. 
Smart Rendering: With Smart Rendering you can considerably reduce the encoding processing strain
for MPEG files. During production of MPEG files only those parts of the movie that were changed in the
program (e.g. by video cleaning or effects) are re-encoded. The MPEG files contained in the movie must
have the same format, i.e. the bit rates (variable or constant), audio formats, image resolutions, and video
formats must
 match. 
Anti-flicker filter: 
This option should only be activated for playback on a TV screen, since it reduces line flickering. 
To return to the standard settings, please use the Reset 
button. 
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The "Advanced" button opens the "Advanced settings" dialog. Here you can adjust all the fine settings of
the MPEG encoder. Please also read the Annexe MPEG Encoder Settings
. 

Memory
 Information on how much memory space each disc format requires and how this relates to the quality
can be found in "Appendix: Digital video and data storage". 
Especially with the MPEG-2 encoder, which is used on SVCDs, DVDs and mini-DVDs (that is, on CD
ROMs written in DVD file format), it can be difficult to supply reliable information relating to the required
memory space. If the "Variable bit rate" of the MPEG-2 encoder is activated, encoding will occur
according to the movements in the picture. The required memory space is dependent on the film material,
therefore resulting in an action film needing more memory space than a period drama, for instance. A
slideshow needs less storage space than normal because hardly any movement is found there, except for
transitions, text, and photo effects. 
If you cannot save your disc project on a blank CD, you will have to divide it up into different sections. 

Test series for variable encoder settings
 If you would like to know how much memory space you require for various encoder settings, you should
run some simulations before burning. 
So you don't waste any blank CDs while testing, you should activate the "Simulate first" option. 
Then create, for example, a short (ca. 5 min.) disc project and simulate burning in multiple cycles with
various settings. 
After every simulation you can access the MPEG 1 or MPEG 2 file on the hard disk in the subdirectory
"My audio video" to check how large the resulting file is. 
From the results, you can extrapolate how much disc space your disc project will require. The memory
requirements of a 5-minute disc project would have to be multiplied by 20 in order to estimate the space
required for a 100-minute movie. 
Hint
: It's better to add some buffer time. 

Burn WMV HD
 WMV HD (Windows Media High Definition Disc) is a type of disc optimized for playback of
slideshows on PC. The slideshow(s) are converted in a high-resolution format into the Windows Media 9
format and a menu is added, like with DVDs. You must have Windows Media Player 9 or higher
installed on your PC. 
Video encoding will be preset for HDTV
 resolution (1280 x 720, also known as "720p"). To select different resolutions, click on the button
"Encoder settings" and in "Presets" choose the following: 

 Standard PAL (720x576) or NTSC (720 x 480)
 Standard PC resolutions (1024 x 768 or 1280 x 1024)
 HDTV 720p (1280x720) or 1080i (1920x1080)

 Burn JPEG disc
 The JPEG disc
 is a special case. No video file is created to be burned, but rather every photo in the disc project is
exported individually with effects and burned to CD or DVD. Many modern DVD players can play
JPEG files directly. 
If a project contains several slideshows, a subfolder will be created for each one, and the corresponding
images will be placed into each one.
This means that there are no menus, no sound, no animated effects or transitions – although it does offer
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the best possible quality available for playback on TV. 
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Encoder settings
 Use the "Encoder" button to access the selection dialog to specify the properties of the MPEG encoder
(memory requirements, quality, and duration of the MPEG conversion). 
Preset: 
Here you will find additional settings for the selected disc type. 
Longplay DVD DVD with extra-long play time. The bit rate is

reduced (this compromises quality). 
Standard PAL Normal DVD 
Standard PAL 16:9 Normal DVD in 16:9 widescreen format 
Bit rate
: The bit rate determines the memory requirements of the completed video. The greater the bit rate, the
larger the file, and the shorter the maximum play time of the movie that fits on a disc. 
Adjust bit rate: 
The expected file size of the finished video is estimated, depending on the set bit rate. If the movie does
not fit onto the disc, then the bit rate is corrected accordingly. 
Quality: 
Determines the quality of the encoding process. The higher the quality, the better the finished video will
look; however, encoding will take considerably longer. 
Smart Rendering: With Smart Rendering you can considerably reduce the encoding processing strain
for MPEG files. During production of MPEG files only those parts of the movie that were changed in the
program (e.g. by video cleaning or effects) are re-encoded. The MPEG files contained in the movie must
have the same format, i.e. the bit rates (variable or constant), audio formats, image resolutions, and video
formats must
 match. 
Anti-flicker filter: 
This option should only be activated for playback on a TV screen, since it reduces line flickering. 
To return to the standard settings, please use the Reset 
button. 
The "Advanced" button opens the "Advanced settings" dialog. Here you can adjust all the fine settings of
the MPEG encoder. Please also read the Annexe MPEG Encoder Settings
. 

Memory
 Information on how much memory space each disc format requires and how this relates to the quality
can be found in "Appendix: Digital video and data storage". 
Especially with the MPEG-2 encoder, which is used on SVCDs, DVDs and mini-DVDs (that is, on CD
ROMs written in DVD file format), it can be difficult to supply reliable information relating to the required
memory space. If the "Variable bit rate" of the MPEG-2 encoder is activated, encoding will occur
according to the movements in the picture. The required memory space is dependent on the film material,
therefore resulting in an action film needing more memory space than a period drama, for instance. A
slideshow needs less storage space than normal because hardly any movement is found there, except for
transitions, text, and photo effects. 
If you cannot save your disc project on a blank CD, you will have to divide it up into different sections. 

Test series for variable encoder settings
 If you would like to know how much memory space you require for various encoder settings, you should
run some simulations before burning. 
So you don't waste any blank CDs while testing, you should activate the "Simulate first" option. 
Then create, for example, a short (ca. 5 min.) disc project and simulate burning in multiple cycles with
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various settings. 
After every simulation you can access the MPEG 1 or MPEG 2 file on the hard disk in the subdirectory
"My audio video" to check how large the resulting file is. 
From the results, you can extrapolate how much disc space your disc project will require. The memory
requirements of a 5-minute disc project would have to be multiplied by 20 in order to estimate the space
required for a 100-minute movie. 
Hint
: It's better to add some buffer time. 

Burn WMV HD
 WMV HD (Windows Media High Definition Disc) is a type of disc optimized for playback of
slideshows on PC. The slideshow(s) are converted in a high-resolution format into the Windows Media 9
format and a menu is added, like with DVDs. You must have Windows Media Player 9 or higher
installed on your PC. 
Video encoding will be preset for HDTV
 resolution (1280 x 720, also known as "720p"). To select different resolutions, click on the button
"Encoder settings" and in "Presets" choose the following: 

 Standard PAL (720x576) or NTSC (720 x 480)
 Standard PC resolutions (1024 x 768 or 1280 x 1024)
 HDTV 720p (1280x720) or 1080i (1920x1080)

 Burn JPEG disc
 The JPEG disc
 is a special case. No video file is created to be burned, but rather every photo in the disc project is
exported individually with effects and burned to CD or DVD. Many modern DVD players can play
JPEG files directly. 
If a project contains several slideshows, a subfolder will be created for each one, and the corresponding
images will be placed into each one.
This means that there are no menus, no sound, no animated effects or transitions – although it does offer
the best possible quality available for playback on TV. 
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Memory
 Information on how much memory space each disc format requires and how this relates to the quality
can be found in "Appendix: Digital video and data storage". 
Especially with the MPEG-2 encoder, which is used on SVCDs, DVDs and mini-DVDs (that is, on CD
ROMs written in DVD file format), it can be difficult to supply reliable information relating to the required
memory space. If the "Variable bit rate" of the MPEG-2 encoder is activated, encoding will occur
according to the movements in the picture. The required memory space is dependent on the film material,
therefore resulting in an action film needing more memory space than a period drama, for instance. A
slideshow needs less storage space than normal because hardly any movement is found there, except for
transitions, text, and photo effects. 
If you cannot save your disc project on a blank CD, you will have to divide it up into different sections. 

Test series for variable encoder settings
 If you would like to know how much memory space you require for various encoder settings, you should
run some simulations before burning. 
So you don't waste any blank CDs while testing, you should activate the "Simulate first" option. 
Then create, for example, a short (ca. 5 min.) disc project and simulate burning in multiple cycles with
various settings. 
After every simulation you can access the MPEG 1 or MPEG 2 file on the hard disk in the subdirectory
"My audio video" to check how large the resulting file is. 
From the results, you can extrapolate how much disc space your disc project will require. The memory
requirements of a 5-minute disc project would have to be multiplied by 20 in order to estimate the space
required for a 100-minute movie. 
Hint
: It's better to add some buffer time. 

Burn WMV HD
 WMV HD (Windows Media High Definition Disc) is a type of disc optimized for playback of
slideshows on PC. The slideshow(s) are converted in a high-resolution format into the Windows Media 9
format and a menu is added, like with DVDs. You must have Windows Media Player 9 or higher
installed on your PC. 
Video encoding will be preset for HDTV
 resolution (1280 x 720, also known as "720p"). To select different resolutions, click on the button
"Encoder settings" and in "Presets" choose the following: 

 Standard PAL (720x576) or NTSC (720 x 480)
 Standard PC resolutions (1024 x 768 or 1280 x 1024)
 HDTV 720p (1280x720) or 1080i (1920x1080)

 Burn JPEG disc
 The JPEG disc
 is a special case. No video file is created to be burned, but rather every photo in the disc project is
exported individually with effects and burned to CD or DVD. Many modern DVD players can play
JPEG files directly. 
If a project contains several slideshows, a subfolder will be created for each one, and the corresponding
images will be placed into each one.
This means that there are no menus, no sound, no animated effects or transitions – although it does offer
the best possible quality available for playback on TV. 
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Burn WMV HD
 WMV HD (Windows Media High Definition Disc) is a type of disc optimized for playback of
slideshows on PC. The slideshow(s) are converted in a high-resolution format into the Windows Media 9
format and a menu is added, like with DVDs. You must have Windows Media Player 9 or higher
installed on your PC. 
Video encoding will be preset for HDTV
 resolution (1280 x 720, also known as "720p"). To select different resolutions, click on the button
"Encoder settings" and in "Presets" choose the following: 

 Standard PAL (720x576) or NTSC (720 x 480)
 Standard PC resolutions (1024 x 768 or 1280 x 1024)
 HDTV 720p (1280x720) or 1080i (1920x1080)

 Burn JPEG disc
 The JPEG disc
 is a special case. No video file is created to be burned, but rather every photo in the disc project is
exported individually with effects and burned to CD or DVD. Many modern DVD players can play
JPEG files directly. 
If a project contains several slideshows, a subfolder will be created for each one, and the corresponding
images will be placed into each one.
This means that there are no menus, no sound, no animated effects or transitions – although it does offer
the best possible quality available for playback on TV. 
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Burn JPEG disc
 The JPEG disc
 is a special case. No video file is created to be burned, but rather every photo in the disc project is
exported individually with effects and burned to CD or DVD. Many modern DVD players can play
JPEG files directly. 
If a project contains several slideshows, a subfolder will be created for each one, and the corresponding
images will be placed into each one.
This means that there are no menus, no sound, no animated effects or transitions – although it does offer
the best possible quality available for playback on TV. 
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OnDisc Editing
 With OnDisc Editing you can burn more slideshows onto disc at a later stage and customize the menu
accordingly. It's also possible to just rework the menu. 
In order to use OnDisc Editing, the "Prepare disc for OnDisc Editing" option has to activated. You will
find this option in the "Burn disc" dialog
. 

To put a slideshow onto a DVD,
first load the slideshow and switch
to the "Burn" interface, insert the
DVD-/+RW and click this button. 

MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe will ask you if you wish to add the slideshows
loaded into the Edit Slideshow
 Monitor to the disc. If you answer "Yes", the entries will be added to the existing menu. 
It is not
 possible to retroactively edit already burned slideshows in Edit Slideshow Monitor. (For this, use the
Recover backup project function). You may only make changes to the menu. 
In addition to the standard options of menu design (see "Burn" interface), you can remove existing
slideshows from the menu in OnDisc Editing mode, in order to replace them by new reworked versions. 
Select a slideshow in the navigation
structure and press the Del key. To
re-insert the slideshow, press the
Shift + Del 
keys. 
Warning! 
Deleting certain parts of your DVD-/+RW is not possible. Every new version of the menu will be burned
additionally to the disc. 
Accordingly, the remaining disc space becomes less and less the more changes you make. If you remove
a movie from the menu, it will still be played, providing "Actions at the end of the movie" is set up
accordingly. To find out more see "Menu entries and preview images
". 
With "Burn disc" you can create your "new" disc. Here, only the new slideshows and the adjusted menu
will be encoded and burned to disc. 
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Create PC show
Click this button and a presentation optimized for your PC
will be created. 

First, enter a path where the PC show will be found again later, and click "OK". 
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Create webDVD
You can create an online presentation which can be
uploaded to MAGIX Online Album and opened there. To
do this, you must first register on MAGIX Online Album. 

First, create and save the online presentation on your computer, and then it can be uploaded. Indicate a
location to save the file. Usually the suggested folder does not need to be changed. 
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Online functions
In this chapter
Integrated browser
MAGIX Screenshare
MAGIX News Center
Send slideshow as email (deluxe version)
Online
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Integrated browser
 The integrated browser offers many useful functions that help you collect material for using in your
project. All kinds of media can be collected – images, videos, sound or simply text can be all integrated
using the built-in browser with great results. 
Tip: 
You must have an Internet connection to use the full range of options offered by the integrated browser. 

Open browser
The integrated browser opens in the Media
Pool (view "Media
") via "MAGIX Media -> Web import...". 

Navigation in the browser
One page back:
 Switches to the previous page. 
One page forward:
 Switches back to the page before the "One page back" button
was pressed. 
Stop:
 Stops loading the selected page. 
Reload:
 The current page will be reloaded. 
Home:
 Returns to the home page. 

In the address header, next to the navigation buttons, you can simply enter an Internet address like
http://www.magix.com. Press the enter button and the corresponding page will be loaded. 

Loading Internet media
 The buttons described here are used to collect and load media directly from the Internet into the current
film. The corresponding functions can be found in the context menu of the browser. 

Save selected text: The selected text will be saved. It can
then be edited using the Title editor
. 
Download selected images
: The selected images will be saved to your computer. 
Start audio recording
: A dialog for audio recording opens. 
Hint
: For recording from the Internet it is important that the
sound card is selected as the sound source. 
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Define the path for saving Internet media.
 To define the path for saving Internet media, simply click on the folder symbol and navigate to the
desired folder. Confirm your selection with OK. 

Accept media after download
 This option makes sure that the downloaded media are loaded into the current slideshow right away. 
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Navigation in the browser
One page back:
 Switches to the previous page. 
One page forward:
 Switches back to the page before the "One page back" button
was pressed. 
Stop:
 Stops loading the selected page. 
Reload:
 The current page will be reloaded. 
Home:
 Returns to the home page. 

In the address header, next to the navigation buttons, you can simply enter an Internet address like
http://www.magix.com. Press the enter button and the corresponding page will be loaded. 

Loading Internet media
 The buttons described here are used to collect and load media directly from the Internet into the current
film. The corresponding functions can be found in the context menu of the browser. 

Save selected text: The selected text will be saved. It can
then be edited using the Title editor
. 
Download selected images
: The selected images will be saved to your computer. 
Start audio recording
: A dialog for audio recording opens. 
Hint
: For recording from the Internet it is important that the
sound card is selected as the sound source. 

Define the path for saving Internet media.
 To define the path for saving Internet media, simply click on the folder symbol and navigate to the
desired folder. Confirm your selection with OK. 

Accept media after download
 This option makes sure that the downloaded media are loaded into the current slideshow right away. 
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Define the path for saving Internet media.
 To define the path for saving Internet media, simply click on the folder symbol and navigate to the
desired folder. Confirm your selection with OK. 

Accept media after download
 This option makes sure that the downloaded media are loaded into the current slideshow right away. 
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MAGIX Screenshare
 This function makes it possible for you to offer assistance to other users directly via the Internet, or to
get help from others. To do this you have to register MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe first. 
Hint:
 To inform the screensharing guests of exactly what is being shown, it is also a good idea to telephone or
chat simultaneously. 

Register as host for a screen transfer
1.  If you want to start a screenshare instance yourself, then you have to register as a host first. To

do this open the menu "Online" and then select "Screen transfer as host...".
2. In the dialog you can enter a name for the screen session. Your user account name is used here

by default.
3. Now click on "start session". A small window will now open in the bottom right corner which

displays the status of your screen session. A number will also be displayed (session ID) which
serves as a password for your guests. 

4. Start the screenshare instance.

 Register as guest of a screen session
1.  You have to register as a guest to view a screensharing instance. To do this open the menu

"Online" and then select "Screen transfer as guest...".
2. Enter the password you received from your host (8-digit session ID).
3. Now click on "start session". A window will open displaying a smaller version of your host's

screen.
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MAGIX News Center
MAGIX can supply you with all of the latest information about
your software. In the MAGIX News Center, you will find all of
the links to current online tutorials as well as tips & tricks on
individual topics or software application examples. 

You will also be informed of the availability of brand new updates and patches for your program as well
as special offers, contests, and surveys. 
The news is split into three color-coded sections: 

 Green for practical tips & tricks for your software
 Yellow reports the availability of new patches and updates for your product
 Red for special offers, contests, and surveys
 And if there are no new messages, then the button will be grey

All available information is shown as soon as you click on MAGIX News Center. If you click on one of
the news items you will be forwarded to the corresponding website. 
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Send slideshow as email (deluxe version)
 With this option selected in the File menu a compressed file in Windows™ Media Format will be
created. Your email program will be simultaneously activated and the file created will be added as an
attachment of a new message. Any slideshow can be compressed without intermediate steps and sent as
an email immediately. 
Shortcut: Shift + U 
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Online
 MAGIX Online World offers a wide range of online services for digital photography, video, music,
media backup/security, and connecting desktop PCs with mobile handsets and the web. 
For more information, please go to the menu Online > MAGIX Online World overview or surf to the
MAGIX Online World website. 
In this section:
MAGIX Online Album
MAGIX Online Print Service
MAGIX Community
Catooh – the Online Content Library
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MAGIX Online Album
 Impress your friends and family in minutes with your own photos and videos as your own your personal
photo & video website: http://first_name.last_name.magix.net. 
MAGIX Online Album lets you put your favorite photos online directly from within MAGIX products
like MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, or mobile phones with built-in cameras, and
then send a link to them to your friends via email. All photos are immediately available from anywhere in
the world on a professionally-designed photo website, in well-organized photo galleries, as full-screen
slideshows, or in the form of a personal photo e-card. 

 Personalized album website in many designs,
 unique Internet address (URL),
 upload your pictures directly from a camera phone, send the link, and share the picture with other

camera phone users,
 full-screen online slideshows with fade effects and music,
 send individual designer e-cards with your own photos,
 Share your photos with friends, incl. Internet management and password access to private

albums
MAGIX Online Album is available in three versions, the smallest of which (the FREE album  with 500
MB webspace for your photos) is entirely free. 
The larger versions (CLASSIC or PREMIUM) are available for a monthly charge, but also come with
many handy features, such as a faster website, 2 MB or 5 GB storage space, more website designs or
access by mobile phone/PDA. More information about prices and features is available at 
http://www.magix-photos.com
. 
Upload images from slideshows

1.  Select still image and place the start marker at the position of the image which you want to
upload from your slideshow.

2. Then, select "Online -> MAGIX Online Album -> Load image from slideshows" in the menu. 
In order to upload photos to your MAGIX Online Album, simply log in using your email address.
Naturally, access is protected via your personal password. If you still don't have a password, click on 
"Register now"
. 
Using your MAGIX Online Media Manager
, you can quickly manage your photo website, upload photos and music, create new albums, add designs
and text, and much more. 
Using "Upload movie as video"
 you can present your slideshow with fades, music, and all other effects as a playable video in the
Internet. 

1. Design your slideshow.
2. Save your movies, and then under "MAGIX Online Album" select "Online -> Upload slideshow

as video". 
Now, you just have to follow the instructions on the screen to finish the upload process. 
Upload slideshow as audio: 
With this option, you can present only the audio of your slideshow in your online album. 

1. Design your slideshow.
2. Save your movies, and then under "MAGIX Online Album" select "Online -> Upload audio from

slideshow". 
Now, you just have to follow the instructions on the screen to finish the upload process. 
The following options are also available: 
Send e-cards and photo emails 
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Send your photos as unique ecards with great designs or as a photo email to your friends and family. 
Order photo prints and gifts 
Order paper prints or great photo gifts from MAGIX Online Album and have them delivered directly to
your home, or pick them up from a photo lab in your area. 
Delivery time is usually just 2 - 3 days. 
Mehr zum MAGIX Online Print Service
 You can also read the FAQ (frequently asked questions) on the Internet.
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MAGIX Online Print Service
 MAGIX Online Print Service lets you order paper prints and photo gifts (t-shirts, mugs, etc.) directly
from within MAGIX programs such as MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe or via
www.magix.com. Upload your photos with a click and have the developed photos delivered to your
home within days. 

Order photo prints and gifts
 Order real paper prints or great photo gifts straight from your MAGIX Online Album and have them
delivered directly to your home or pick them up (no shipping costs) from your nearest photo developer. 
Delivery usually takes 2 - 3 days. 
More about MAGIX Online Print Service

  Order your valuable digital photos in impressive quality on premium photo paper from a digital
photo printing specialist 

 Brilliant prints on premium photo paper in all formats
 Impressive picture quality; true-to-color for up to 100 years
 Huge selection of great photo gifts (t-shirts, mugs, calendars, and much more)
 Includes MAGIX Photo Manager for conveniently ordering your photos
 Real prints and great photo gifts of your digital pictures – it's that easy

1. Select photos
 Take your time and select your favorite photos from the program and optimize them for best results.
Remove redeye, enhance colors and contrast, and much more. All offline and on your PC! 
Then simply select MAGIX Online Print Service from the "Online" menu and "Send selected". 

2. Select format and quantity
 Now select the desired number and the image format (e.g. 10x15) or photo gift (mug, t-shirt). Do you
have a voucher? Then click on "Use voucher" and enter your voucher code. 

3. Specify zoom
 One great option is the crop function for your prints. To use it click on the button "Edit photo". Here you
can set the format (small 2:3 or digital 3:4) you would like for your photos. 
You can see how your photo prints will look in the preview window. Using the selection frame you can
crop your photos individually. 

4. Submit order
 Once you have made all your settings click on the "Submit order" button. Now all you have to do is
enter your details and the type of delivery. Your order will now be dispatched online. 
You will now receive an order confirmation by email including a link where you can find up-to-date
information about your order anytime. 
Delivery straight to your doorstep
 Have your prints and photo gifts conveniently delivered straight to your doorstep or pick them up from a
photo retailer close to you to save postage. Orders usually take 2-3 days. 
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MAGIX Community
 MAGIX Community is the place to exchange photos, videos, and music with friends and the world. As
soon as you have registered for free, you can use all of its great features. 
You can also read the FAQ (frequently asked questions) online
. 
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MAGIX Community
 MAGIX Community is the place to exchange photos, videos, and music with friends and the world. As
soon as you have registered for free, you can use all of its great features. 
You can also read the FAQ (frequently asked questions) online
. 
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Catooh – the Online Content Library
 Catooh provides you with high-quality photos, videos, and music for every theme, expanded by
intelligent iContent with professional Soundpools, DVD menu templates, and brilliant MAGIX
ShowMaker styles to help you make your photo, video, and music projects reality. All of this is available
directly from your MAGIX software. 
Just choose "Online" from the menu "Catooh" to set up an Internet connection. 
Browse through the thematically sorted categories or view the results directly by entering a keyword.
After downloading, you can drag the objects from the Media Pool directly into your arrangement. 
Tip: Read the introduction online
! 
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Menus
 In this chapter you'll find the full menu list of your copy of MAGIX Xtreme PhotoStory on CD & DVD
8 deluxe and the corresponding functions. 
In this chapter
File menu
Edit menu
Effects (FX)
Online menu
Tasks menu
Help menu
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File menu
In this chapter
New
Open
Open automatically saved project...
Manage slideshow
Wizards
Save
Save disc project as
Import
Scan image
Recording
Export
Internet
Transfer to external device
Backup copy
Burn project (image) again
Settings
Exit
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New
In this section
Project
Slideshow
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Project
This menu item creates a new MAGIX Xtreme PhotoStory on
CD & DVD 8 deluxe project. You can also open this feature
via the "New project" button above the video monitor. 

Keyboard shortcut: Shift + N 
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Slideshow
 This option creates a new slideshow. The default name for a new slideshow can be specified in the
program settings. 
Keyboard shortcut: Ctrl + Alt + N 
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Open
This menu item loads a previously saved MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe project. Please note
that the related files must be accessible. 

MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe searches for the used sounds, pictures and videos
under the path to where you last saved the disc project. 
Keyboard shortcut: Ctrl + O 
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Open automatically saved project...
 This option loads an automatically created slideshow backup. This type of automatic backup gets the file
extension MV_ (underscore). This command is only intended for use in emergencies, e.g. if you
unintentionally saved your change and wish to return to the previous version of the project. 
Keyboard shortcut: Alt + O 
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Manage slideshow

 Remove from project
 This option removes the current slideshow from the project. 
Shortcut: Shift + F4 

Rename
 You can enter a name for the current slideshow here. 

Attach
 This function attaches an opened slideshow to another one. This attaches it to the end of the opened
slideshow and automatically applies the original slideshow's settings. 
Attach an opened slideshow
: An already opened slideshow can be selected from the list and attached. This option is only available if
your project contains multiple slideshows. 
Attach the last edited slideshow
: All of the slideshows that were last edited are listed. This option is only available if other slideshows
have been previously edited. 
Load and attach a slideshow
: Click a folder and a dialog will open to select a slideshow. Navigate like in Windows Explorer to the
folder that contains the desired slideshow. Double clicking on a slideshow file (*.mvm) opens it and
attaches it to the current slideshow. 

Import slideshow file
 Use this option to load a slideshow into your project. 
Please note that all related photos must be accessible. MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe searches for the used sounds, pictures, and videos from the path to where you last saved the
slideshow. 
Keyboard shortcut: Ctrl + O 

Export slideshow file
 A dialog opens where you can specify the path and name of the slideshow. The slideshow can then be
imported again into other projects. 
Note
: The slideshow file (*.mvm) contains all information about the used media files, cuts, effects, and titles,
but not the picture and sound material itself. This is found in the recorded or imported media files that
remain unchanged during the entire MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe editing
process. To save the full slideshow into a dedicated directory, for instance to continue editing on a
different PC, please use the function "Copy movie and media into directory". 
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Wizards
 This menu entry contains different aids for different tasks in MAGIX Xtreme PhotoStory on CD &
DVD 8 deluxe. 
In this section
Slideshow wizard
Clean-up Wizard
MovieShow Maker
Soundtrack Maker
Adjust music to section
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Slideshow wizard
 This wizard makes creating great slideshows
 child's play. You will be led through the necessary steps automatically. 
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Clean-up Wizard
 The Clean Up Wizard helps you delete disc projects from you hard drive, including all slideshows and
the audio, video, and picture files used in them. Use this function to free up disk space for future
projects. 
Caution:
 If the files you used in the slideshow have also been used in other slideshows (like trailers, opening
music, for example), then you should make backup copies of these files beforehand. 
Keyboard shortcut: Shift + I 

Delete specific files
 Choose this option if you would like to select certain files for deletion. You can select the desired files in
the "File selection" dialog. In the next step, the Clean Up Wizard automatically looks for other files which
belong to your selection. Using this method you can delete an entire slideshow with all of its
accompanying media, help, project, and backup files. Before they are deleted you receive relevant
information in a dialog and a confirmation request. 

Search and delete superfluous files
 Choose this option if you would like to find unnecessary files or free up some space on your hard drive.
The Clean Up Wizard then automatically looks for extraneous files created during use of MAGIX
Xtreme PhotoStory on CD & DVD 8 deluxe. Before they are deleted you receive relevant information in
a dialog and a confirmation request. 
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MovieShow Maker
This opens MovieShow Maker
. 
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Soundtrack Maker
 This command opens the MAGIX Soundtrack Maker
. 
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Adjust music to section
 If you have edited your background music with Remix Agent and a musical tempo was provided, then
you can adjust the cuts to change automatically in time with the beat using this command. All hard cuts
(edits without transitions) will be moved to occur on the musical quarter notes. 
Keyboard shortcut: Ctrl + Shift + U 
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Save
The current disc project is saved with the name displayed in
the project window. If you have not yet specified a name for
your project, a dialog will open wherein MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe asks you to do so. 

Keyboard shortcut: Ctrl + Alt + S 
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Save disc project as
 A dialog opens where you can specify the path and name of the disc project. 
Keyboard shortcut: Alt + Shift + S 
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Import
 A dialog for importing media files opens. Choose between "Search" and "Automatic import". 
Search
: A dialog for selecting media files opens. The selected files will be imported into the current slideshow
after "Open" is clicked. 
Note
: Media files can be dragged and dropped into the slideshow from the Media Pool much more
conveniently. 
Import automatically
: To copy photos from a digital camera to the computer, the accompanying MAGIX Photo Manager
program will open. As soon as the program is ready, connect the digital camera with the computer. The
imported photos can be conveniently dragged from the Media pool into the slideshow. Please also read
the MAGIX Photo Manager help file by pressing "F1" from within the program. 
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Scan image
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Scan photo externally...
 Opens MAGIX Xtreme Photo Designer for scanning photos. This function is required if there are
problems when scanning with MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
Keyboard shortcut: Alt + Shift + A 

Twain scanner

 Select source
 The TWAIN interface connects MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe with nearly all
modern scanners or digital cameras. To scan, please proceed as follows: 

1. Install the TWAIN software for your device. 
2. Restart you PC. 
3. Start MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
4. Click on "File ? Twain Scanner/Camera ? Select source" if the scanner works with 32 bit

software. 
5. Select your device from the dialog. This step is only required once and only has to be repeated if

you want to change the device.

 Scan with
 The scan window of your scan software will appear. Specify the resolution and color depth in this
window. 
When the scan is complete, the TWAIN software should close automatically and MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe should now contain the newly created image file. It's possible that
the TWAIN window remains open. You can then scan multiple pictures one after the other. 
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Twain scanner

 Select source
 The TWAIN interface connects MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe with nearly all
modern scanners or digital cameras. To scan, please proceed as follows: 

1. Install the TWAIN software for your device. 
2. Restart you PC. 
3. Start MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
4. Click on "File ? Twain Scanner/Camera ? Select source" if the scanner works with 32 bit

software. 
5. Select your device from the dialog. This step is only required once and only has to be repeated if

you want to change the device.

 Scan with
 The scan window of your scan software will appear. Specify the resolution and color depth in this
window. 
When the scan is complete, the TWAIN software should close automatically and MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe should now contain the newly created image file. It's possible that
the TWAIN window remains open. You can then scan multiple pictures one after the other. 
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Select source
 The TWAIN interface connects MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe with nearly all
modern scanners or digital cameras. To scan, please proceed as follows: 

1. Install the TWAIN software for your device. 
2. Restart you PC. 
3. Start MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
4. Click on "File ? Twain Scanner/Camera ? Select source" if the scanner works with 32 bit

software. 
5. Select your device from the dialog. This step is only required once and only has to be repeated if

you want to change the device.

 Scan with
 The scan window of your scan software will appear. Specify the resolution and color depth in this
window. 
When the scan is complete, the TWAIN software should close automatically and MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe should now contain the newly created image file. It's possible that
the TWAIN window remains open. You can then scan multiple pictures one after the other. 
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Recording
 Select between Audio recording and Single image recording
. 
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Export
 This provides all export formats supported by MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
that aren't covered by burning. Refer to "Exporting
" for more information. 
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Internet
 This is a list of menu entries regarding all of the services that are available directly from within MAGIX
Xtreme PhotoStory on CD & DVD 8 deluxe. 
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Transfer to external device
 Most devices require certain format settings (file format, resolution, bit rate, picture repeat rate, etc.) to
be able to play a video. 
The menu is divided into various device classes (mobile phones, organizers and PDAs, games consoles,
and video players) to make choosing your device easier. The last three selections are saved as favorites
in the top part of the device list if you have more than one device or want to present your movies to your
friends. 
If your device is listed here, you won't have to worry about the format settings, because the necessary
settings of the Export dialog
 are automatically customized to the target device. Simply select your device and click "OK". 
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Download presets for new device
 The selection of playback devices is constantly changing. New devices or versions are coming on the
market every day. The list of supported devices may therefore not be up-to-date and may not (yet)
contain your specific device. MAGIX continuously maintains updated preset lists for the available devices
(available online for download). Internet access is required. 
The command "Download presets for new device" opens a website containing an up-to-date list of all
supported devices and device versions. Just search for the desired device and click the corresponding
link. The settings for the device will be downloaded and made available to you in MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe. 
Warning
: Some browsers display a warning if you try to download an executable file (.exe). You can ignore this
warning. 
If your device is not listed on the website, you can report your unsupported device so that it will be
included in later updates. 
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Output audio/video
 This command opens the dialog for exporting the completed video or its audio track to analog or digital
video recorders/camcorders or various mobile devices such as smartphones, PDAs, video players, or
games consoles. 
Please read the chapter "Output audio/video
". 
Keyboard shortcut: H 
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Backup copy
 Files must be saved to be able to be easily retrieved in case of a hard drive crash or some other error. 
In this section:
Copy project and media into folder...
Save slideshow and media as...
Burn backup copy to disc
Burn slideshow and media to CD/DVD
Restore data backup from (S)VCD/Video DVD

Copy project and media into folder...
 The project and all of the files it contains are saved together in one folder. Use this function to transfer an
entire project to another computer. 
Keyboard shortcut: Shift + Q 
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Copy project and media into folder...
 The project and all of the files it contains are saved together in one folder. Use this function to transfer an
entire project to another computer. 
Keyboard shortcut: Shift + Q 
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Save slideshow and media as...
 The slideshow and all necessary files can be saved in any folder. 
Keyboard shortcut: Shift + R 

Burn backup copy to disc
 Use this option to burn the project with all relevant slideshows and their files to CD or DVD. 
Even larger projects can be burned straight to disc. The project, if necessary, will be split up and burned
automatically to multiple discs. A restore program which is burned to the first disc of this type of backup,
guarantees easy re-recording of the backup. 
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Burn backup copy to disc
 Use this option to burn the project with all relevant slideshows and their files to CD or DVD. 
Even larger projects can be burned straight to disc. The project, if necessary, will be split up and burned
automatically to multiple discs. A restore program which is burned to the first disc of this type of backup,
guarantees easy re-recording of the backup. 
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Burn slideshow and media to CD/DVD
 Use this option to burn the slideshow and all relevant files to CD or DVD. 
Even larger slideshows can be burned straight to disc. If necessary, the slideshow will be split up and
burned automatically to multiple discs. A restore program which is burned to the first disc of this type of
backup guarantees easy re-recording of the backup. 
Keyboard shortcut: Alt + Shift + R 

Restore data backup from (S)VCD/Video DVD

 Use this menu command to restore a project backup that has been saved onto a CD/DVD. The disc has
to be burned with the option "Add project backup data" (see "Burn disc dialog
"). 
You can choose which of the slideshows contained on the disc should be restored by selecting it from the
list and highlighting which directory. In this folder a subfolder Backup_xx will be created for each
restored backup where all project files of the disc will be stored. All restored slideshows are then loaded
into MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe and can be edited. 
If you select the option "Restore image files only
", only the original image files contained on the disc are restored. 
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Restore data backup from (S)VCD/Video DVD

 Use this menu command to restore a project backup that has been saved onto a CD/DVD. The disc has
to be burned with the option "Add project backup data" (see "Burn disc dialog
"). 
You can choose which of the slideshows contained on the disc should be restored by selecting it from the
list and highlighting which directory. In this folder a subfolder Backup_xx will be created for each
restored backup where all project files of the disc will be stored. All restored slideshows are then loaded
into MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe and can be edited. 
If you select the option "Restore image files only
", only the original image files contained on the disc are restored. 
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Burn project (image) again
 All necessary files, menus, and encoded video files needed to burn a CD/DVD will be temporarily
stored on your hard drive. After your disc is burned, these are not 
automatically deleted. Use "Burn disc project (image) again" enables you to burn as many discs as you
would like without having to encode the files again. 

In the dialog, choose the image you want. All necessary files are then transferred to the MAGIX Goya
burnR. 
Tip
: For more information on using MAGIX Goya burnR, read the help file of the program. 
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Settings
In this section
Slideshow...
Project...
Program settings
Slideshow effect settings
Change the program interface
Reset program settings to default...
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Slideshow...
 Opens the settings for the current slideshow. 
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Project...
 Project name
:Give your disc project a name. This name will be used as a preset title for the disc you are going to burn.
The slideshows will also be given this name. 
Use 16:9 aspect ratio for current disc project
: This option lets you edit the slideshow from the very beginning in 16:9 format. The video monitor's size
changes to correspond to this. 
Cut new images to fit screen automatically
: Images that do not correspond to the slideshow's ratio are adjusted automatically. The zoom factor is
set in such a way that there are no black bars to the left or right or top to bottom. 
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Program settings
 This menu item opens the program settings
. 
Keyboard: P 
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Slideshow effect settings
 This menu item accesses the slideshow's effects settings. The settings made here apply to the entire
slideshow. 
Keyboard shortcut: M 

Page 307



Change the program interface
 Here you can switch between various designs, in which MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe can be represented. 

Reset program settings to default...
 Use this function to reset all program settings
 you made in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe to their original settings. 
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Reset program settings to default...
 Use this function to reset all program settings
 you made in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe to their original settings. 
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Exit
 Closes MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
Keyboard shortcut: Alt + F4 
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Edit menu
In this section:
Undo
Redo
Cut
Copy
Insert
Delete
Exchange
Split object
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Undo
You can undo the last steps you made. This means that you can
easily try out critical operations. If the result does not meet your
expectations, then you can simply "undo" it and return to the
initial status. 

Key: Ctrl + Z 

Redo

 Redo
 This command cancels a previous "Undo" command. 
Key: Ctrl + Y 

Cut
Cut
 This function deletes the selected photo (or the selected
object in the Timeline mode) and copies it to the clipboard.
You can then use the "Paste" command to copy it into any
slideshow. 

Keyboard shortcut: Ctrl + X 
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Cut
Cut
 This function deletes the selected photo (or the selected
object in the Timeline mode) and copies it to the clipboard.
You can then use the "Paste" command to copy it into any
slideshow. 

Keyboard shortcut: Ctrl + X 
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Copy

 Copy
 This command copies the selected scenes (or the selected object in Timeline mode) to the clipboard.
From there you can paste it into any other slideshow using the "Paste" command. 
Key: Ctrl + C 

Insert
Insert
 This command inserts the clipboard material (photo or
object) at the current position of the start marker. 

Keyboard shortcut: Ctrl + V 
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Insert
Insert
 This command inserts the clipboard material (photo or
object) at the current position of the start marker. 

Keyboard shortcut: Ctrl + V 
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Delete

 Delete
 This command cancels the selected photo (or the selected object in Timeline mode). 
Key: Del 
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Exchange
Replaces the selected object with an object selected in the
Media Pool. Length adjustment moves the objects following it
correspondingly. 

If photo objects are removed/exchanged, then the display duration will remain. 

Split object
 This command cuts a scene at the point where the start marker is positioned. This way, two
free-standing objects are created. 
You can isolate a part of an object in order to delete it: 

1. Place the start marker where you'd like to have it by left clicking in the timeline.
2. Select the video object by clicking on it and click on the cut button. 
3. Place the start marker at the end of the part you wish to remove and click on the cut button

again.
4. Select the middle object that was created and press the "DEL" key.
5. Pull the object at the back to the front; it should automatically snap into place. All subsequent

objects will be moved along in unison so that no gaps appear.
You can also use this function to apply effects to a certain part of an object only. 
Keyboard shortcut: T 
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Split object
 This command cuts a scene at the point where the start marker is positioned. This way, two
free-standing objects are created. 
You can isolate a part of an object in order to delete it: 

1. Place the start marker where you'd like to have it by left clicking in the timeline.
2. Select the video object by clicking on it and click on the cut button. 
3. Place the start marker at the end of the part you wish to remove and click on the cut button

again.
4. Select the middle object that was created and press the "DEL" key.
5. Pull the object at the back to the front; it should automatically snap into place. All subsequent

objects will be moved along in unison so that no gaps appear.
You can also use this function to apply effects to a certain part of an object only. 
Keyboard shortcut: T 
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Effects (FX)
In this chapter
Image optimization
Distortion
View & animation
Design
Rotate 90°
Automatically cut to fit monitor
Display duration...
Edit image (external)...
Create panorama image...
Picture-in-picture collages
Fades
Background design
Image stabilization
Title Editor
Save as title template...
Convert to 3D titles...
Sound optimization
Adjust music to section
Reset Effects
Show/Hide
Object properties
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Image optimization
 This places the image material in the right light, sharpens shaky recordings, and corrects tint, all
conveniently from the Media Pool
. 
In this section
TV picture
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TV picture
 This submenu item performs various adjustments for the TV picture. Besides interlace and anti-flickering
filters, you will find the option to adjust the image to the real proportions of the TV picture. A special
algorithm ensures an optimal ratio between image size and image borders (anti-cropping). 
In this section
Interpolation for interlace material
Anti-flicker filter
Border cropping adjustment
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Interpolation for interlace material
 Choose this option to remove interlace artifacts from your video image. If, for instance, you extract
freeze frames from a video, ridge structures appear in sequences which feature movement. 
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Anti-flicker filter
 Choose this option for still pictures with detailed structures and high contrast. This filter reduces line
flickering during TV playback. 
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Border cropping adjustment
 Select this option if the edges are cropped during playback on your television. Values stored in "
Slideshow effects settings
" will be applied. 
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Distortion
 Image material can be transformed in various artistic ways; a broad palette of effects is available to you
for this in the Media Pool
. 

Page 325



View & animation
 These effects allow properties like section, image size, position, and rotation of image and video objects
to be specified in the Media Pool
. 
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Design
 Add different decorations, speech bubbles, and animations to photos directly in the Media Pool
 to add life to your slideshow. 
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Rotate 90°
 Rotates the image 90° clockwise/counterclockwise. 

Shortcuts: Ctrl + Alt + F to the right 
Ctrl + Alt + G to the left 
You can also turn a photo in Storyboard
 mode via the rotation buttons on the photo box. 
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Automatically cut to fit monitor
 This option enables photos to be adjusted to suit the current format. In this case, the picture is zoomed in
to such an extent that the upper and lower parts of the photo are hidden and the annoying black bars to
the sides disappear. The consequence of course is that portions of the image will be missing. 
Shortcut: Shift + A 
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Display duration...
 Enter the display duration for the current photo here in [Minutes]:[Seconds]:[Frames]. 
Apply to area between the start and end markers
: Applies the settings to all photos located between the start and end markers. 
Apply to all
: The settings are applied to every photo in the current movie, but the settings will not be applied to
photos in other movies in the project. 
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Edit image (external)...
 The command "Edit image (external)" enables photos to be edited with the MAGIX Xtreme Photo
Designer graphics program. The command appears in the context menu for every image. The context
menu opens by clicking the small FX button at the top edge of the photo box.A dialog window of the
MAGIX Xtreme Photo Designer wizard appears. This is a clever little helper that recommends several
typical photo tasks from which you can simply select the specific task, mark with a cross, and then send
your picture to MAGIX Xtreme Photo Designer. MAGIX Xtreme Photo Designer opens and loads the
selected picture.In MAGIX Xtreme Photo Designer you are supplied with the necessary instructions for
editing your photos. Have fun experimenting! 
After editing has been completed, the modified picture will be used instead of the original material. 
Retouch redeye, select clippings, apply creative distortions ("flowing color"), enhance Internet photos,
and much more. The integrated MAGIX Xtreme Photo Designer
 makes it possible. Even unsuccessful recordings can be fit for presentation in the blink of an eye. Read
more on this in the MAGIX Xtreme Photo Designer help. 

Create panorama image...
 With only a single click you can create a panorama
 in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. You can do this fully automatic or manually;
try experimenting with it. 
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Create panorama image...
 With only a single click you can create a panorama
 in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. You can do this fully automatic or manually;
try experimenting with it. 
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Picture-in-picture collages
 These work similarly to normal picture-in-picture effects, but more objects are used. Depending on the
collage, arrange the selected objects one after the other and drag the collage onto the first object. 
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Fades
 This provides a list of all fades sorted into categories. Clicking on a category shows all of the fades
contained therein. 
To load a fade, click on it and drag it onto a scene which you would like to blend into. Alternatively, you
can select the scene into which you would like to blend into before and double click on the fade in the
Media Pool later. 
Tip:
 All fades will appear in the menu between two scenes, and they can also be selected there. 
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Background design
 Select a color, a picture, or any video on your hard disk which you would like to serve as the
background for the photo displayed. This function is especially useful when photos have black bars
around them or if they are reduced in size. 
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Image stabilization
 Opens the video stabilizer dialog to help you correct shaky footage. Read more on this topic in "Video
stabilization". 
Keyboard shortcut: Shift + K 
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Title Editor

 Title Editor
 Key Ctrl + t 

Page 337



Save as title template...
 If you have designed special titles, these can be saved as a template. Titles will be saved in the titles
folder in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe to make them easier to find in the Media
Pool (under "Titles). 
Keyboard shortcut: Shift + E 

Page 338



Convert to 3D titles...
 The title object will now be turned into a MAGIX 3D object. If you have also installed MAGIX 3D
Maker, the program will open for you to work on the text. 
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Sound optimization
 The "Audio cleaning
" dialog will open to help you remove noise. 
Shortcut: Shift + W 
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Adjust music to section
 If you have edited your background music with Remix Agent and a musical tempo was provided, then
you can adjust the cuts to change automatically in time with the beat using this command. All hard cuts
(edits without transitions) will be moved to occur on the musical quarter notes. 
Keyboard shortcut: Ctrl + Shift + U 

Reset Effects
 This is not really an "effect", since it actually deactivates all current effects. 
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Show/Hide
 Hides or shows the selected object. 

Object properties
 This function displays all the information about the currently selected objects, such as file name, position
on the hard-drive, tempo, etc. The Object Editor also defines the foreground and background color of
every object in the arrangement. 
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Object properties
 This function displays all the information about the currently selected objects, such as file name, position
on the hard-drive, tempo, etc. The Object Editor also defines the foreground and background color of
every object in the arrangement. 
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Online menu
 This is a list of menu entries regarding all of the services that are available directly from within MAGIX
Xtreme PhotoStory on CD & DVD 8 deluxe. 
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Tasks menu
 In this menu you will find direct solution and short video explanations on how to perform tasks in
different topics. Not only will you find step-by-step instructions for sound and pictures here, but you also
find quick access to many of functions. 
If you click on an entry with a camera symbol, then you will open a short tutorial video which displays a
solution. Entries without camera symbols offer a solution to the problem immediately. 
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Help menu
In this section:
Help
Content
magix.info
start introductory video
Display tool tips
MAGIX Screenshare
Register online
Online update
About MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
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Help
 This command is available for almost every feature of the program, and it opens the "Help" file for the
corresponding topic. Use this command to get help on any of MAGIX Xtreme PhotoStory on CD &
DVD 8 deluxe's functions. 
Keyboard shortcut: F1 
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Content
 Use the command "Content" in the "Help" menu to open the start page of the help file. You can read
through the help file step-by-step and jump to specific sections via the tree structure on the right hand
side. 
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magix.info
 Help and get help
 - Directly from within the program, you'll be able to access magix.info, the new MAGIX Knowledge
Base. In the Knowledge Base, you'll find answers to all of the most frequently asked questions about
MAGIX products and multimedia in general. Couldn't find an answer to your particular question? No
problem, just ask the question yourself. 

You can go to magix.info
 in the "Online" menu, or via this button. 
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start introductory video
 The introductory video shows you how all the most important features work. Specific topics are
explained in detail in additional tutorial videos. 
Shortcut: Ctrl + F1 
To play the introductory video you may have to insert the program CD. 
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Display tool tips
 Tooltips are small information windows that open up automatically if the mouse pointer stops briefly on a
button or some other area. They provide information about the function of the button. These information
boxes can be switched on or off with this option. 
Keyboard shortcut: Ctrl + Shift + F1 

Page 351



MAGIX Screenshare
 This function makes it possible for you to offer assistance to other users directly via the Internet, or to
get help from others. To do this you have to register MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe first. 
Hint:
 To inform the screensharing guests of exactly what is being shown, it is also a good idea to telephone or
chat simultaneously. 
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Register online
 This option opens the MAGIX homepage for online registration where you can register yourself as a
MAGIX user. 
Registration grants you access to the MAGIX support website
 (see support) where various program updates and help programs can be downloaded. 
With the registration form supplied (start menu under "MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe -> Service and support -> Register") you can register via post or fax. Simply print it out, fill it in,
and send it off! 
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Online update
 Connects directly to the MAGIX online update page where you can get the latest version of your
program. 
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About MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe
 Displays copyright info and version number of MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
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General settings
 You can access the project-independent MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe settings
this way. These settings are also global. 
Keyboard shortcut: P 
In this chapter
Playback
Folders
Options
Display
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Playback
 Audio playback

 Driver selection
 DirectSound should be selected here. DirectSound is a component of DirectX that is installed
automatically on your computer during program installation (if necessary). If the DirectX system is no
longer installed on your computer or no longer works properly, then there is a DirectSound installation
routine for reinstallation to be found in the "Addon" folder of the MAGIX Xtreme PhotoStory on CD &
DVD 8 deluxe
 program disc. 

Output device
 Use this option to specify which sound card plays the wave audio objects. This is especially important if
you have multiple sound cards installed on your computer. 

Audio buffer size
 Here you can specify the buffer size that should be used for playback of the entire arrangement or for
previewing audio files in the Media Pool. 

Video playback

 Use output and file cache
 This option activates a clipboard which enables smoother playback of transition effects. You should
usually keep this option activated. 

Arranger

 Autoscroll during playback:
 The screen playback does not follow the playback cursor if it has reached the end of the screen. 
Fast
: If autoscroll is activated, the screen view automatically shifts when the playback cursor reaches the last
quarter of the screen during playback. 
Slow
: If autoscroll is activated, the screen view automatically shifts when the playback cursor reaches the right
edge of the screen during playback. This is particularly useful for longer disc projects. 
Warning
: Scrolling requires constant recalculation of the screen view, which may lead to interrupted playback if
the amount of system RAM is too low. If this happens, simply deactivate the autoscroll feature. 

Display
 Update in background:
 The update if the object display after move and zoom operations in the arranger is performed in the
background in order to let you work smoothly. 

Image material playback
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 Adjust size of image material in higher quality (slower)
 You can use this feature to improve the quality when resizing, particularly downsizing to less than half of
the original size for picture-in-picture effects. This also requires more CPU
 power. 
Note
: Switching off this option has no effect on quality during exporting/burning. 

Load image material in the background
 Image
 material will be loaded in the background so that it can still be edited during the loading process. 
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Arranger

 Autoscroll during playback:
 The screen playback does not follow the playback cursor if it has reached the end of the screen. 
Fast
: If autoscroll is activated, the screen view automatically shifts when the playback cursor reaches the last
quarter of the screen during playback. 
Slow
: If autoscroll is activated, the screen view automatically shifts when the playback cursor reaches the right
edge of the screen during playback. This is particularly useful for longer disc projects. 
Warning
: Scrolling requires constant recalculation of the screen view, which may lead to interrupted playback if
the amount of system RAM is too low. If this happens, simply deactivate the autoscroll feature. 

Display
 Update in background:
 The update if the object display after move and zoom operations in the arranger is performed in the
background in order to let you work smoothly. 

Image material playback

 Adjust size of image material in higher quality (slower)
 You can use this feature to improve the quality when resizing, particularly downsizing to less than half of
the original size for picture-in-picture effects. This also requires more CPU
 power. 
Note
: Switching off this option has no effect on quality during exporting/burning. 

Load image material in the background
 Image
 material will be loaded in the background so that it can still be edited during the loading process. 
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Folders
 Projects
: The standard path for all projects (*.<Pojektdatei>) 
Exports: The standard path for all file exports via "File -> Export slideshow...
". 
Audio import
: The standard path for all imported (music) files. 
Disc images
: Here you can specify the path for the folder where MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe saves the temporary files required for creating a disc. 

Options
 Here you can specify the most important options for the behavior and display of MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe. 
Keyboard shortcut: P 

Video standard
 PAL is used in Europe; the US and Japan use NTSC. This setting should not be changed. 

Preview
 The resolution can be reduced for video decoding, but this only has an effect while preview editing. If
playback becomes jerky, then we recommend entering a lower value. The quality of exported videos is
not influenced by this. 

Video options

 Hardware acceleration for 3D effects
 Here you can (de)activate hardware acceleration of your graphics card for 3D effects. You can find
more information about this topic in the "3-D fades"
 chapter. 

High output quality with dynamic zoom and combination effects
 If this option is set, then a newly developed zoom algorithm will be used that provides much more
accurate results. You should, however, only use this option if you own a PC that is capable of handling
processor-heavy tasks. Otherwise export (and invariably disc creation) can take a lot longer. 

Reduce bitmap resolution for preview
 During playback in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe images and photos will be
shown in lower resolution. The quality of the preview will be reduced, but this option helps save
computing resources. 

Online Services
 Here you can configure the Online Services
 you use. You require a connection to the Internet to do this. 

System
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 Automatically fade photos with effects
 Loaded photos will be automatically supplied with a crossfade
. 

Load CD tracks via record dialog
 If this option is activated, then you can record audio CDs via the record button in the transport control.
While dragging & dropping from the file manager the record window where recording starts will be
opened. This option can be used if drag & drop via the file manager does not working properly, or if you
want to record the first bars of an incomplete CD track in the arrangement.
Here you should note that the digital track data from the digital analog converters of the CD-ROM drive
have to be converted into analog signals and then into digital data by the analog/digital converters.
Depending on the quality of the converter used, this can lead to losses in quality. 

Automatically preview exported clips
 If you export a movie as a video file, then it will be played back immediately after being created. 

Automatic preview when changing photos
 If this option is activated, then a short preview of the transition effect will be played. 

"Cut to fit monitor automatically" influences movies
 If this option is active, then videos will be cut to avoid black edges. The property "Cut to fit monitor
automatically" must be activated for the project. 

Standard picture length
 Here you can adjust the default display duration of the selected photo. This can be changed again at any
time. 

Hints
 In its newly installed state, MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe displays a number of
security queries at various parts of the program. Every one of them can be switched off by clicking the
small box at the bottom that says "Don't show this message again". To display these warning messages,
please select the "Reactivate dialogs
" option. 

Program interface

 Hide news
 This option deactivates the MAGIX News Center
 in the main interface of MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
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Options
 Here you can specify the most important options for the behavior and display of MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe. 
Keyboard shortcut: P 

Video standard
 PAL is used in Europe; the US and Japan use NTSC. This setting should not be changed. 

Preview
 The resolution can be reduced for video decoding, but this only has an effect while preview editing. If
playback becomes jerky, then we recommend entering a lower value. The quality of exported videos is
not influenced by this. 

Video options

 Hardware acceleration for 3D effects
 Here you can (de)activate hardware acceleration of your graphics card for 3D effects. You can find
more information about this topic in the "3-D fades"
 chapter. 

High output quality with dynamic zoom and combination effects
 If this option is set, then a newly developed zoom algorithm will be used that provides much more
accurate results. You should, however, only use this option if you own a PC that is capable of handling
processor-heavy tasks. Otherwise export (and invariably disc creation) can take a lot longer. 

Reduce bitmap resolution for preview
 During playback in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe images and photos will be
shown in lower resolution. The quality of the preview will be reduced, but this option helps save
computing resources. 

Online Services
 Here you can configure the Online Services
 you use. You require a connection to the Internet to do this. 

System

 Automatically fade photos with effects
 Loaded photos will be automatically supplied with a crossfade
. 

Load CD tracks via record dialog
 If this option is activated, then you can record audio CDs via the record button in the transport control.
While dragging & dropping from the file manager the record window where recording starts will be
opened. This option can be used if drag & drop via the file manager does not working properly, or if you
want to record the first bars of an incomplete CD track in the arrangement.
Here you should note that the digital track data from the digital analog converters of the CD-ROM drive
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have to be converted into analog signals and then into digital data by the analog/digital converters.
Depending on the quality of the converter used, this can lead to losses in quality. 

Automatically preview exported clips
 If you export a movie as a video file, then it will be played back immediately after being created. 

Automatic preview when changing photos
 If this option is activated, then a short preview of the transition effect will be played. 

"Cut to fit monitor automatically" influences movies
 If this option is active, then videos will be cut to avoid black edges. The property "Cut to fit monitor
automatically" must be activated for the project. 

Standard picture length
 Here you can adjust the default display duration of the selected photo. This can be changed again at any
time. 

Hints
 In its newly installed state, MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe displays a number of
security queries at various parts of the program. Every one of them can be switched off by clicking the
small box at the bottom that says "Don't show this message again". To display these warning messages,
please select the "Reactivate dialogs
" option. 

Program interface

 Hide news
 This option deactivates the MAGIX News Center
 in the main interface of MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
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Preview
 The resolution can be reduced for video decoding, but this only has an effect while preview editing. If
playback becomes jerky, then we recommend entering a lower value. The quality of exported videos is
not influenced by this. 

Video options

 Hardware acceleration for 3D effects
 Here you can (de)activate hardware acceleration of your graphics card for 3D effects. You can find
more information about this topic in the "3-D fades"
 chapter. 

High output quality with dynamic zoom and combination effects
 If this option is set, then a newly developed zoom algorithm will be used that provides much more
accurate results. You should, however, only use this option if you own a PC that is capable of handling
processor-heavy tasks. Otherwise export (and invariably disc creation) can take a lot longer. 

Reduce bitmap resolution for preview
 During playback in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe images and photos will be
shown in lower resolution. The quality of the preview will be reduced, but this option helps save
computing resources. 

Online Services
 Here you can configure the Online Services
 you use. You require a connection to the Internet to do this. 

System

 Automatically fade photos with effects
 Loaded photos will be automatically supplied with a crossfade
. 

Load CD tracks via record dialog
 If this option is activated, then you can record audio CDs via the record button in the transport control.
While dragging & dropping from the file manager the record window where recording starts will be
opened. This option can be used if drag & drop via the file manager does not working properly, or if you
want to record the first bars of an incomplete CD track in the arrangement.
Here you should note that the digital track data from the digital analog converters of the CD-ROM drive
have to be converted into analog signals and then into digital data by the analog/digital converters.
Depending on the quality of the converter used, this can lead to losses in quality. 

Automatically preview exported clips
 If you export a movie as a video file, then it will be played back immediately after being created. 

Automatic preview when changing photos
 If this option is activated, then a short preview of the transition effect will be played. 
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"Cut to fit monitor automatically" influences movies
 If this option is active, then videos will be cut to avoid black edges. The property "Cut to fit monitor
automatically" must be activated for the project. 

Standard picture length
 Here you can adjust the default display duration of the selected photo. This can be changed again at any
time. 

Hints
 In its newly installed state, MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe displays a number of
security queries at various parts of the program. Every one of them can be switched off by clicking the
small box at the bottom that says "Don't show this message again". To display these warning messages,
please select the "Reactivate dialogs
" option. 

Program interface

 Hide news
 This option deactivates the MAGIX News Center
 in the main interface of MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
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Video options

 Hardware acceleration for 3D effects
 Here you can (de)activate hardware acceleration of your graphics card for 3D effects. You can find
more information about this topic in the "3-D fades"
 chapter. 

High output quality with dynamic zoom and combination effects
 If this option is set, then a newly developed zoom algorithm will be used that provides much more
accurate results. You should, however, only use this option if you own a PC that is capable of handling
processor-heavy tasks. Otherwise export (and invariably disc creation) can take a lot longer. 

Reduce bitmap resolution for preview
 During playback in MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe images and photos will be
shown in lower resolution. The quality of the preview will be reduced, but this option helps save
computing resources. 

Online Services
 Here you can configure the Online Services
 you use. You require a connection to the Internet to do this. 

System

 Automatically fade photos with effects
 Loaded photos will be automatically supplied with a crossfade
. 

Load CD tracks via record dialog
 If this option is activated, then you can record audio CDs via the record button in the transport control.
While dragging & dropping from the file manager the record window where recording starts will be
opened. This option can be used if drag & drop via the file manager does not working properly, or if you
want to record the first bars of an incomplete CD track in the arrangement.
Here you should note that the digital track data from the digital analog converters of the CD-ROM drive
have to be converted into analog signals and then into digital data by the analog/digital converters.
Depending on the quality of the converter used, this can lead to losses in quality. 

Automatically preview exported clips
 If you export a movie as a video file, then it will be played back immediately after being created. 

Automatic preview when changing photos
 If this option is activated, then a short preview of the transition effect will be played. 

"Cut to fit monitor automatically" influences movies
 If this option is active, then videos will be cut to avoid black edges. The property "Cut to fit monitor
automatically" must be activated for the project. 

Standard picture length
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 Here you can adjust the default display duration of the selected photo. This can be changed again at any
time. 

Hints
 In its newly installed state, MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe displays a number of
security queries at various parts of the program. Every one of them can be switched off by clicking the
small box at the bottom that says "Don't show this message again". To display these warning messages,
please select the "Reactivate dialogs
" option. 

Program interface

 Hide news
 This option deactivates the MAGIX News Center
 in the main interface of MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 

Page 367



System

 Automatically fade photos with effects
 Loaded photos will be automatically supplied with a crossfade
. 

Load CD tracks via record dialog
 If this option is activated, then you can record audio CDs via the record button in the transport control.
While dragging & dropping from the file manager the record window where recording starts will be
opened. This option can be used if drag & drop via the file manager does not working properly, or if you
want to record the first bars of an incomplete CD track in the arrangement.
Here you should note that the digital track data from the digital analog converters of the CD-ROM drive
have to be converted into analog signals and then into digital data by the analog/digital converters.
Depending on the quality of the converter used, this can lead to losses in quality. 

Automatically preview exported clips
 If you export a movie as a video file, then it will be played back immediately after being created. 

Automatic preview when changing photos
 If this option is activated, then a short preview of the transition effect will be played. 

"Cut to fit monitor automatically" influences movies
 If this option is active, then videos will be cut to avoid black edges. The property "Cut to fit monitor
automatically" must be activated for the project. 

Standard picture length
 Here you can adjust the default display duration of the selected photo. This can be changed again at any
time. 

Hints
 In its newly installed state, MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe displays a number of
security queries at various parts of the program. Every one of them can be switched off by clicking the
small box at the bottom that says "Don't show this message again". To display these warning messages,
please select the "Reactivate dialogs
" option. 

Program interface

 Hide news
 This option deactivates the MAGIX News Center
 in the main interface of MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
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Standard picture length
 Here you can adjust the default display duration of the selected photo. This can be changed again at any
time. 

Hints
 In its newly installed state, MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe displays a number of
security queries at various parts of the program. Every one of them can be switched off by clicking the
small box at the bottom that says "Don't show this message again". To display these warning messages,
please select the "Reactivate dialogs
" option. 

Program interface

 Hide news
 This option deactivates the MAGIX News Center
 in the main interface of MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe. 
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Display
 Video mode

 Compatibility mode (video for Windows)
 This mode works on all systems. Activate this mode if there are problems with playback. 

Hardware acceleration (Direct 3D)
 This mode offers extreme increase in speed by calculating mixing, effects, and various transitions the the
graphics card directly. Depending on the graphics card, performance can increase by 300%. The
graphics card will not be used during export. 
Note! 
To use this mode the graphics card must possess at least 128 MB memory. You will need to install
Direct 3D 9, or higher, and the graphics card driver must support "High Level Pixel Shader Language
2.0". MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe checks the corresponding properties when
this mode is selected and switches it off if necessary. 

Alternative mode 1 (mixer overlay)
 This mode performs hardware-based deinterlacing for output onto a PC screen or a projector, whereby
the playback quality is significantly better than with interlaced analog video recordings. 

Alternative mode 2 (video mixing renderer 9)
 This mode uses the hardware de-interlacing function of modern graphics cards together with DirectX 9.
Make sure that you are using the most recent version of your graphics card driver, which must be
compatible with DirectX 9 to function properly. This mode is only superior to "Overlay mixer" mode with
a limited number of graphics card models. 

De-interlacing
 In the DirectShow modes "Overlay mixer" and "Video mixing renderer 9", you can activate hardware
de-interlacing with your graphics card. For general information on de-interlacing and the options
"Top/Bottom field first", please read the corresponding article "De-interlacing
". 

Image formation in Vertical Blank Intervals (VBI)
 The image formation takes place in the vertical blank intervals of the monitor signal (or the connected TV
signal). This helps avoid image interruptions. 
Warning
: Because of waiting time required for the next VBI, this process adds significant computational time! 
For digital displays like the TFT monitors you can deactivate the option. In the Overlay mode image
formation occurs exclusively in VBI. 

Project- and
slideshow-relevant settings

Page 370



Project- and
slideshow-relevant settings
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New project - Settings
 When creating a new disc project, you can specify multiple settings that will continue to apply to the
related slideshows. 
Load existing project or slideshow
: Select from the last projects and slideshows you were working to start working from where you
previously left off. 
Create new project
:Give your disc project a name. This name will be used as a preset title for the disc you are going to burn.
The slideshows will also be given this name. 
Use 16:9 aspect ratio for current project
: This option lets you edit the slideshow from the very beginning in 16:9 format. The video monitor's size
adjusts to correspond to this. 
Advanced
 Display time for each photo: By default, photos are displayed for the time entered here. Of course, you
can change the time each photo is displayed later. 
Fade photos automatically with effects: When loading photos, they will automatically fade from one into
the other using effects. These fades can be changed or removed later. 
Cut new images to fit screen automatically
: Images that do not correspond to the slideshow's ratio are adjusted automatically. The zoom factor is
set in such a way that there are no black bars to the left or right or top to bottom. 
Presets for the capacity display
: Set the disc type you prefer here. MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe estimates how
much space a disc project will occupy on a corresponding blank disc. This display can be found below
the slideshow. 
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Movie properties
 The dialog with the settings for the current slideshow are displayed here. The dialog can be opened via
the "File" menu
. 

Automatically select preview image
 MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe uses an automatically selected preview image. 

Use image file
 Clicking the folder button opens a dialog to load image files. In this dialog, you can navigate to the
directory where the image file is found and select it by double clicking. 

Use preview image from movie
 Use the fader to select a frame from the current slideshow. 
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Problems and solutions
In this chapter
File will not load
Choppy or uneven playback
Possible problems and their solutions
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File will not load
 If files cannot be loaded, this means that the format is either no supported by MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe and the corresponding codec must first be activated. Read the
section "Import formats" or "Activate additional functions". 
In case of AVI files, it is possible that the necessary codec in not installed. For more, please refer to "
General tips for AVI videos
" in the appendix "Digital video and storage devices". 
Tip
: To find out which codecs are used in the movie file, different help programs are available. An example
for this is "GSpot" or "AVIcodec". 
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Choppy or uneven playback
 Don't panic if the picture on your screen is choppy or uneven. The finished product will look perfect and
play smoothly. Don't forget that MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe calculates all
effects in real time. This lets you see for yourself what sort of influence each of the effects will have on
your video footage. Some effects make even today's high-performance PCs work quite hard, and often,
a steady, continuous video stream is simply not possible on your PC. The final product, free from
previous choppiness, is only available after rendering it to DVD or exporting it. For that reason, you
should first edit the movie in its raw version without effects. The preview generally delivers a steady
picture, allowing you to work quickly and quietly. Towards the end, you can add effects to your movies
to give them a special touch of Hollywood! 
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Possible problems and their solutions
 The code entered is incorrect (telephone activation)

  Make sure your entry is correct; in most cases a typo is the culprit.
 If the code is entered correctly, then you can dial the number for our call center. Our co-workers

are glad to help you personally.
The MAGIX website won't open

  Check your Internet connection; you may have to use manual dial-up.
The MAGIX website won't open
 Check your Internet connection; you may have to use manual dial-up. 
The form for ordering via post/fax won't open

  Check that an adequate text editing program is installed and activated (for example, MS Word).
I still haven't received an email with the activation code

  Check that your inbox isn't full.
 Have a look in your spam folder.

You can always send questions via email to our support whenever you like. Please have the following
information at hand so that we can assist you as quickly and as specifically as possible. 

 Complete product name
 Exact version number (to be found in the about box in the "About" menu item of the "Help"

menu)
 Encoder/Decoder name
 Your user code (accessible via the "Activate via post/fax" dialog)

I installed my MAGIX program onto my new computer or built a new hard disk (sound card,
memory...) into my old computer. Now my activation code is no longer accepted.
 Activation is linked to a specific computer. Changes to the computer's hardware, for example,
integrating a larger hard disk can lead to the computer no longer being recognized as the one for which
the activation code was created. This will most likely happen if you install MAGIX Xtreme PhotoStory
on CD & DVD 8 deluxe on a new computer. If this is the case, simply request a new activation code.
Since you're already registered as a MAGIX customer, you won't have to pay for another activation. 
Online:
 When registering on the MAGIX website use your existing MAGIX login details. 
Post/Fax:
 Print out the order form again and send it to the addressee/fax number stated. 
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Activate additional functions
 You can activate encoders/decoders for various file formats as required. 
Why does it have to be "activated"?
 To import (decode) or export (encode) certain video and audio formats you will require a specific
codec. MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe will ask you if you want to activate the
codec as soon as you need it. The integration of decoders and encoders from third parties into programs
usually costs money. These codecs are integrated via additional, voluntary activation in MAGIX
programs which, according to usage and degree of prevalence, can be free or fee-based for special
high-quality codecs. This way, MAGIX can continue to be able to provide you with optimum value for
money for your software. 
In this chapter
Free activation (MPEG 2 codec)
Fee-based activation (MPEG-4)
Possible problems and their solutions

Page 378



Free activation (MPEG 2 codec)
 To be able to use the MPEG-2 codec, you will have to first activate it for free. 
Activation can be done online via telephone or via post/fax. The quickest and easiest way to order an
activation code is via the Internet. 
Order activation code online
 Click on "Order online..." (  Field 1). MAGIX Xtreme PhotoStory 8 will automatically contact the
MAGIX server and load the corresponding codec. 
Note
: Activation of the codec checks the registration data as required. Activation of the codec only functions if
your version of the program has already been registered in your name. If you haven't registered MAGIX
Xtreme PhotoStory 8, then you can do this at any time. 
If your computer has no Internet access, you have the following options for activation: 
Order activation code in MAGIX Service Center
 Use this option to conduct activation from a different computer which has Internet access. 
Order activation code via telephone
 The telephone number and necessary details you will need to call to receive activation by telephone are
displayed here. 
Order activation code via post/fax
 After clicking on "Order via post/fax" (field 2), your user code will appear. This automatically assigns
your personal activation code to your PC. Click on "Continue to order form" to transfer your user code
automatically to the post/fax form. Now send the completed form as a print out to the address/fax no.
mentioned. Your activation code will be sent to you in just a few days via post or fax. It can also be sent
by mail if an email address is state d. 
Enter activation code
 After receiving your personal activation code, you can use the activation dialog for the corresponding file
format to start exporting for the respective format. if you receive the activation code via email, then copy
it into the input field in the dialog and click "Activate...". 
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Fee-based activation (MPEG-4)
 The MPEG-4 codec requires a fee-based activation. This can be done online, via telephone, or via
post/fax. The quickest and easiest way to order an activation code is via the Internet. Ordering the
activation code takes just a few minutes via email. Ordering your activation code via post/fax requires a
few days for processing. 
Order activation code online
 Click on "Order online..." (Field
 1). The web browser will open for you to register MAGIX Xtreme PhotoStory on CD & DVD 8
deluxe first (if you have not already done so). You will then be forwarded to a website where you can
request the corresponding activation. 
If your computer has no Internet access, then you have the following options for activation: 
Order activation code in MAGIX Service Center
 Use this option to conduct activation from a different computer which has Internet access. 
Order activation code via post/fax
 After clicking on "Order via post/fax" (field 2) your user code will appear. This automatically assigns
your personal activation code to your PC. Click on "Continue to order form" to transfer your user code
automatically to the post/fax form. Now send the completed form as a printout to the address/fax no.
mentioned. Once payment has been processed successfully, your activation code will be sent to you in
the post/via fax in just a few days. Optionally it can also be sent by email if an email address is stated. 
Enter activation code
 After receiving your personal activation code use the export or burn function to reopen the activation
dialog for the corresponding file format. Type or copy the activation code into the input field in the dialog
and click on "Activate..."
. 
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Possible problems and their solutions
 The code entered is incorrect (telephone activation)

  Make sure your entry is correct; in most cases a typo is the culprit.
 If the code is entered correctly, then you can dial the number for our call center. Our co-workers

are glad to help you personally.
The MAGIX website won't open

  Check your Internet connection; you may have to use manual dial-up.
The MAGIX website won't open
 Check your Internet connection; you may have to use manual dial-up. 
The form for ordering via post/fax won't open

  Check that an adequate text editing program is installed and activated (for example, MS Word).
I still haven't received an email with the activation code

  Check that your inbox isn't full.
 Have a look in your spam folder.

You can always send questions via email to our support whenever you like. Please have the following
information at hand so that we can assist you as quickly and as specifically as possible. 

 Complete product name
 Exact version number (to be found in the about box in the "About" menu item of the "Help"

menu)
 Encoder/Decoder name
 Your user code (accessible via the "Activate via post/fax" dialog)

I installed my MAGIX program onto my new computer or built a new hard disk (sound card,
memory...) into my old computer. Now my activation code is no longer accepted.
 Activation is linked to a specific computer. Changes to the computer's hardware, for example,
integrating a larger hard disk can lead to the computer no longer being recognized as the one for which
the activation code was created. This will most likely happen if you install MAGIX Xtreme PhotoStory
on CD & DVD 8 deluxe on a new computer. If this is the case, simply request a new activation code.
Since you're already registered as a MAGIX customer, you won't have to pay for another activation. 
Online:
 When registering on the MAGIX website use your existing MAGIX login details. 
Post/Fax:
 Print out the order form again and send it to the addressee/fax number stated. 
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Keyboard shortcuts
In this chapter
Media Pool
Slideshow

Media Pool
Folders 0 ... 9 
Delete file Del 
Copy file Ctrl + Ins 
Insert file Shift + Ins 
Rename file Alt + R 
New folder Ctrl + P 
Folder as link Ctrl + Q 
Options P 
Help F1 
Select files:
Select multiple pictures listed
out one after the other: 

Shift + click on the first file + click on
the last file that is to be selected. 

Select multiple individual
pictures: 

Ctrl + mouse click on the
corresponding pictures 

Select all pictures of the
opened folder: 

Ctrl + A 

Slideshow
 Load/Save project
New project Alt + Ctrl + N 
Load project Ctrl + Alt + O 
Save project Ctrl + Alt + S 
Save project as... Alt + Shift + S 
Delete project Alt + Shift + O 
New slideshow Ctrl + N 
Load slideshow Ctrl + O 
Load restoration slideshow Alt + O 
Save slideshow Ctrl + S 
Save slideshow as... Shift + S 
Close slideshow Shift + O 
Delete slideshow Shift + I 
Burn backup copy to disc Alt + Shift + R 
Recording
Audio recording R 
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Tools
Select all (not in Storyboard mode) Ctrl + A 
Cut Ctrl + X 
Copy Ctrl + C 
Insert Ctrl + V 
Undo Ctrl + Z 
Restore Ctrl + Y 
Delete Del 
Photo overview O 
Slideshow
 Maker 

W 

Optimize photo Shift + X 
Audio cleaning Shift + W 
Cut
Split object T 
Remove object beginning Ctrl + T 
Remove object end Shift + T 
Split slideshow Alt + T 
Effects
Edit photo Shift + Y 
Zoom 2 Ctrl + Alt + 1 
Zoom 3 Ctrl + Alt + 2 
Free zoom selection Ctrl + Alt + 3 
Fix image proportions Ctrl + Alt + 4 
Reset cropping Ctrl + Alt + 5 
Pan left -> right Ctrl + Shift + A 
Pan right -> left Ctrl + Shift + B 
Pan top -> bottom Ctrl + Alt + V 
Pan bottom -> top Ctrl + Shift + D 
Zoom out Ctrl + Shift + E 
Zoom in Ctrl + Shift + F 
Reset movement Ctrl + Shift + G 
Rotate left Ctrl + Alt + F 
Rotate right Ctrl + Alt + G 
Rotate 180 degrees Ctrl + Alt + H 
Transition (length) Alt + l 
Apply transition to all Alt + A 
Random transition Alt + Z 

Mirror horizontally Ctrl + Alt + A 
Mirror vertically Ctrl + Alt + B 
Horizontal symmetry Ctrl + Alt + C 
Vertical symmetry Ctrl + Alt + D 
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Kaleidoscope Ctrl + Alt + E 
Color shift 1/2/3 Shift + 1/2/3 
Title Editor Alt + Shift + T 
Reset video effects Ctrl + C 
Object properties Ctrl + E 
Arrangement display
Switch Storyboard/Timeline mode Tab 
Optimize grid view Shift + B 
Zoom 1 frame Ctrl + 1 
Zoom 5 frames Ctrl + 2 
Zoom 1 sec Ctrl + 3 
Zoom 10 sec Ctrl + 4 
Zoom 1 min Ctrl + 5 
Zoom 10 min Ctrl + 6 
Zoom range from start to end marker Ctrl + 7 
Zoom the entire slideshow Ctrl + 8 
Playback and marker placement
Start/Stop playback Space bar, ? 
Stop at position (stop playback, move start
marker to current position) 

Escape, ?, 0 on the
number pad 

Move start marker to the beginning Home 
Move end marker to the end end 
Slow wind left Left 
Slow wind right Right 
Fast wind left Ctrl + Left 
Fast wind right Ctrl + Right 
Full screen playback Alt + Enter 
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Media Pool
Folders 0 ... 9 
Delete file Del 
Copy file Ctrl + Ins 
Insert file Shift + Ins 
Rename file Alt + R 
New folder Ctrl + P 
Folder as link Ctrl + Q 
Options P 
Help F1 
Select files:
Select multiple pictures listed
out one after the other: 

Shift + click on the first file + click on
the last file that is to be selected. 

Select multiple individual
pictures: 

Ctrl + mouse click on the
corresponding pictures 

Select all pictures of the
opened folder: 

Ctrl + A 

Slideshow
 Load/Save project
New project Alt + Ctrl + N 
Load project Ctrl + Alt + O 
Save project Ctrl + Alt + S 
Save project as... Alt + Shift + S 
Delete project Alt + Shift + O 
New slideshow Ctrl + N 
Load slideshow Ctrl + O 
Load restoration slideshow Alt + O 
Save slideshow Ctrl + S 
Save slideshow as... Shift + S 
Close slideshow Shift + O 
Delete slideshow Shift + I 
Burn backup copy to disc Alt + Shift + R 
Recording
Audio recording R 
Tools
Select all (not in Storyboard mode) Ctrl + A 
Cut Ctrl + X 
Copy Ctrl + C 
Insert Ctrl + V 
Undo Ctrl + Z 
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Restore Ctrl + Y 
Delete Del 
Photo overview O 
Slideshow
 Maker 

W 

Optimize photo Shift + X 
Audio cleaning Shift + W 
Cut
Split object T 
Remove object beginning Ctrl + T 
Remove object end Shift + T 
Split slideshow Alt + T 
Effects
Edit photo Shift + Y 
Zoom 2 Ctrl + Alt + 1 
Zoom 3 Ctrl + Alt + 2 
Free zoom selection Ctrl + Alt + 3 
Fix image proportions Ctrl + Alt + 4 
Reset cropping Ctrl + Alt + 5 
Pan left -> right Ctrl + Shift + A 
Pan right -> left Ctrl + Shift + B 
Pan top -> bottom Ctrl + Alt + V 
Pan bottom -> top Ctrl + Shift + D 
Zoom out Ctrl + Shift + E 
Zoom in Ctrl + Shift + F 
Reset movement Ctrl + Shift + G 
Rotate left Ctrl + Alt + F 
Rotate right Ctrl + Alt + G 
Rotate 180 degrees Ctrl + Alt + H 
Transition (length) Alt + l 
Apply transition to all Alt + A 
Random transition Alt + Z 

Mirror horizontally Ctrl + Alt + A 
Mirror vertically Ctrl + Alt + B 
Horizontal symmetry Ctrl + Alt + C 
Vertical symmetry Ctrl + Alt + D 
Kaleidoscope Ctrl + Alt + E 
Color shift 1/2/3 Shift + 1/2/3 
Title Editor Alt + Shift + T 
Reset video effects Ctrl + C 
Object properties Ctrl + E 
Arrangement display
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Switch Storyboard/Timeline mode Tab 
Optimize grid view Shift + B 
Zoom 1 frame Ctrl + 1 
Zoom 5 frames Ctrl + 2 
Zoom 1 sec Ctrl + 3 
Zoom 10 sec Ctrl + 4 
Zoom 1 min Ctrl + 5 
Zoom 10 min Ctrl + 6 
Zoom range from start to end marker Ctrl + 7 
Zoom the entire slideshow Ctrl + 8 
Playback and marker placement
Start/Stop playback Space bar, ? 
Stop at position (stop playback, move start
marker to current position) 

Escape, ?, 0 on the
number pad 

Move start marker to the beginning Home 
Move end marker to the end end 
Slow wind left Left 
Slow wind right Right 
Fast wind left Ctrl + Left 
Fast wind right Ctrl + Right 
Full screen playback Alt + Enter 
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Slideshow
 Load/Save project
New project Alt + Ctrl + N 
Load project Ctrl + Alt + O 
Save project Ctrl + Alt + S 
Save project as... Alt + Shift + S 
Delete project Alt + Shift + O 
New slideshow Ctrl + N 
Load slideshow Ctrl + O 
Load restoration slideshow Alt + O 
Save slideshow Ctrl + S 
Save slideshow as... Shift + S 
Close slideshow Shift + O 
Delete slideshow Shift + I 
Burn backup copy to disc Alt + Shift + R 
Recording
Audio recording R 
Tools
Select all (not in Storyboard mode) Ctrl + A 
Cut Ctrl + X 
Copy Ctrl + C 
Insert Ctrl + V 
Undo Ctrl + Z 
Restore Ctrl + Y 
Delete Del 
Photo overview O 
Slideshow
 Maker 

W 

Optimize photo Shift + X 
Audio cleaning Shift + W 
Cut
Split object T 
Remove object beginning Ctrl + T 
Remove object end Shift + T 
Split slideshow Alt + T 
Effects
Edit photo Shift + Y 
Zoom 2 Ctrl + Alt + 1 
Zoom 3 Ctrl + Alt + 2 
Free zoom selection Ctrl + Alt + 3 
Fix image proportions Ctrl + Alt + 4 
Reset cropping Ctrl + Alt + 5 
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Pan left -> right Ctrl + Shift + A 
Pan right -> left Ctrl + Shift + B 
Pan top -> bottom Ctrl + Alt + V 
Pan bottom -> top Ctrl + Shift + D 
Zoom out Ctrl + Shift + E 
Zoom in Ctrl + Shift + F 
Reset movement Ctrl + Shift + G 
Rotate left Ctrl + Alt + F 
Rotate right Ctrl + Alt + G 
Rotate 180 degrees Ctrl + Alt + H 
Transition (length) Alt + l 
Apply transition to all Alt + A 
Random transition Alt + Z 

Mirror horizontally Ctrl + Alt + A 
Mirror vertically Ctrl + Alt + B 
Horizontal symmetry Ctrl + Alt + C 
Vertical symmetry Ctrl + Alt + D 
Kaleidoscope Ctrl + Alt + E 
Color shift 1/2/3 Shift + 1/2/3 
Title Editor Alt + Shift + T 
Reset video effects Ctrl + C 
Object properties Ctrl + E 
Arrangement display
Switch Storyboard/Timeline mode Tab 
Optimize grid view Shift + B 
Zoom 1 frame Ctrl + 1 
Zoom 5 frames Ctrl + 2 
Zoom 1 sec Ctrl + 3 
Zoom 10 sec Ctrl + 4 
Zoom 1 min Ctrl + 5 
Zoom 10 min Ctrl + 6 
Zoom range from start to end marker Ctrl + 7 
Zoom the entire slideshow Ctrl + 8 
Playback and marker placement
Start/Stop playback Space bar, ? 
Stop at position (stop playback, move start
marker to current position) 

Escape, ?, 0 on the
number pad 

Move start marker to the beginning Home 
Move end marker to the end end 
Slow wind left Left 
Slow wind right Right 
Fast wind left Ctrl + Left 
Fast wind right Ctrl + Right 
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Full screen playback Alt + Enter 
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Annex: Digital Video and Data
Storage
In this chapter
Video Editing on the PC
HDTV
MPEG Compression
General notes on AVI videos
Capacity and quality of different disc formats
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Video Editing on the PC
 Digital video processing with the PC is comparable to audio processing. The analog medium that is
video must first be digitized before it can be processed by the computer. 
Digital video processing functions quite similar to recording via a sound card. The signal flow is measured
in very short, regular intervals, and the values resulting from it can then be processed by the computer.
The accuracy of each individual measurement results in the resolution, and the frequency of the
measurements results in the frame rate. The more precise and frequent the signal is measured, the higher
the quality of the digitized video, but also the higher demands on the capture performance and the
required storage space. The Windows standard format for video files is AVI
 (audio and video Interleaved). 
Digitizing video adopts either the camera or the graphics card, a TV card (e.g. Miro PCTV), or a video
card (e.g. Fast AV Master). However, video handling makes much higher demands upon the hardware if
good image quality is required. In order to be able to reasonably process video files on today's PCs, they
must be compressed. Digital audio, on the other hand only uses compression for saving storage space. 

HDTV
 This acronym stands for "High Definition Telev
ision. 
High definition television is a general term applied to a series of television norms that differentiate
themselves from normal television by increased resolution and an altered aspect ratio (16:9). This type of
digital television offers cinema-like image quality and impressive sound quality. With doubled horizontal
and vertical resolution the image quality of HDTV
 is approximately four times as sharp as previous standards (PAL, NTSC, SESAM). 
At this time MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe supports two resolution standards: 

 720p (1280x720 pixel)
 1080i (1920x1080 pixel)
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MPEG Compression
 MPEG means "Moving Picture Experts Group" and defines a workgroup which cooperates with the
International Standards Organization (ISO) as well as the international Electro Technical Commission
(ETC) to develop standards for video and audio coding. 
Generally, the graphic data rate of the digital video standard is 167 megabits per second, which, when
not compressed, requires a far higher storage capacity than a DVD can offer. A one-sided DVD 5 with
4.7 GB storage capacity is enough for 4 Minutes. For this reason, the available pictorial material must be
effectively compressed – a function which is achieved with the MPEG procedure. 
This procedure is based on the simple fact that up to 96% of digital video data consists of repetition and
can be compressed without visible degradation of the pictorial quality. 
Each MPEG compression is, however, a data reduction and as such connected with information loss. If
the video consists of very extensive details, or if the content changes very fast, then the picture may blur
(dependent on the strength of the compression and the quality of the encoder). 
Errors can also result from so-called compression artifacts such as small color defects or images that are
too dark. 
At average compression rates under 3 megabits per second it is probable that you will notice reduced
quality. At rates around 6 megabit per second the degradation in quality becomes almost invisible. 

General notes on AVI videos
 The AVI format (Audio Video Interleaved) isn't actually a proper video format! Rather, it is a so-called
"container", where the conventions for transferring audio and video files to the program are only loosely
defined. The codec (coder/dec
oder) actually defines what storage format is used. A codec compresses audio/video data into its own
unique format which can only be read by the codec itself and is decoded when the film is played. 
In concrete terms, a computer-generated AVI file can only
 be loaded by and played on a different computer if the same codec is installed on it. 
Many codecs (e.g. Intel Indeo®

 video) have now become standard components of the Windows™ installation. Others like the popular
DivX codec are not standard. If you are generating an AVI file for future play on another computer using
one of these codecs, you should first install this codec on the other PC. The best method available is to
copy the codec installer to your export directory and burn it every time you create a video disc
(slideshow disc) for play on computers. 
You may encounter some problems when using older video editing cards with codecs which only function
with the card's hardware. Such AVIs can only
 be used on the computer which was used to create them. Try to avoid using this kind of codec. 

Capacity and quality of different disc formats
 In MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, a number of different disc formats are
available. 
This chapter will explain which formats can be best employed in different cases, the differences in quality,
and how much space each format requires. 
The following table summarizes the relationship between space requirements and quality. For further
information please read the chapters on the individual disc formats. 
Disc format Quality Approx. length Purpose
VCD * Approx. 70

minutes/CD 
Slideshow
 for TVy 
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SVCD ** approx. 30-40
minutes/CD 

Slideshow for TV 

DVD *** approx. 2 hours/DVD Slideshow for TV 
miniDVD *** approx. 20

minutes/CD 
Slideshow for TV 

JPEG DISC **** Depends on original
images and DVD
player* 

Slideshow on TV 
without sound,
effects, or
transitions 

Slideshow
Disc 

**** Dependent on the
original pictures and
music length 

Slideshow on PC 
with some effects,
or as a backup 

WMV HD **** Depends from resulting
material, prediction is
difficult, approx. 3
hours/ DVD, approx.
30 min./ CD 

Slideshow on
PC/TV with
specialized players
that support
Windows Media 9
format 

MultiDisc ***/***
* 

approx. 1 hour/ DVD Slideshow on TV
and PC, highest
quality on PC 

* The display duration for some DVD players may be set in this menu. The number of photos that can be
burned onto a CD or DVD depends on the sizes of the picture files. 
Note
: For all disc types with menus, you can use the menu templates from the "TV ShowTime DVD" section.
Each picture of a slideshow is then displayed in full screen on its own menu page without having to play
the slideshow. 
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General notes on AVI videos
 The AVI format (Audio Video Interleaved) isn't actually a proper video format! Rather, it is a so-called
"container", where the conventions for transferring audio and video files to the program are only loosely
defined. The codec (coder/dec
oder) actually defines what storage format is used. A codec compresses audio/video data into its own
unique format which can only be read by the codec itself and is decoded when the film is played. 
In concrete terms, a computer-generated AVI file can only
 be loaded by and played on a different computer if the same codec is installed on it. 
Many codecs (e.g. Intel Indeo®

 video) have now become standard components of the Windows™ installation. Others like the popular
DivX codec are not standard. If you are generating an AVI file for future play on another computer using
one of these codecs, you should first install this codec on the other PC. The best method available is to
copy the codec installer to your export directory and burn it every time you create a video disc
(slideshow disc) for play on computers. 
You may encounter some problems when using older video editing cards with codecs which only function
with the card's hardware. Such AVIs can only
 be used on the computer which was used to create them. Try to avoid using this kind of codec. 

Capacity and quality of different disc formats
 In MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, a number of different disc formats are
available. 
This chapter will explain which formats can be best employed in different cases, the differences in quality,
and how much space each format requires. 
The following table summarizes the relationship between space requirements and quality. For further
information please read the chapters on the individual disc formats. 
Disc format Quality Approx. length Purpose
VCD * Approx. 70

minutes/CD 
Slideshow
 for TVy 

SVCD ** approx. 30-40
minutes/CD 

Slideshow for TV 

DVD *** approx. 2 hours/DVD Slideshow for TV 
miniDVD *** approx. 20

minutes/CD 
Slideshow for TV 

JPEG DISC **** Depends on original
images and DVD
player* 

Slideshow on TV 
without sound,
effects, or
transitions 

Slideshow
Disc 

**** Dependent on the
original pictures and
music length 

Slideshow on PC 
with some effects,
or as a backup 

WMV HD **** Depends from resulting
material, prediction is
difficult, approx. 3
hours/ DVD, approx.
30 min./ CD 

Slideshow on
PC/TV with
specialized players
that support
Windows Media 9
format 
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MultiDisc ***/***
* 

approx. 1 hour/ DVD Slideshow on TV
and PC, highest
quality on PC 

* The display duration for some DVD players may be set in this menu. The number of photos that can be
burned onto a CD or DVD depends on the sizes of the picture files. 
Note
: For all disc types with menus, you can use the menu templates from the "TV ShowTime DVD" section.
Each picture of a slideshow is then displayed in full screen on its own menu page without having to play
the slideshow. 
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Capacity and quality of different disc formats
 In MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe, a number of different disc formats are
available. 
This chapter will explain which formats can be best employed in different cases, the differences in quality,
and how much space each format requires. 
The following table summarizes the relationship between space requirements and quality. For further
information please read the chapters on the individual disc formats. 
Disc format Quality Approx. length Purpose
VCD * Approx. 70

minutes/CD 
Slideshow
 for TVy 

SVCD ** approx. 30-40
minutes/CD 

Slideshow for TV 

DVD *** approx. 2 hours/DVD Slideshow for TV 
miniDVD *** approx. 20

minutes/CD 
Slideshow for TV 

JPEG DISC **** Depends on original
images and DVD
player* 

Slideshow on TV 
without sound,
effects, or
transitions 

Slideshow
Disc 

**** Dependent on the
original pictures and
music length 

Slideshow on PC 
with some effects,
or as a backup 

WMV HD **** Depends from resulting
material, prediction is
difficult, approx. 3
hours/ DVD, approx.
30 min./ CD 

Slideshow on
PC/TV with
specialized players
that support
Windows Media 9
format 

MultiDisc ***/***
* 

approx. 1 hour/ DVD Slideshow on TV
and PC, highest
quality on PC 

* The display duration for some DVD players may be set in this menu. The number of photos that can be
burned onto a CD or DVD depends on the sizes of the picture files. 
Note
: For all disc types with menus, you can use the menu templates from the "TV ShowTime DVD" section.
Each picture of a slideshow is then displayed in full screen on its own menu page without having to play
the slideshow. 
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Digital Versatile Disc (DVD)

 Quality
 The exceptional color quality, image definition, and contrast of the DVD format are all well known. 
A resolution of 720 x 576 (PAL) and coded using MPEG-2, 25 pictures per second produces very
good results. The quantity of data is approx. 5 times as much as a VCD. 

DVD size
 DVDs look similar to CDs. The only visible difference is that double-sided DVDs have no label.
Otherwise, both formats have the same dimensions. 

 Diameter: 12 cm, like a normal CD (there are also DVDs with a diameter of only 8 cm) 
 Thickness: 1.2 mm, just like a normal CD

DVD media (overview)
 The DVD does not differ outwardly from a conventional CD-ROM. Higher memory density (up to 17
GB as opposed to 650-780 megabytes) results from the fact that information is stored more densely
(double-capacity) and that up to four layers can be used. In order to be able to read the information, a
special laser with modified wavelength is required. Therefore, DVDs cannot be read using conventional
CD-ROM drives. 

Writable disc formats
 The recordable DVD market is split for the time being into three types: DVD-RAM, DVD+RW and
DVD-RW. 
DVD-R: 
Once-only writable medium. The DVD-R can be specified with the file structures of DVD Video, DVD
Audio, or DVD-ROM. 
DVD+RW
: Re-recordable DVDs can be created using +RW drives and can be read by almost any commercial
DVD-ROM or DVD player. The companies involved are mainly Philips, Sony, HEWLETT PACKARD
(as well as Ricoh, Yamaha, and Mitsubishi). 
DVD-RW: 
Writable and erasable DVD technology is promoted by Pioneer and Sharp. This format was developed
by the Pioneer company and should be compatible with existing DVD players. 
DVD-RAM:
 This standard is not recommended due to small storage capacity and incompatibility with DVD players. 
Note: MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe supports DVD -R, DVD+R, DVD +RW,
DVD -RW, but not DVD-RAM! 
Blank discs:
 Single-sided recordable blanks with a capacity of 4.7 GB and a playback time of approx. 2 hours serve
as storage media for all DVD burning formats at present. 

Copy Protection
 Macrovision (APS): 
The movie industry claims that even DVD-ROM drives and decoders or diagram cards with composite
outputs or s-video outputs must support the Macrovision analog copy protection (APS). Only some
older DVD players do not possess APS. 
APS adds additional signals to a DVD's stored graphical data. The data is almost unchanged. These
supplementary signals disturb the synchronization and the automatic recording regulation of most video
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recorders to prevent recording of the video. They are not noticeable on the television or the monitor,
however. 
Content Scrambling System (CSS): 
CSS prevents saving and duplication of DVD video tracks to hard disk. The VOB streams of DVDs
without CSS can otherwise (like other video files) be loaded via the Import Video button 
There are further types of copy protection besides APS and CSS which ensure that retail DVDs cannot
be copied without distortion 
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Blu-Ray disc
 Alongside HD-DVD, the Blu-ray Disc is viewed as the successor to DVDs and offers especially high
storage capacity of up to 27 GB as a single-layer disc (double-layer up to 54 GB) with very few write
errors. 
The term Blu-ray Disc comes from the blue color of the laser. Because a color cannot be registered as a
trademark, the letter "e" was removed from the word "blue". 
The high storage capacity of the Blu-ray Disc suits high definition videos and slideshows in high quality
perfectly, since these are characterized by large file sizes (depending on material approximately 40
MB/sec) and very high memory use. 
Hint:
 A corresponding device is required for viewing Blu-ray Discs. To fully enjoy the benefits of high
definition video, you should also use an HD-enabled TV. 
Companies that were involved in developing Blu-ray technology have united themselves into the Blu-ray
Disc Association (BDA). 
Blu-ray Discs come in three varieties:

  Only readable BD ROM (comparable to DVD video),
 rewritable BD-RE (comparable to DVD±RW or DVD RAM), 
 and as a disc that can be written to only once BD-R (comparable to DVD±R).
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Video CD (VCD)
 Video CDs are specific CD-ROMs for storing videos in certain forms. Compression takes place using
the MPEG-1 codec. VCDs can be played on either a video CD player attached to a television or
directly via the computer's CD-ROM drive. Most DVD players can play VCDs. 
Resolution: 
VCDs can play movies with a maximum resolution of 352 x 288 pixels (PAL) or 352 x 240 (NTSC) at
25 pictures per second. The resolution of a VHS cassette offers for instance 300 x 360 pixels. More
important than the resolution is the use of a good MPEG-1 encoder. Since video images constantly
change, errors cannot always be perceived by the viewer. 
Hard disk capacity:
 A VCD can store about 70 minutes of video. A typical motion picture must therefore be stored on two
VCDs. In order to get as much video data on a normal CD as possible, one must forego correction
information on VCD/SVCD formats within the individual sectors (sub-ranges) of a CD. You can
therefore fit 720 MB of video data on a 650 MB blank CD. Due to improved burning and scanning
technology it is now possible to burn up to 985 MB video data on a 99min blank CD. 
Encoder settings:
 Normally the video CD data is played at a data rate of 1150 kBits video and 224 kBits audio. By
increasing the video bit rate to 3000kBits you can get the same resolution and an better-quality audio bit
rate. Movement artifacts disappear almost completely at approx. 2000 kBits with the picture appearing a
little less sharp. This pre-supposes, however, that the player can also play back such a bit rate. The fact
that many DVD players can handle an increased data rate is due to well written player software. 
Experiment with higher data rates:
 If you do not need the full running time of the VCD, then you can experiment with space to improve the
quality of the video! 
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Super Video CD (SVCD)
 The Super Video CD (SVCD)
 is a technological advancement of the video CD. SVCDs are also like VCD-specified CD-ROMs which
can be played using either a Super Video CD player (connected to the television), or directly with the
CD-ROM drive of a computer. Many DVD players can also play SVCDs. MPEG-2 and the increase of
the data transfer rate makes it hard to tell videos from videos in DVD quality apart. 
Resolution: 
SVCDs use the better MPEG-2 encoder in a standardized resolution of 480 x 576 (PAL). The
MPEG-2 format offers a maximum resolution of up to 720 x 576 points and improved compression
methods characterized by excellent image definition and homogenity. 
Hard disk capacity:
 An average 90-minute movie must be spread across 3 CDs. On one SVCD you can get about 30
minutes of good-quality movie. 
Encoder setting:
 Compared to the VCD with 1.3, the data transfer rate is doubled to 2.6 Mbit/s. 
MPEG-2 format introduces the so-called variable bit rate (VBR). In contrast to the constant bit rate
(CBR) of the MPEG-1 encoders, this encoder has the option of using more bits for movement-intensive
sections, as well as saving bits if picture content remains the same. 
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miniDVD
 The miniDVD is nothing more than the DVD data format burned onto a CD-ROM. Thus the MPEG-2
encoder and all other specifications of the DVD data format are used, and only the data carriers are
different. Because the CD-ROM can only save about a sixth of the quantity of data a DVD can hold, the
capacity of a miniDVD is accordingly limited to approx. 20 minutes of movie. 
MiniDVDs are particularly suitable for playing on the computer. For stand-alone devices they must be
tested on an individual basis as to whether the device can handle the DVD format on a CD-ROM. 

JPEG disc
 This type of disc is intended for use in case your photos have been optimized and you want to display
them on a DVD player at the highest quality. 
Each picture will be exported individually with the corresponding photo cleaning effects and burned onto
a CD or DVD in a format which is recognized and played by most DVD players. 
This format does not support menus, dynamic effects, transitions, or sound. The display length of each
picture is not burned onto the disc either and will be determined by the DVD player. There are DVD
players which allow the display duration for each picture to be set. Please refer to the manufacturer's
instructions for your DVD player. 
This format is usually known as "Photo CD" or "JPEG CD". 
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WMV HD
 WMVHD (Windows Media High Definition Disc) is a disc type for optimum slideshow playback on
your PC. The slideshow(s) are converted in a high-resolution format into the Windows Media 9 format
and a menu is added, like with DVDs. The minimum requirement for playback is Windows Media Player
9 (or higher). The slideshows are encoded, by default, in HDTV
 resolution (1280 x 720, also known as "720p"). 
However, a powerful PC with Windows Media Player 9 installed is required for playback. 
The values "720p" or "1080i" describe the vertical resolution in pixels. The total resolution of the "PC
slideshow 720p" is 1280 x 720 pixels, the "PC slideshow 1080i" has 1920 x 1080 pixels. 
Unfortunately, there are currently now DVD players for sale that can handle this format as the jump in
quality from DVD to WMV HD is greater than from VHS cassettes to DVD. 
However, players that support this format may be available in the near future, although we cannot
guarantee that discs created with MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe can be played in
these players. TV sets that can handle such high resolutions are already available from retailers. 
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Multi disc (Deluxe version only)
 A multidisc is a combination of different disc formats on one DVD. It consists of 3 parts and offers the
following advantages: 

 Maximum quality when played on a PC with WMV HD (Windows Media High Definition Disc)
 Fully compatible with DVD players due to a DVD part (Digital Versatile Disc)
 Greatest possible safety as a data backup of the project is added (burn option).
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Appendix: MPEG Encoder
Settings
In this chapter
General settings
Video settings
Advanced video settings
Audio settings
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General settings
 MPEG type:
 Set the output type of the created MPEG file. You can adjust the encoder settings freely (to export your
video in the corresponding format, for instance) for further use in other programs or on your own
website. 
If you open the encoder from a burn dialog, or intend to use the exported material for VCDs, SVCDs or
DVDs, then select the corresponding option. This will adjust the settings of the encoder according to the
standards required for the corresponding discs to be played in a compatible player. 
Video format: Automatically specifies the video format, aspect ratio, and frame rate (see video settings
). You can choose between PAL or NTSC. 
Interlace mode: The movie is encoded interlaced (i.e. in two half-screens, so-called fields). This is
essential for later playback on TV screens. If you want to view the exported movie on your PC only and
like a "cinemascope" view, you can also encode by frame (progressively). Some video projectors also
support playback of progressively encoded image material. See Interlace
. 
Bit rate:
 The bit rate determines the memory requirement by the completed video. The amount of data available
can be used differently for different display modes. 20 MB can be 4 seconds of DVD video, or 5
minutes of Internet streaming at the thumbnail size. The quality of an MPEG video is measured by the
width of the created data stream, i.e. the bit rate. This is the amount of transmitted data per time unit and
is indicated in kBit/s or bit per second. 
Quality: Determines the quality of the encoding process, or the quality of the movement
 to be more precise. The higher the quality, the better the finished video will look, but encoding will take
considerably longer. The preset value "10" is a good compromise between speed and quality. 
Smart Rendering: Smart Rendering can considerably reduce the encoding/processing strain of MPEG
files. The production of MPEG files re-encodes only those parts of the movie that were changed in the
program (e.g. by video cleaning or effects). Please note: The MPEG files contained in the movie must
 have the same format, i.e. the bit rates (variable or constant), audio formats, image resolutions, and
video formats must match. 
Quick, GOP-precise copying:
 This special Smart Rendering mode enables MPEG material to be transferred without having to encode
it for the target medium, thereby greatly increasing the encoding speed. The video material cannot appear
to have been altered in any way; only hard cuts (without fades) are permitted. These won't be executed
precisely to the frame, but will rather take place at the next GOP borders. For this reason, cuts should be
set somewhat more generously. 
To burn DVDs in original 5.1 Surround Sound (Dolby Digital Audio) without having to re-encode, this
option has to be activated. 
Allows you to rip the necessary settings from an existing MPEG file. This can be useful if you want to
merge MPEG files together without re-rendering via Smart Rendering. 
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Video settings
 Frame rate:
 PAL requires 25 frames/sec, NTSC 29.97 frames/sec. Please note: encoding NTSC material as PAL or
vice versa may be possible; however, it will result in jittery images. 
Aspect ratio:
 Lets you set the image side or pixel ratio. With MPEG 2 the image format is displayed as image ratio;
correspondingly there is 1:1 (square screen, not recommended), 4:3 (regular video) an 2.21:1
(cinemascope). This applies irrespectively of the selected video format. 
With MPEG 1 the pixel format is specified instead. There is 1:1, CIR601 (corresponds to regular video)
for 625 lines = PAL and 525 lines = NTSC and the same in 16:9. When selecting the output format
Video CD the pixel format is automatically adjusted to the selected video format. Use with caution, even
if you only want to export MPEG 1. 
The option Auto
 is set as default. Here you can adjust the Movie settings accordingly. 
Resolution:
 Width and height of the video corresponds with the settings in the export dialog. 
GOP structure: Here you can change the settings of the GOP
 sequence, i.e. the number of P frames per I frame within a GOP. Please note that the total length of the
GOP must not exceed 15 frames, which corresponds to the default setting (1 I frame + 4 P frames + 5*2
B frames = 15 frames). 
However, you can reduce the length of the GOP sequence (while compromising the image quality at the
same bit rate). This speeds up the encoding process considerably as the motion estimation while
encoding P and B frames requires high CPU
 performance. The speed of decoding, i.e. playback, is also increased. 
If I frame is set to 1, each frame is an I frame. If the value is set larger, the setting describes the total
length of the GOP. 
Auto GOP:
 Closed GOPs do not contain relations to frames from subsequent GOPs. MPEGs where all GOPs are
closed, make MPEG editing easier as the I frames only can be edited alone if the GOP is closed. Auto
GOP closes GOPs at scene changes, whereby two different and complex procedures ("fast" and
"VSCD") are used. 
Bit rate mode
 In "constant bit rate" mode a bit rate that constantly remains the same is used. This option should be
used for Video CDs, as it is only requried here. With a constant bit rate the full power of MPEG
compression can not be used properly as bandwidth for non-moving scenes is lost. 
"Variable bit rate" mode attempts to adjust the available storage space to the requirements of the video
you want to encode. The actual bit rate fluctuates around a mean value. During calm sections of the video
it may drop to a minimum value, if there are movements in the scene it may rise to the maximum value.
There are two different regulation processes (mode 1 and mode 128). 
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Advanced video settings
 MPEG profile and level: The MPEG-2 standard defines so-called "profiles" and "levels". For creating
SVCDs and DVDs you can use "Main profile and Main level". The high profile adds additional
properties to the data stream like the option to display an image at a reduced resolution for restricted
transmission quality (SNR-scalable profile), or locally scaled, for instance an HDTV
 data stream on a standard TV set. The 4:2:2 profile is used if the image data is to be encoded for
alternative chroma scanning. However, these profiles are supported by very few encoders, and mainly
only for professional use. 
These levels define the restrictions to the image resolution and the maximum data rate. Low level can only
reach a reduced resolution (352x2888 = CIF); high level, or High 1440, enables encoding in HDTV
format. 
Estimate movement: These parameters are controlled via the quality controller (see General Settings). 
Other
 Noise sensitivity:
 This factor defines how sensitive the encoder will react to noise in the source material. If the source
material only contains a little noise (digital recordings, computer animations, or material already de-noised
by video cleaning), then you don't have to change the default value 4, or you can even reduce to increase
the quality further. However, if you want to encode noisy material, then too low of a factor will
considerably increase the encoding time at the cost of quality. For an unedited analog video you can
increase the factor to 8-14. 
Noise reduction
 (click on noise sensitivity): A noise filter is used with adjustable settings from 1-31. 
Advanced parameters
 Additional expert settings are available in the tree to the right of the window. These should only be
changed by experienced users. They have been optimized for general applications to such an extent that
changes are only necessary in exceptional cases. 

Audio settings
 Audio type: You can use MPEG Layer 1, 2 or PCM (WAV
) audio. Select "No audio" in the export dialog. 
Sample rate:
 You can set a sample rate of 32, 44.1 or 48 kHz for the audio track. VCDs and SVCDs require 44.1
kHz, DVDs require 48 kHz. To reduce the size of audio data it is recommended to lower the bit rate
instead of the sample rate. 
Mode:
 You can use Mono, Stereo, Joint Stereo or Dual Channel. 
Bit rate:
 Here you can set the bitrate of the audio signal. The higher the bit rate, the better the playback quality.
VCD requires 224 kBit/s, and for SVCDs and DVDs select a value between 384 kBit/s and 448 kBit/s. 
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MPEG glossary
In this chapter
Motion estimation
Bit rate
Block
Chroma format
Field
Frame
GOP
I frames
Interlace
P frames and B frames
Prediction
Quantization scaling
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Motion estimation
 Motion estimation is a further element for reducing data used in MPEG encoding. 
Motion estimation also occurs in the B and P frames. The image difference that still exist after prediction
 are examined. Complex algorithms are used to search for an original occurrence of the macro block in
the reference frame of each macro block of the P or B frame (these are units of 2x2 blocks specially
combined for this purpose), which have been moved either by movement or by camera pan. They can
then be left out in the P and B frame. Only the information by how far and to where the macro block has
been moved is saved instead. This vector is called the motion detector. 
In the General encoder settings
, you can specify the quality of the final MPEG video. This factor also influences the time required for
encoding. The longer it takes, the better the quality. 

Bit rate
 MPEG is a format used for storage and transferring. With older formats (e.g. AVI
) you could predict that 20 seconds of movie would result in 20 MB of data. The file size is a direct
measurement of quality. 
In the case of MPEG this is different. The amount of data available can be used differently for different
display modes. 20 MB can be 4 seconds of DVD Video or 5 minutes of streaming Internet in thumbnail
format. The quality of an MPEG video is measured by the width of the created data stream, i.e. the bit
rate. This is the amount of data transmitted per time unit indicated in kBit/s or bits per second. 
Bits, not bytes, are used, since the data word width has to address the transmission restrictions. 
The file size can be calculated from the average bit rate, if its length is known: 
F = (BRV + BRA) * t 
F...File size BRV...Bit rate

video 
BRA...Bit rate
audio 

t...Length in s 
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Block
 For almost all image file editing techniques the image is subdivided into 8 x 8 pixel blocks (image points).
This should be noted if you would like to used user-defined image resolutions (width/height), and they
should always be a multiple of 8. 

Chroma format
 The color value of each image point consists of the color values for the primary colors red, green, and
blue (RGB), and for traditional and technical reasons it is transformed into one brightness value (Y =
0.299*R = 0.587*G + 0.114*B) and two color difference values (U = R - Y, V = G -Y). 
The Y value alone produces the black and white picture. These signal components allow brightness and
color information to be handled separately. The first data reduction occurs when single rows comprising a
picture are read. Because the human eye has a lower color resolution than a brightness resolution, the
color components are recorded only for every other point of a row (4:2:2) for each four pixels grouped
(4:1:0), i.e. color signal under-reading. 
4:2:2
 This corresponds to the established TV standard. One piece of color information is transmitted per row
for two pixels which corresponds to a 2/3 compression of the output data. 
4:1:0 
This is the color coding used for DVDs and most other consumer video applications. For each 4 pixels
grouped together on two rows, one unit of color information is saved. This corresponds to a output data
compression of 1/2. 

Field
 A half-image, i.e. two halves which combine to produce a frame (see de-interlacing
). 

Frame
 A frame is a single image from a video sequence which also called a full image. PAL video, for example,
contains 25 frames per second, NTSC 29.97 frames. 
Video recordings, with the exception of computer animations and still frames, don't contain full images.
Instead, they have double numbers of half-images (fields) which are transmitted in an interlaced state.
However, we still refer to frames, since many predecessors of MPEG compression are based on such
frames. Video editing literature usually refers to frames. 

GOP
 Group of P
ictures: The sequence of I frames and the P and B frames that belong to them. 
e.g. I B B P B B P B B I ... 
(This GOP has a length of 9, with 2 P frames and 2 B frames) 
I frames contain the entire image information of a frame, while P and B have part of the information.
So-called prediction
 and movement approximation are methods used for reduction. 
The combination P B B is called a subgroup. 
I frames must appear in regular intervals in the data stream for image and sound to be synchronized.
Between the I frames only a limited count of P and B frames is allowed. This explains a few things: Since
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P and B frames contain only differential information, these differences will be larger with time, since more
and more changes takes place from frame to frame. A large count does not make much sense, since
GOP has a maximum length of 15 (4P, 2B) in PAL and 18 (5P, 2B) in NTSC. (More than 2 B frames
between P frames is not allowed). 
In a closed GOP
, B frames of the last subgroup may contain only backward predictions or references to the preceding P
frame, but no references to the following I frame, since it belongs to the next GOP. 

I frames
 Intra-frames: In these pictures, the entire image information of a frame is saved and only information from
this frame is used ("intra-frame encoded"). In contrast to the I frame, P and B frames save only the
differences between the current frame, and preceding and/or following frame are also found in MPEG
video (P frame = "predicted frame", B frame = "bidirectional frame", see Prediction
). 
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frame, but no references to the following I frame, since it belongs to the next GOP. 

I frames
 Intra-frames: In these pictures, the entire image information of a frame is saved and only information from
this frame is used ("intra-frame encoded"). In contrast to the I frame, P and B frames save only the
differences between the current frame, and preceding and/or following frame are also found in MPEG
video (P frame = "predicted frame", B frame = "bidirectional frame", see Prediction
). 
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Interlace
 For historical reasons, pictures in a movie are always recorded and transmitted in the form of two fields;
first the lines with even numbers and then those with odd numbers. These fields are alternatively displayed
with double the frame rate. The (lazy) eye of the viewer or the processing of the TV tube puts the two
frames together to form one. 

The output image First field Second field 
You normally don't have to worry about field processing. The video material goes through the entire
processing chain as fields and is exported again as fields or burned onto DVD or shown on TV when
played back on a DVD as a full picture. Only in certain rare conditions is it necessary to go deeper into
this process. Two problems can occur: 

1. Interlace artifacts
 To be displayed on a computer monitor (during recording, in your TV/VCR, and in the arranger during
editing), the two fields must be combined to form a full screen. 
These two fields are not the same, since two fields are created during the recording between which a
1/50 of a second gap is evident. Moving objects can therefore produce artifacts on vertical edges. 

Typical interlacing errors 
You can use so-called de-interlacing to avoid this type of artifact. De-interlacing places a picture in
between the two fields (interpolated). If you want to create stationary pictures from movies, then you
should definitely use a de-interlace filter. 
In the system settings ("File" menu -> Program settings) you can set the preview monitor display to use
hardware de-interlacing during video recordings for the video recorder and for display in the arranger. 

2. Incorrect field rate
 If you move around the series of fields in a movie data stream, then you will see strong jitter and flicker
effects. Picture objects move in a backward movement – two steps forwards, one back – since a
delayed field is shown before the previous one. This can happen in the processing chain if you export
video material improperly with the wrong field order and then import it into different material. We use
MXV or MPEG "Top field first" format for all analog recordings ("odd" in other programs). 
DV-AVI on the other hand is saved with "Bottom Field
 First". 
You can correct the field series for each video object in its object settings. See: "Menu
 -> Effects -> Object properties" 

P frames and B frames
 P frames save only the difference between the current picture and the preceding I frame. The "P" comes
from the term "prediction" which describes this process. 
B frames save the differences between the current picture and the I or P frame preceding and following.
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This includes the information that was the same before and remained the same after the current frame.
Both directions are analyzed (indicates the "B" in the name, i.e. "bidirectional-predicted"). You can read
more under prediction
. 

Prediction
 Prediction is a method of data reduction used by the MPEG format. The image elements already known
from the previous or following frames are removed from the data stream. 

How does it work?
 The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is transmitted
together with the encoder, which always knows exactly which kind of frame comes next. I, P, and B
frames are differentiated. 
Note: When we talk about pictures, we refer to frames of the video output, and I, P and B frames are the
encoded video frames. Just as in movement approximation, blocks (8x8 pixels) are united into
macroblocks (16x16 pixels) during prediction. 
The first frame is always the I frame. It is completely encoded from the first picture. Afterwards, the 4th
picture is analyzed for the creation of the first P frame. As already said, the encoder and later the
decoder will know that two B frames belong between them. This image will also be completely encoded,
and afterwards all macroblocks that haven't changed in comparison to the I frame will be deleted. They
will be replaced by corresponding references for the decoder that tell it "you already know what should
be shown here, and you can get it from the last I frame". 
Now the 2nd will be completely encoded, and all macroblocks identical to the first I frame and the
following P frame will be removed. References to previous frames are called backward predictions,
and references to following frames are called forward predictions
. The third picture will be edited in exactly the same fashion. 
The fourth picture we have already explained, and now we need the next P frame, or picture number 7.
Pictures 5 and 6 are B frames again which are compared to P frames to both sides of them (picture 4
and 7), and these are followed by the last two B frames. These have a special place, since in closed
GOPs they may contain only backward predictions
 and no references to the next I frame, since it belongs to the next GOP. 
Also: Since the decoder is no prophet, the P frames are always transmitted before the B frames! The
GOP explained above will be encoded and transmitted in the order it is written. 
Original GOP: I0 B01 B02 P01 B11 B12 P02 B21 B22 I1

 Data stream: I0 P01 B01 B02 P02 B11 B12 B21 B22 I1

 ... in closed GOPs 
I0 P01 B01 B02 P02 B11 B12 I1 B21 B22 P11

... in open GOPs 
Because of this nested structure it is easy to see that during direct editing of MPEG material, and
complicated computations have to be made! These are made easier using a frame table
. A frame table contains a list in which the information of every frame in the data stream is found to
identify the type of frame it is. 
Using "Movement prediction
", P and B frames are likewise reduced. 

Quantization scaling
 The single pictures in MPEG are saved using a compression method comparable to JPEG with bitmaps
and associated with quality loss. For this single images are divided into 8 x 8 blocks
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. 
Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows and columns) using
a DCT
 (discreet cosinus transformation) mathematical method. Each of these values is produced using all 64
individual pixels of the block, but the values in the matrix are ordered in such a way that the image
information is ordered according to its importance. 
This matrix will then be multiplied by another matrix, i.e. the quantization matrix
. Exactly how and why this matrix must be created is the biggest secret of encoder programmers, since
this determines the quality of the whole encoding process. What is known is that the result should contain
as many zeros as possible! These zeros correspond to the "unimportant" image elements mentioned and
will not be transmitted in the data stream. 
Depending on the encoder parameters regarding the target bit rate, fewer or more values of the matrix
will be declared unimportant by dividing the quantization matrix by the quantization scaling factor
. Since only whole numbers are used, a division can produce a zero is the remainder is discarded. 
This factor is also a direct measure of the sought image quality of the MPEG data stream, since the "Q" in
"Q" factor stands for quantization and quality. 
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P frames and B frames
 P frames save only the difference between the current picture and the preceding I frame. The "P" comes
from the term "prediction" which describes this process. 
B frames save the differences between the current picture and the I or P frame preceding and following.
This includes the information that was the same before and remained the same after the current frame.
Both directions are analyzed (indicates the "B" in the name, i.e. "bidirectional-predicted"). You can read
more under prediction
. 

Prediction
 Prediction is a method of data reduction used by the MPEG format. The image elements already known
from the previous or following frames are removed from the data stream. 

How does it work?
 The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is transmitted
together with the encoder, which always knows exactly which kind of frame comes next. I, P, and B
frames are differentiated. 
Note: When we talk about pictures, we refer to frames of the video output, and I, P and B frames are the
encoded video frames. Just as in movement approximation, blocks (8x8 pixels) are united into
macroblocks (16x16 pixels) during prediction. 
The first frame is always the I frame. It is completely encoded from the first picture. Afterwards, the 4th
picture is analyzed for the creation of the first P frame. As already said, the encoder and later the
decoder will know that two B frames belong between them. This image will also be completely encoded,
and afterwards all macroblocks that haven't changed in comparison to the I frame will be deleted. They
will be replaced by corresponding references for the decoder that tell it "you already know what should
be shown here, and you can get it from the last I frame". 
Now the 2nd will be completely encoded, and all macroblocks identical to the first I frame and the
following P frame will be removed. References to previous frames are called backward predictions,
and references to following frames are called forward predictions
. The third picture will be edited in exactly the same fashion. 
The fourth picture we have already explained, and now we need the next P frame, or picture number 7.
Pictures 5 and 6 are B frames again which are compared to P frames to both sides of them (picture 4
and 7), and these are followed by the last two B frames. These have a special place, since in closed
GOPs they may contain only backward predictions
 and no references to the next I frame, since it belongs to the next GOP. 
Also: Since the decoder is no prophet, the P frames are always transmitted before the B frames! The
GOP explained above will be encoded and transmitted in the order it is written. 
Original GOP: I0 B01 B02 P01 B11 B12 P02 B21 B22 I1

 Data stream: I0 P01 B01 B02 P02 B11 B12 B21 B22 I1

 ... in closed GOPs 
I0 P01 B01 B02 P02 B11 B12 I1 B21 B22 P11

... in open GOPs 
Because of this nested structure it is easy to see that during direct editing of MPEG material, and
complicated computations have to be made! These are made easier using a frame table
. A frame table contains a list in which the information of every frame in the data stream is found to
identify the type of frame it is. 
Using "Movement prediction
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", P and B frames are likewise reduced. 

Quantization scaling
 The single pictures in MPEG are saved using a compression method comparable to JPEG with bitmaps
and associated with quality loss. For this single images are divided into 8 x 8 blocks
. 
Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows and columns) using
a DCT
 (discreet cosinus transformation) mathematical method. Each of these values is produced using all 64
individual pixels of the block, but the values in the matrix are ordered in such a way that the image
information is ordered according to its importance. 
This matrix will then be multiplied by another matrix, i.e. the quantization matrix
. Exactly how and why this matrix must be created is the biggest secret of encoder programmers, since
this determines the quality of the whole encoding process. What is known is that the result should contain
as many zeros as possible! These zeros correspond to the "unimportant" image elements mentioned and
will not be transmitted in the data stream. 
Depending on the encoder parameters regarding the target bit rate, fewer or more values of the matrix
will be declared unimportant by dividing the quantization matrix by the quantization scaling factor
. Since only whole numbers are used, a division can produce a zero is the remainder is discarded. 
This factor is also a direct measure of the sought image quality of the MPEG data stream, since the "Q" in
"Q" factor stands for quantization and quality. 
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Prediction
 Prediction is a method of data reduction used by the MPEG format. The image elements already known
from the previous or following frames are removed from the data stream. 

How does it work?
 The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is transmitted
together with the encoder, which always knows exactly which kind of frame comes next. I, P, and B
frames are differentiated. 
Note: When we talk about pictures, we refer to frames of the video output, and I, P and B frames are the
encoded video frames. Just as in movement approximation, blocks (8x8 pixels) are united into
macroblocks (16x16 pixels) during prediction. 
The first frame is always the I frame. It is completely encoded from the first picture. Afterwards, the 4th
picture is analyzed for the creation of the first P frame. As already said, the encoder and later the
decoder will know that two B frames belong between them. This image will also be completely encoded,
and afterwards all macroblocks that haven't changed in comparison to the I frame will be deleted. They
will be replaced by corresponding references for the decoder that tell it "you already know what should
be shown here, and you can get it from the last I frame". 
Now the 2nd will be completely encoded, and all macroblocks identical to the first I frame and the
following P frame will be removed. References to previous frames are called backward predictions,
and references to following frames are called forward predictions
. The third picture will be edited in exactly the same fashion. 
The fourth picture we have already explained, and now we need the next P frame, or picture number 7.
Pictures 5 and 6 are B frames again which are compared to P frames to both sides of them (picture 4
and 7), and these are followed by the last two B frames. These have a special place, since in closed
GOPs they may contain only backward predictions
 and no references to the next I frame, since it belongs to the next GOP. 
Also: Since the decoder is no prophet, the P frames are always transmitted before the B frames! The
GOP explained above will be encoded and transmitted in the order it is written. 
Original GOP: I0 B01 B02 P01 B11 B12 P02 B21 B22 I1

 Data stream: I0 P01 B01 B02 P02 B11 B12 B21 B22 I1

 ... in closed GOPs 
I0 P01 B01 B02 P02 B11 B12 I1 B21 B22 P11

... in open GOPs 
Because of this nested structure it is easy to see that during direct editing of MPEG material, and
complicated computations have to be made! These are made easier using a frame table
. A frame table contains a list in which the information of every frame in the data stream is found to
identify the type of frame it is. 
Using "Movement prediction
", P and B frames are likewise reduced. 

Quantization scaling
 The single pictures in MPEG are saved using a compression method comparable to JPEG with bitmaps
and associated with quality loss. For this single images are divided into 8 x 8 blocks
. 
Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows and columns) using
a DCT
 (discreet cosinus transformation) mathematical method. Each of these values is produced using all 64

Page 428



individual pixels of the block, but the values in the matrix are ordered in such a way that the image
information is ordered according to its importance. 
This matrix will then be multiplied by another matrix, i.e. the quantization matrix
. Exactly how and why this matrix must be created is the biggest secret of encoder programmers, since
this determines the quality of the whole encoding process. What is known is that the result should contain
as many zeros as possible! These zeros correspond to the "unimportant" image elements mentioned and
will not be transmitted in the data stream. 
Depending on the encoder parameters regarding the target bit rate, fewer or more values of the matrix
will be declared unimportant by dividing the quantization matrix by the quantization scaling factor
. Since only whole numbers are used, a division can produce a zero is the remainder is discarded. 
This factor is also a direct measure of the sought image quality of the MPEG data stream, since the "Q" in
"Q" factor stands for quantization and quality. 
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Quantization scaling
 The single pictures in MPEG are saved using a compression method comparable to JPEG with bitmaps
and associated with quality loss. For this single images are divided into 8 x 8 blocks
. 
Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows and columns) using
a DCT
 (discreet cosinus transformation) mathematical method. Each of these values is produced using all 64
individual pixels of the block, but the values in the matrix are ordered in such a way that the image
information is ordered according to its importance. 
This matrix will then be multiplied by another matrix, i.e. the quantization matrix
. Exactly how and why this matrix must be created is the biggest secret of encoder programmers, since
this determines the quality of the whole encoding process. What is known is that the result should contain
as many zeros as possible! These zeros correspond to the "unimportant" image elements mentioned and
will not be transmitted in the data stream. 
Depending on the encoder parameters regarding the target bit rate, fewer or more values of the matrix
will be declared unimportant by dividing the quantization matrix by the quantization scaling factor
. Since only whole numbers are used, a division can produce a zero is the remainder is discarded. 
This factor is also a direct measure of the sought image quality of the MPEG data stream, since the "Q" in
"Q" factor stands for quantization and quality. 
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If you still have questions...
 Task assistant
 The task assistant is your information center. It helps you complete your tasks and provides support at
every step. Not only will you find clear videos with step-by-step instructions, but you'll also find quick
access to a lot of functions. 
The task assistant chapters can be found in the "Tasks" menu
. 

Program help
 The program's help file contains hints on how to use the program and additional information. Many
important terms are indicated in the text in italics and an explanation of them can be reached by clicking
on them. 
Homepage
: The main help page can be accessed via the "Help -> Contents" menu point. 
Context help
: Press the "F1" key at any point in the opened program and help will open with the matching help topic
(context help). 
Search function
: To find out information on specific words, use the search function. Enter either the individual word or
use logical operators (OR, AND, NEAR) to refine your search if you have several search words. 

 "OR" (between two words): All topics which contain both words or one of the words will be
listed.

 "AND" (between two words): Only those topics will be listed which contain both words.
 "NEAR" (between two words): Only those topics will be listed which contain both words. A

maximum of six other words may be added between the search terms.
 "NOT"" (before a word): Topics which contain this word will not be listed.

Print
: Use the help program's print function to make a printout of individual topics or entire sections. For help
cases which may take a long time, this can be more practical than switching between the help window
and the program. The print button is located at the top of the help window in the toolbar. 
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PDF manual
 Much like the help feature, the electronic PDF manual contains the entire program documentation. You
can find it under "Start -> Programs -> MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe" in the
"Documentation" subfolder. 
Note:
 To view the PDF file you will need "Foxit Reader" application; you can find it on the MAGIX Xtreme
PhotoStory on CD & DVD 8 deluxe installation DVD. 
We hope you have fun using MAGIX Xtreme PhotoStory on CD & DVD 8 deluxe and enjoy hours of
entertainment with your slideshows! Your MAGIX Team. 
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